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Preface
Thank you for purchasing the Canon imageCLASS MF5700 Series. Please read this manual thoroughly before 
operating the product in order to familiarize yourself with its capabilities, and to make the most of its many 
functions. After reading this manual, store it in a safe place for future reference.

How to Use This Manual

Symbols Used in This Manual
The following symbols are used in this manual to explain procedures, restrictions, handling 
precautions, and instructions that should be observed for safety.

IMPORTANT Indicates operational requirements and restrictions. Be sure to read these items 
carefully in order to operate the machine correctly, and to avoid damage to the 
machine.

NOTE Indicates a clarification of an operation, or contains additional explanations for a 
procedure. Reading these notes is highly recommended.

Buttons Used in This Manual
A button or an item is referred to in [brackets] as follows in this manual.

• A button or an item on the screen ......................................... [OK]

• Name of window or dialog box .............................................. [Add Printer Wizard]

• A button on a toolbar .............................................................   (Help)

Displays Used in This Manual
Screen shots of computer operation screens used in this manual may differ from the ones you actually 
see depending on the model or options that come with your machine. 

Abbreviations Used in This Manual
In this manual, product names and model names are abbreviated as follows:
Microsoft® Windows® 98 operating system is referred to as Windows 98.
Microsoft® Windows® Millennium Edition operating system is referred to as Windows Me.
Microsoft® Windows® 2000 operating system is referred to as Windows 2000.
Microsoft® Windows® XP operating system is referred to as Windows XP.
Microsoft® Windows Server™ 2003 operating system is referred to as Windows Server 2003.

See the User’s Guide Refer to the User’s Guide for details on the topic of the previous sentence.

machine The word “machine” refers to Canon imageCLASS MF5700 Series machine.

default A setting that remains in effect unless you change it.
iv



Legal Notices

Trademarks
Canon and the Canon Logo are trademarks of Canon Inc.

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or in other countries.

Other brand and product names are trademarks or registered trademarks of their respective 
companies.

In this manual, Microsoft and Microsoft Windows are referred to as Microsoft and Windows 
respectively.

Copyright
Copyright © 2005 by Canon Inc. All rights reserved.

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or 
translated into any language or computer language, in any form or by any means, electronic, 
mechanical, magnetic, optical, chemical, manual, or otherwise, without the prior written permission of 
Canon Inc.

Notice
The information in this manual is subject to change without notice.

CANON INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL, EITHER 
EXPRESS OR IMPLIED, EXCEPT AS PROVIDED HEREIN, INCLUDING WITHOUT LIMITATION, 
THEREOF, WARRANTIES AS TO MARKETABILITY, MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE OF USE OR AGAINST INFRINGEMENT OF ANY PATENT. CANON INC. 
SHALL NOT BE LIABLE FOR ANY DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF 
ANY NATURE, OR LOSSES OR EXPENSES RESULTING FROM THE USE OF THIS MATERIAL.
v



CHAPTER

1 
 corresponding 
Installation
This chapter explains the procedure to install the drivers and software on your computer. Once the
drivers are installed, you can make printing, scanning, and PC faxing* from your computer.
* Only for the MF5750/MF5770 models.

System Requirements
The drivers can be installed and used in the following system environments.

■ Operating System
Windows 98, Windows Me, Windows 2000, Windows XP, Windows Server 2003*.

■ Computer
Any computer on which Windows 98, Windows Me, Windows 2000, Windows XP or Windows Server 2003* runs 
properly.

■ Hardware Environment
• IBM or IBM-compatible PC
• CD-ROM drive or network environment with the access to CD-ROM
• PC equipped with a USB port and the USB class driver installed

* Only for network connection.

** Log on as a user account with administrator privileges is recommended.

NOTE
The USB 2.0 Hi Speed connection requires a PC equipped with a CPU faster than 300 MHz and more than 64 MB 
of RAM and with Windows XP SP1 installed, or with a CPU faster than 133 MHz and more than 64 MB of RAM 
and with Windows 2000 SP4 installed. If your PC meets all of these requirements and is preinstalled with USB 2.0 
Host Controller, the USB 2.0 connection will be guaranteed.

OS CPU RAM Available free disk space

Windows 98 Intel Pentium® 90 MHz or greater 
32 MB of RAM, 64 
MB or greater is 
recommended

At least 115 MB, 200 MB or greater 
is recommended

Windows Me Intel Pentium® 150 MHz or greater
32 MB of RAM, 64 
MB or greater is 
recommended

At least 115 MB, 200 MB or greater 
is recommended

Windows 2000**
Intel Pentium® 133 MHz or greater, or 
compatible micro processors (up to 2 
processors are supported)

64 MB of RAM, 
128 MB or greater 
is recommended

At least 115 MB, 200 MB or greater 
is recommended

Windows XP** Pentium Family® 300 MHz or greater
64 MB of RAM, 
128 MB or greater 
is recommended

At least 115 MB, 200 MB or greater 
is recommended

Windows Server 
2003*

Pentium Family® 300 MHz or greater
64 MB of RAM, 
128 MB or greater 
is recommended

At least 115 MB, 200 MB or greater 
is recommended
1-1
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Where to Find Help
When you encounter a problem during installation of the driver software or while operating your 
machine, consult the following:

■ In This Manual
See Chapter 5, “Troubleshooting.”

■ In the User’s Guide
See Chapter 9, “Troubleshooting.”

■ README. TXT File
The hints, limitations, and restrictions you need to be aware of when installing and using the drivers are included in 
the README.TXT file provided with the drivers.

■ Online Help
You can locate additional help in the online Help file provided with the driver software. In the [Properties] dialog box, 
you can click [Help] to display information about every feature and option in the drivers. 

■ Context Sensitive Help
This Help displays the explanation of each item in the current dialog box. Use one of the following procedures to 
activate a context sensitive help.

- Click  (Help) in the title bar of the dialog box ➞ click the desired item.
- Right-click the desired item ➞ select [What’s this?].
- Select the desired item ➞ press [F1].

■ Canon Authorized Dealers or Service Providers
If the Help does not provide the information you need, contact your Canon authorized dealer or Canon authorized 
service provider.

Installing Software on Your Computer
This section provides installation procedure of drivers to use the Canon MF5700 Series as a local 
printer, scanner, or fax (connected directly to your computer). (Fax function is available for the MF5750/
MF5770 models only.)

When installing the drivers, follow the steps shown in the [MF5700 Series Setup] screen.

Before you install the software, be sure to:

• Confirm the machine is not connected to your computer.
• Turn on the machine. (See "Connect power cord," in the Set-up Sheet.)
• Quit any Windows application running on your computer.

IMPORTANT
If you are using Windows 2000/XP/Server 2003, be sure to log on as a member of Administrators. The full control 
access right is necessary for the installation of the drivers.

NOTE
• Use of a cable 3 m long or less is recommended.
• The screen shots shown are from Windows XP. However, the installation procedure is essentially the same for 

other versions of Windows.
1-2
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To Use the Machine as a Local Printer, Scanner or for PC Faxing 
(USB Connection) 

1 Insert the CD-ROM into your CD-ROM drive.

The [MF5700 Series Setup] screen appears.

Install the software following steps 1, 2 and 3 in the [MF5700 Series Setup] screen.

If the [MF5700 Series Setup] screen is not displayed, on the Windows desktop, click [start] ➞ [My Computer] 
(Windows 98/Me/2000: double-click [My Computer]). Open the CD-ROM icon ➞ double-click [Setup(Setup.exe)].

If you are installing from a copy saved on a network or hard disk, double-click [Setup(Setup.exe)] in the copy.

Step 1 Install the MF Drivers (USB Connection)

1 In the [MF5700 Series Setup] screen, click [Install Drivers].

2 Click [Install MF Drivers].

[MF5700 Series Setup] screen
1-3
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3 Read the License Agreement ➞ click [Yes].

4 Click [Exit].

NOTE
If you are using Windows 98/Me, a message recommending you to restart your computer may appear. In this 
case, continue installing after restarting your computer.

Step 2 Install the MF Toolbox

1 In the [Install Drivers] screen, click [Install MF Toolbox].

If you have closed the [Install Drivers] screen, on the Windows desktop, click [start] ➞ [My Computer] (Windows 
98/Me/2000: double-click [My Computer]). Open the CD-ROM icon ➞ double-click [Setup(Setup.exe)].

If you are installing from a copy saved on a network or hard disk, double-click [Setup(Setup.exe)] in the copy.
1-4
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2 Click [Next >].

3 Click [Continue].

4 Read the License Agreement ➞ click [Yes].
1-5
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5 When the [Choose Destination Location] dialog box appears, click [Next >].

6 Click [Next >].

7 Click [Exit].
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Step 3 Connect the USB Cable
1 Make sure that the machine is turned on.

Connect the USB cable after MF Toolbox installation.

2 Connect the USB cable to the machine and computer USB port.

When you connect the USB cable to the computer, the machine is automatically detected as a new hardware. 
Wait for a while as your computer performs various settings.

Depending on your computer, a message may display asking you to restart your computer.

After restarting your computer, wait for a while for your computer to continue performing various settings.

Install Accompanying Applications
To install the accompanying applications, in the [MF5700 Series Setup] screen, click [Install 
Applications].

You can also install it later.

Read User’s Manual
To read the PDF manual on the CD-ROM, click [Read Manuals] on the [MF5700 Series Setup] screen.

Installation is now complete. In the [MF5700 Series Setup] screen, click [Exit] to close the screen. Then 
remove the CD-ROM from the disk drive.

To Use the Machine as a Network Printer (Network Connection) 
(MF5770 Model Only)

IMPORTANT
The machine needs to be restarted for the specified settings to become effective. To restart the machine, 
disconnect the power cord, wait for at least 10 seconds, and connect the power cord again.

NOTE
• For details on specifying network settings, see Chapter 2, “Specifying the Network Settings,“ in the Network Guide.
• For additional network protocol settings, see the Network Guide.
• For the values of the network settings, consult your network administrator or internet service provider (ISP).
• The machine does not support Network Scanning or PC Faxing. The printer must be connected via USB for 

scanning and PC faxing.

Step 1 Specifying Network Settings

1 Press [Menu] ➞  or  to select <6.NETWORK SETTINGS> on the LCD ➞ press [OK].

2 Press  or  to select <1.LAN SETTINGS> ➞ press [OK].

3 Press  or  to select <1.IP ADDRESS AUTO.> ➞ press [OK].

MENU
 6.NETWORK SETTINGS

NETWORK SETTINGS
 1.LAN SETTINGS

LAN SETTINGS
 1.IP ADDRESS AUTO.
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■ To obtain an IP address automatically (dynamic allocation):

4 Press  or  to select <ON> ➞ press [OK].

5 Press  or  to select <1.DHCP>, <2.BOOTP>, or <3.RARP> ➞ press [OK].

6 Press  or  to select <ON> ➞ press [OK].

7 Press [Stop/Reset] to return to the standby display.

8 Restart the machine by disconnecting the power cord, and then reconnecting it.

■ To specify an IP address manually (static allocation):

4 Press  or  to select <OFF> ➞ press [OK].

5 Press  or  to select <2.IP ADDRESS> ➞ press [OK].

6 Enter an IP address of the machine using the numeric keys ➞ press [OK].

Write down the IP address you entered:          ,          ,          ,          

7 Press  or  to select <3.SUBNET MASK> ➞ press [OK].

8 Enter the subnet mask using the numeric keys ➞ press [OK].

Write down the subnet mask you entered:           ,          ,          ,          

IP ADDRESS AUTO.
                ON

IP ADDRESS AUTO.
 1.DHCP

DHCP
                ON

IP ADDRESS AUTO.
               OFF

LAN SETTINGS
 2.IP ADDRESS

IP ADDRESS
000.000.000.000_

LAN SETTINGS
 3.SUBNET MASK

SUBNET MASK
000.000.000.000_
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9 Press  or  to select <4.DEFAULT GATEWAY> ➞ press [OK].

10 Enter the default gateway address using the numeric keys ➞ press [OK].

Write down the gateway address you entered:           ,          ,          ,          

11 Press [Stop/Reset] to return to the standby display.

12 Restart the machine by disconnecting the power cord, and then reconnecting it.

Step 2 Connecting the Machine to a Network

1 Connect a Category 5 rated (Cat 5) twisted-pair LAN cable to the 10Base-T/100Base-TX port on the back 
of the machine. Connect the other end of the cable to a network router or a hub.

Step 3 Checking Network Settings

1 Press [Menu] ➞  or  to select <6.NETWORK SETTINGS> on the LCD ➞ press [OK].

2 Press   or  to select <2.VIEW IP ADDRESS> ➞ press [OK].

3 Press  or  to select the desired setting ➞ press [OK].

4 Press [Stop/Reset] to return to the standby display.

LAN SETTINGS
 4.DEFAULT GATEWAY

DEFAULT GATEWAY
000.000.000.000�

MENU
 6.NETWORK SETTINGS

NETWORK SETTINGS
 2.VIEW IP ADDRESS

VIEW IP ADDRESS
 1.IP ADDRESS
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Step 4 Install the MF Network Drivers (Network Connection)

NOTE
For Windows 2000/XP/Server 2003, log on as Administrator to install the software.

1 Insert the CD-ROM into your CD-ROM drive.

The [MF5700 Series Setup] screen appears.

Install the software following steps in the [Install Drivers] screen.

2 In the [MF5700 Series Setup] screen, click [Install Drivers].

NOTE
You can click [Read Manuals] to read PDF manuals.

3 Click [Next >].
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4  [License Agreement] screen appears, then click [Yes].

5 Select the target machine in the Device List ➞ click [Next >].

NOTE
If the target machine is not listed in the Device List, click [Search by IP Address] and enter the IP address ➞ click 
[OK]. If you do not know the machine’s IP address, see Checking Network Settings on p. 1-9.
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6 Select the driver(s) to install ➞ click [Next >]. 

7 Select the default printer or fax ➞ click [Next >].

8 Select the driver type (Printer and/or Fax) ➞ click [Next >].
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9 Click [Exit].

NOTE
When a screen prompting you to restart your computer is appeared instead of the screen above, select [Yes, I 
want to restart my computer now.] or [No, I will restart my computer later.] and then click [Exit].

Checking Installation
Check if the drivers are installed successfully and the machine is selected as the default printer.

NOTE
If your machine is selected in the printer box when you open the [Print] dialog box in an application, which means 
your machine is set as the default printer.

1 Open the [Printers and Faxes] (Windows 98/Me/2000: [Printers]) folder.

Click [start] on the Windows task bar ➞ select [Printers and Faxes] (Windows 98/Me/2000: [Start] ➞ [Settings] ➞ 
[Printers]).

Make sure the driver icon is displayed.

2 Select the default printer.

If your machine is already set as the default printer, go to step 3.

❑ Click the corresponding printer driver icon.

❑ From the [File] menu, click [Set as Default Printer] (Windows 98/Me: [Set as Default]).

3 Open the [Scanners and Cameras] folder (Windows 98/2000: the [Scanners and Cameras Properties] 
dialog box).

Click [start] on the Windows task bar ➞ select [Control Panel] ➞ [Scanners and Cameras] (Windows 98/2000: 
[Start] ➞ [Settings] ➞ [Control Panel] ➞ double-click the [Scanners and Cameras] icon).

Make sure the corresponding scanner driver name or icon is displayed.

4 If the [Canon MF Toolbox 4.7] icon is displayed on the Windows desktop, installation of the MF Toolbox 
4.7 has been successful.
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Uninstalling and Reinstalling the Software
If the drivers are not working properly, remove the drivers and install them again. When removing the 
software, first remove the MF Toolbox, and then the MF drivers. Even if you want to reinstall the 
software, you must still remove the currently installed software. Before you remove the drivers, make 
sure the following:

• You have the installation software available for installation.
• No application is running on your computer.

IMPORTANT
To uninstall the software in Windows 2000/XP/Server 2003, you must be the user with administrative privileges.

Removing the MF Toolbox

1 Quit the MF Toolbox and any applications (including anti-virus) that are currently running.

To close the MF Toolbox, click [X] at the top right of the MF Toolbox window.

2 Click [start] on the Windows task bar ➞ [(All) Programs] ➞ [Canon] ➞ [MF Toolbox 4.7] ➞ [Uninstall 
Toolbox].

3 Follow the on-screen instructions. 

When the Repair or Remove program selection screen is displayed, check [Remove] ➞ click [Next >].

If asked to confirm removal of an application etc., click [OK].

Restart your computer if asked to do so.

4 Click [Exit].

Removing the MF Drivers
1 Click [start] on the Windows task bar ➞ [(All) Programs] ➞ [Canon] ➞ [MF Drivers] ➞ [Uninstall Drivers].

The [MF Drivers Uninstaller] dialog box appears.

2 Select the corresponding printer ➞ click [Perform].

The confirmation message dialog box appears.

3 Click [Yes].

Uninstallation proceeds automatically and next dialog box appears.
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4 Click [Exit].

NOTE
A message recommending you to restart your computer may appear under some operating systems. In this case, 
continue installing after restarting your computer.

Reinstalling the Software
On the Windows desktop, click [start] ➞ [My Computer] (Windows 98/Me/2000: double-click [My 
Computer]). Open the CD-ROM icon ➞ double-click [Setup(Setup.exe)]. The MF Setup screen 
appears. Go back to the “Step 1 Install the MF Drivers (USB Connection),” on p. 1-3 and reinstall the 
software. If you install the software using a copy on network or hard disk, open the MF Setup screen by 
double-clicking the [Setup(Setup.exe)] icon.
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Printing
This chapter explains the procedure to print a document from a Windows application. To change print settings, access 
the properties dialog box of the printer driver.

Printing a Document

1 Load paper in the cassette or the multi-purpose feeder.

For details on loading paper, see Chapter 2, "Paper Handling," in the User’s Guide.

2 Open the document in an application.

3 Select the command to print. 

In most cases, click [Print] from the [File] menu.

The [Print] dialog box appears.

4 From the [Select Printer] list box or the [Name] pull-down list in the [Print] dialog box, select the printer to 
be used.

5 Click [Preferences] or [Properties].

NOTE
Depending on the application you are using, select the printer to be used in the [General] tab sheet in the [Print] 
dialog box, then specify the print settings in the corresponding tab sheet. (Only for Windows 2000.)

6 Specify the required settings ➞ click [OK].

NOTE
For details, see “Changing Print Settings,” on p. 2-2.

7 Click [Print] or [OK].

Printing starts.

NOTE
To cancel printing, click [Cancel].
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Canceling Printing

1 Open the [Printers and Faxes] (Windows 98/Me/2000: [Printers]) folder.

Click [start] on the Windows task bar ➞ select [Printers and Faxes] (Windows 98/Me/2000: [Start] ➞ [Settings] ➞ 
[Printers]).

2 Double-click the corresponding printer driver icon.

3 Right click the print job ➞ click [Cancel] ➞ [Yes].

NOTE
You can also cancel a print job using [Status Monitor] on the operation panel of the machine. For details, see 
Chapter 7, "Status Monitor," in the User’s Guide.

Changing Print Settings
To view or change the print settings, access the properties or printing preferences dialog box of the 
printer driver. 
You can access the properties dialog box either from the application's [Print] dialog box and the 
[Printers and Faxes] (Windows 98/Me/2000: [Printers]) folder, or the printing preferences dialog box 
from the [Printers and Faxes] (Windows 2000: [Printers]) folder.

To access the dialog box, follow the procedure below.

NOTE
• The properties dialog box enables you to set up the printer configuration and configure the print settings for all 

Windows applications. The printing preferences dialog box enables you to specify the default settings for the 
printing options available when you print with the Canon imageCLASS MF5700 Series. (Only for Windows 2000/
XP/Server 2003.)

• The number of tabs displayed in the properties dialog box will vary, depending on the type of operating system you 
are using and the method you use to access the dialog box.

• The method you use to access the dialog boxes determines how long the printing options remain in effect:
- If you access the dialog box from an application's [Print] dialog box, your selected printing options apply only to 

the current print job. They will not be stored when you close the application.
- If you access the dialog box from the [Printers and Faxes] (Windows 98/Me/2000: [Printers]) folder, selected 

printing options apply to all Windows applications and remain in effect until you change those settings.

From a Windows Application

■ Opening the Printing Preferences or Properties Dialog Box

1 Select the command to print.

In most cases, click [Print] from the [File] menu.

The [Print] dialog box appears.

2 From the [Select Printer] list box or the [Name] pull-down list in the [Print] dialog box, select the printer to 
be used.

3 Click [Preferences] or [Properties].

The [Printing Preferences] or [Canon MF5700 Series Properties] dialog box appears. 
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From the [Printers and Faxes] 
(Windows 98/Me/2000: [Printers]) Folder

■ Opening the Properties Dialog Box

1 Open the [Printers and Faxes] (Windows 98/Me/2000: [Printers]) folder.

Click [start] on the Windows task bar ➞ select [Printers and Faxes] (Windows 98/Me/2000: [Start] ➞ [Settings] ➞ 
[Printers]).

2 Click the corresponding printer driver icon.

3 From the [File] menu, click [Properties].

You can also open the properties dialog box by right-clicking the corresponding printer driver icon and selecting 
[Properties] from the pop-up menu. 

The [Canon MF5700 Series Properties] dialog box appears. 

■ Opening the Printing Preferences Dialog Box (Windows 2000/XP/Server 2003)

1 Open the [Printers and Faxes] (Windows 2000: [Printers]) folder.

Click [start] on the Windows task bar ➞ select [Printers and Faxes] (Windows 2000: [Start] ➞ [Settings] ➞ 
[Printers]).

2 Click the corresponding printer driver icon.

3 From the [File] menu, click [Printing Preferences].

You can also open the printing preferences dialog box by right-clicking the corresponding printer driver icon and 
selecting [Printing Preferences] from the pop-up menu.

The [Canon MF5700 Series Printing Preferences] dialog box appears.
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Windows 98/Me Properties

NOTE
• The screens shown below are displayed when you open [Canon MF5700 Series Properties] from the [Printers] 

folder. 
• The number of tabs displayed in the properties dialog box depends on how you have your system set up.

■ General Tab

Lets you print a test page or define separator pages. Refer to your Windows operating system 
documentation for more information.
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■ Details Tab

Specifies the printer port and time-out settings. Refer to your Windows operating system 
documentation for more information.

■ Spool Settings

The installer sets the following defaults.
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■ Sharing Tab

Specifies the printer sharing settings. This tab sheet is available only when the printer sharing is 
enabled (see p. 2-58). Refer to your Windows operating system documentation for more information.
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■ Page Setup Tab

Specifies the page settings including the paper size, scaling, number of copies, orientation, number of 
pages per sheet, etc.

For information on [Profile] and [Output Method], refer to “Profiles,” on p. 2-21.

Default settings depend on the country/region of purchase.

Preview image
Displays the image with the currently selected settings reflected. For details on 
preview image, see page 2-21.

[Page Size]

Selects the original page size to work with in an application. Available options 
are; [Letter], [11x17], [Legal], [Executive], [A5], [B5], [A4], [B4], [A3], [Index 
Card], [Envelope Monarch], [Envelope COM10], [Envelope DL], [Envelope C5], 
[Envelope B5] and [Custom [Name fixed]]. However, when [11x17], [B4] or [A3] 
is selected in the [Page Size], the original page size is automatically reduced to 
fit [A4] size.

[Output Size]
Selects the output paper size to print on. When this option is set to anything 
other than [Match Paper Size], the original page size is automatically reduced or 
enlarged to fit the selected output paper size when printed.

NOTE
Up to 50 sizes can be defined for [Custom Paper Size] with the [Custom Paper 
Size Settings] option (see p. 2-11).
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[Copies] Specifies the number of copies to be printed (1 to 99).

[Orientation] Selects the direction of printing relative to the paper ([Portrait] or [Landscape]).

[Page Layout]

Selects the number (1, 2, 4, 6, 8, 9 or 16) of original pages per sheet or [Poster] 
(2 x 2, 3 x 3 or 4 x 4 pages to comprise one sheet). When this option is set to 
anything other than [1 Page per Sheet] and [Poster], the original page size is 
reduced to fit the selected page layout when printed.

NOTE
• When [Poster] is selected, [Manual Scaling], [Watermark] and [Layout Options] are 

disabled.
• When [1 Page per Sheet] is selected, [Manual Scaling] appears. When this option 

is set to anything other than [1 Page per Sheet] and [Poster], [Manual Scaling] 
disappears and [Page Order] appears in its place.

[Manual Scaling]
Reduces or enlarges the original page size. Selecting this check box enables 
the edit box on the right side to specify the magnification factor (25 to 200%).

NOTE
If you select enlarge/reduce ratio on the [Print] screen of an application software, 
select 100% on printer setup.

[Page Order]
Selects the order in which original pages are placed on each sheet of the output 
paper when more than one page is printed per sheet.

[Paper Type]

Selects the paper type to print. Available paper types are as follows:
- Plain paper (64 to 90 g/m2)
- Plain Paper L
- Heavy Paper
- Heavy Paper H
- Transparencies

NOTE
If you select [Envelope Monarch], [Envelope COM10], [Envelope DL], or 
[Envelope C5] as [Output Size], [Paper Type] is automatically set to [Envelope].
For details, see “Loading an Envelope in the Multi-Purpose Feeder” on p. 2-7 in the 
User's Guide.
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[Watermark]

Inserts the selected watermark to be printed on each page. 8 types of 
watermark are available as default:
- CONFIDENTIAL
- COPY
- DRAFT
- FILE COPY
- FINAL
- PRELIMINARY
- PROOF
- TOP SECRET
Selecting this check box enables [Edit Watermark] to add a watermark. 

NOTE
This option is disabled when [Page Layout] is set to [Poster]. 

[Edit Watermark...] Opens the [Edit Watermark...] dialog box (see p. 2-10).

[Custom Paper Size...] Opens the [Custom Paper Size Settings] dialog box (see p. 2-11).

NOTE
This setting is available only when you open the [Canon MF5700 Series Printing 
Preferences] dialog box from the [Printers] folder.

[Layout Options...] Opens the [Layout Options] dialog box (see p. 2-13).

NOTE
This option is disabled when [Page Layout] is set to [Poster]. 

[Restore Defaults] Resets all the current settings to their default values.

[View Settings]
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed from (see p. 
2-25).
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■ Edit Watermark

Clicking [Edit Watermark...] in the [Page Setup] tab sheet opens the [Edit Watermark] dialog box. This 
dialog box enables you to insert a text string as a watermark onto pages. This option is enabled only 
when the [Watermark] check box is selected in the [Page Setup] tab sheet (see p. 2-7).

[Watermark List]
Displays the names of registered watermarks. The preview image in the upper 
left part of the dialog box displays the selected watermark with the specified 
settings reflected.

[Add]
Registers a new watermark. Clicking this button adds a blank name field in 
[Watermark List] in which you enter the name of watermark to be registered. Up 
to 50 watermarks can be registered.

[Delete] Removes the selected watermark from [Watermark List].

NOTE
You cannot delete a pre-defined watermark.

[Position]
Specifies the position where the watermark is printed on each page. You can 
enter the values in the [X] and [Y] edit boxes (in a range between –50 and +50), 
or use the X and Y slide bars to move the position.
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■ Custom Paper Size Settings

Clicking [Custom Paper Size...] in the [Page Setup] tab sheet opens the [Custom Paper Size Settings] 
dialog box. This dialog box enables you to define custom paper sizes for quick selection and register 
new custom paper sizes to the [Paper List] box. You can specify the name, width, and height of each 
size. Up to 50 custom paper sizes can be defined.

[Move to Center] Relocates the watermark to the center of the page.

[Angle]
Specifies the angle of watermark ([Upward Left to Right], [Downward Left to 
Right], or [Set Angle]). You can select the corresponding radio button, or use the 
slide bar to move the angle. 

[Name] Displays the name of the currently selected watermark.

[Text] Displays the text string of the currently selected watermark.

[Font] Selects the font type of the watermark. 

[Style]
Selects the font style of the watermark. Available styles are [Regular], [Italic], 
[Bold] and [Bold Italic].

[Size] Specifies the font size of the watermark (1 to 500).

[Color] Selects the font color of the watermark. 

[Border]
Adds the frame to the watermark. You can select the frame type ([Circle], 
[Square], or [None]).

[Print Style] Selects the type of watermark ([Transparent] or [Overlap]).

[Print on First Page Only] Prints the selected watermark only on the first page of the document.
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NOTE
• This setting is not available when the [Canon MF5700 Series Properties] dialog box is opened from a Windows 

application.
• Use the multi-purpose feeder when printing on custom-sized paper.

[Paper List]
Displays the paper sizes actually available. Selects a paper size from which you 
can create a custom paper size.

NOTE
You can share the custom paper sizes with all printers connected to your 
computer. Up to 50 sizes can be defined for [Custom Paper Size].

[Name of Custom Paper Size]

Specifies the name of custom paper.

[Unit] Selects the unit of measurement of paper size ([Millimeter] or [Inch]).

[Paper Size] Specifies the width and height of the custom paper.

NOTE
Be sure that [Width] does not exceed [Height] when specifying the values.

[Register] Registers the custom paper and adds its name to [Paper List].

[Delete] Removes the selected custom paper from [Paper List].

NOTE
You cannot delete a pre-defined paper size.
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■ Layout Options

Clicking [Layout Options...] in the [Page Setup] tab sheet opens the [Layout Options] dialog box. This 
dialog box enables you to print pages with a page frame, header, and footer. This option is disabled 
when [Page Layout] in the [Page Setup] tab sheet is set to [Poster] (see p. 2-7). 

[Edging] Adds a page frame to be printed on each page. 11 options are available.

[Print Date]
Selects if the date is printed on each page or not. Six positions to print the date 
are available. 

[Print User Name]
Selects if the user name is printed on each page or not. Six positions to print the 
user name are available. 

[Print Page Number]
Selects if the page number is printed on each page or not. Six positions to print 
the page number are available. 

[Restore Defaults] Resets all the current settings to their default values.
2-13



P
rin

tin
g

2

■ Finishing Tab

Specifies the finishing settings for the printed pages including the collating and binding. 

For information on [Profile] and [Output Method], refer to “Profiles,” on p. 2-21.

Preview image
Displays the image with the currently selected settings reflected. For details on 
preview image, see p. 2-21.

[Binding Location] Selects a binding location for the printed pages.

[Gutter...]
Click this button to set the gutter width for binding a printed document (see p. 
2-15).

[Finishing...]
Selects the Collate option to print a document in correct binding order. For 
example, when printing multiple copies of a 3-page document, the print order is 
1, 2, 3, 1, 2, 3, and so on.

NOTE
If you select [Collate] in [Finishing], the image on the left bottom of the preview 
image will change.

[Advanced Settings...]
Click this button to display [Advanced Settings] dialog box for specifying the 
finishing details (see p. 2-15).

[Restore Defaults] Resets all the current settings to their default values.

[View Settings]
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed form (see p. 
2-25).
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■ Gutter Settings

Clicking [Gutter...] in the [Finishing] tab sheet opens the [Gutter Settings] dialog box.

■ Advanced Settings

Clicking [Advanced Settings...] in the [Finishing] tab sheet opens the [Advanced Settings] dialog box.

[Gutter] Specifies the gutter width in a range between 0 and 30 mm.

[Image Refinement] Sets the Super Smoothing function of the printer.

[Restore Defaults] Resets all the current settings to their default values.
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■ Quality Tab

Specifies the settings for print quality including the resolution and contrast. 

For more information on [Profile] and [Output Method], refer to “Profiles,” on p. 2-21.

[Objective] Selects the best setting for the print job according to document content.

[Details...] 
Click this button to open the Detailed Settings for Object and make print quality 
settings (see p. 2-17).

[Manual Grayscale Settings]

Enables the manual grayscale. Selecting this check box enables [Grayscale 
Settings...] to access the dialog box which enables you to set the grayscale for 
images (see p. 2-18). 

[Grayscale Settings...]
Click this button after selecting the [Manual Grayscale Settings] check box to 
manually adjust the grayscale settings. The [Grayscale Settings] dialog box 
allows you to specify Brightness, Contrast, and Matching (see p. 2-18). 

NOTE
This option is enabled only when [Manual Grayscale Settings] is selected.

[View Settings]
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed form (see p. 
2-25). 

[About] Displays the version information on the driver. 

[Restore Defaults] Resets all the current settings to their default values.
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■ Detailed Settings

Clicking [Details...] in the [Quality] tab sheet opens the [Detailed Settings] dialog box. This dialog box 
enables you to specify the detailed settings for print quality. 

[Resolution] Selects the printer's resolution in dot per inch (600 dpi or 300 dpi).

[B & W Halftones]

Specifies the use of dithering for printing halftone data.

Pattern 1:
Applies the same dither pattern to text data, graphics data, and image data.

Pattern 2:
Applies dither pattern of clear-cut to text data, of high-quality gradation to 
graphics data, and of high-quality nature image to image data.

Pattern 3:
Applies dither pattern of clear-cut to text and graphics data, and of high-quality 
nature image to image data.

None (Solid):
Prints all colors in black except for white.

[Enable Image Correction]

Select Enable Image Correction to smooth out the streaking and coarse 
features that tend to occur when printing enlarged image files and photographs 
using a software application.

[Toner Save]

Modifies print data to print lighter and conserve toner.

Printer Default:
Prints using the settings in the operation panel of the printer.

Off:
Prints using normal density.

On:
Prints text lighter in printouts for proofreading and checking.
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■ Grayscale Settings 

Clicking [Grayscale Settings...] in the [Quality] tab sheet opens the [Grayscale Settings] dialog box. 
This dialog box enables you to control the brightness and contrast of images. This function is enabled 
only when [Manual Grayscale Setting] is selected in the [Quality] tab sheet (see p. 2-16). Two tab 
sheets are provided in this dialog box. 

● Grayscale Adjustment Tab

[Preview] Displays the image with the currently selected brightness and contrast reflected.

[Original] Displays the original image.

[Brightness] Adjusts the brightness of the preview image in the range between –5 and 5.

[Contrast] Adjusts the contrast of the preview image in the range between –5 and 5.

[Restore Defaults] Resets all the current settings to their default values.
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● Matching Tab 

[Matching Mode]

You can specify the procedure for Color correction.

Driver Matching Mode:
Processes Color in the printer driver. The settings specified in Matching Method 
and Monitor Profile will be enabled.

Gamma Adjustment:
Performs gamma adjustment with the gamma correction value specified in the 
Gamma box.

[Matching Method]

Specifies the matching method by assigning highest priority when the Driver 
Matching Mode is selected in the Matching Mode box.

Perceptual [Monitor Color Matched]:
Gives priority to matching the hue of the color on the monitor with the color of the 
printed output.

Colorimetric:
Gives priority to reducing the color difference between the original document on 
the screen (a logo, for example) and the printed output.

Saturation:
Gives priority to vividness in matching.

NOTE
This option can be selected only when Driver Matching Mode is selected for Matching Mode.
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[Monitor Profile]
Specifies the setting suitable for your monitor when the Driver Matching Mode is 
selected in the Matching Mode box.

NOTE
In the case where several gamma values are provided for one option, to obtain better results 
select the higher gamma value if the printed image is lighter than that of the monitor.
If the monitor is set to a custom setting, it is difficult to produce printed output similar to the 
color of the monitor when performing matching.

[Gamma]

Specifies the gamma correction value when the Gamma Adjustment is selected 
in the Matching Mode box.

The brightness of the document printout can be adjusted without losing the 
brightest and darkest portion of the document.

This option is useful when the printout result is brighter than the original image 
(for example, a photograph before scanning or graphics displayed on the 
monitor), or when you want to intentionally change the brightness of the output.

Four gamma correction values are provided. The larger the value, the darker the 
printout is.

1.0
1.4 Default value
1.8
2.2 

[Restore Defaults] Resets all the current settings to their default values.
2-20



P
rin

tin
g

2

■ Profiles

A registered combination of settings for the [Page Setup], [Finishing] and [Quality] tab sheets is 
referred to as a profile. The profile function commonly provided in each of these tab sheets enables you 
to add, edit, and select a profile, which facilitates your print jobs.

[Profile]

Stores various printer driver settings, each suitable for certain print jobs, as 
pre-defined Profiles. Selecting Profiles from the drop-down list enables the 
printer to perform a variety of print jobs. A frequently performed print job can 
also be saved as a Profile.

Preview image

Displays the image with the currently selected settings reflected. 
Changes the setting for [Page Layout] every time you click anywhere inside the 
image of the page (see p. 2-8). The setting changes in the following order; [1 
Page per Sheet] ➞ [2 Pages per Sheet] ➞ [4 Pages per Sheet] ➞ [1 Page per 
Sheet].... 
Right-clicking the mouse button on the preview image displays the pop-up 
menu, from which you can also change the setting for [Page Layout]. 
Clicking the edges of the preview image of the page changes the binding 
location.
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[Output Method] Switches the job mode between [Print] and [Edit and Preview].

[Print] Executes a normal print job. 

[Edit and Preview]

Saves the data in the [Canon PageComposer] dialog box. If you open [Canon 

MF5700 Series Properties] from the [Printers] folder and select the [Edit and 

Preview] mode,  (Lock) button appears on the right side. When you click this 

button, the [Edit and Preview] mode is locked. 

  (Add Profile)
Click this button to display the [Add Profile] dialog box to add a new Profile to the 
list (see p. 2-23).

  (Edit Profile)
Click this button to display the [Edit Profile] dialog box to edit the name, icon, or 
comment of a stored Profile (see p. 2-24).

[View Settings]
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed form (see p. 
2-25).
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■ Add Profile

Clicking  (Add Profile) opens the [Add Profile] dialog box. This dialog box enables you to register a 
new profile with the current settings. You can add up to 50 new profiles.

[Name] Specifies the name of the profile to be registered.

[Icon] Selects an icon to represent the profile to be registered.

[Comment] Adds comments on the profile to be registered.

[View Settings]
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed form (see p. 
2-25).
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■ Edit Profile

Clicking  (Edit Profile) opens the [Edit Profile] dialog box. This dialog box enables you to edit the 
profile selected in [Profile List].

[Profile List] Displays the list of registered profiles. 

[View Settings]
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed form (see p. 
2-25).

  (Move Up) Moves the profile selected in the [Profile List] one position up.

  (Move Down) Moves the profile selected in the [Profile List] one position down.

[Delete] Removes the selected profile from [Profile List].

NOTE
When one of the pre-defined profiles is selected, this button is disabled.

[Name] Displays and allows you to change the name of the currently selected profile. 

NOTE
When one of the pre-defined profiles is selected, the name cannot be changed.
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■ View Settings

Clicking [View Settings] opens the [View Settings] dialog box. This dialog box displays the current 
settings in the [Page Setup], [Finishing], and [Quality] tab sheets. 

[Icon]
Displays and allows you to change the icon representing the currently selected 
profile.

NOTE
When one of the pre-defined profiles is selected, the icon cannot be changed.

[Comment]
Displays and allows you to change the comment on the currently selected 
profile. 

NOTE
When one of the pre-defined profiles is selected, the comment cannot be changed.

[Import...] Enables you to import profile information from a file.

[Export...] Enables you to export the selected profile information to a file.

NOTE
When one of the pre-defined profiles is selected, this button is disabled.

[Apply Settings from Application] 

Applies the selected profile only to the settings other than [Page Size], 
[Orientation] and [Copies].

[Copy] Copies the contents of the current settings to the clipboard.
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Windows 2000/XP/Server 2003 Properties and Printing 
Preferences

The printer driver for Windows 2000/XP/Server 2003 has the following two main dialog boxes:

■ The Properties Dialog Box
This dialog box enables you to set up the printer configuration and configure the print settings for all 
Windows applications.

■ The Printing Preferences Dialog Box
This dialog box enables you to specify the default settings for the printing options available when you 
print on the Canon MF5700 Series. 

Properties
The [Canon MF5700 Series Properties] dialog box contains several tab sheets that enable you to set 
up the printer configuration and configure the print settings.

NOTE
• The number of tabs displayed in the properties dialog box depends on how you have your system set up. 
• For more information about the following features, see the Online Help (see p. 1-2).
• The screen shots shown are from Windows XP. 
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■ General Tab

Lets you print a test page and define printing preferences. Refer to your Windows operating system 
documentation for more information.
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■ Sharing Tab

Specifies the printer sharing settings. This tab sheet is available only when the printer sharing is 
enabled (see p. 2-58). Refer to your Windows operating system documentation for more information.
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■ Ports Tab

Specifies the port to which the printer is attached. Refer to your Windows operating system 
documentation for more information.
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■ Advanced Tab

Specifies the settings for print spooling. Refer to your Windows operating system documentation for 
more information.

NOTE
[Spool print documents so program finishes printing faster] and [Start printing immediately] are set automatically 
when you install the printer driver.
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■ Color Management Tab

Associates color profiles with your color printer. Refer to your Windows operating system 
documentation for more information.
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■ Security Tab

Specifies security settings. Refer to your operating system documentation for more information.
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■ Profile Tab

Enables you to add, edit, and select a profile to be applied to print jobs. 

[Profile List] Displays the list of registered profiles. 

[Name] Displays the name of the profile currently selected in [Profile List]. 

[Comment] Describes the currently selected profile.

[View Settings] Displays the settings of the currently selected profile.

[Add...]
Opens the [Add/Edit Profile] dialog box which enables you to register a new 
profile (see p. 2-34).

[Edit...]
Opens the [Add/Edit Profile] dialog box which enables you to edit the registered 
profiles (see p. 2-34). 

NOTE
When one of the pre-defined profile ([Default Settings], [2 on 1], or [Confidential]) is 
selected in [Profile List], this button is disabled. 

[Delete] Removes the selected profile from [Profile List]. 

NOTE
When one of the pre-defined profiles is selected, this button is disabled.

[Import...] Enables you to import profile information from a file.

[Export...] Enables you to export the selected profile information to a file.

NOTE
When one of the pre-defined profiles is selected, this button is disabled.
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■ Add/Edit Profile

Clicking [Add...] or [Edit...] opens the [Add/Edit Profile] dialog box which enables you to register new 
profiles and edit existing profiles. This dialog box has four tab sheets. 

● Attribution Tab

The [Attribution] tab sheet enables you to specify attributions of the profile. 

[Define Document Property]

Controls the profile settings.

[Allow Profile Selection]

Enables the selecting of profiles in the document properties dialog box.

[Allow Setting Edition]

Enables the adding and editing of profiles as well as selecting. 

NOTE
When [Allow Profile Selection] is cleared, [Allow Setting Edition] is disabled. 

[Name]
Specifies the name of the new profile, or allows you to change the name of the 
profile selected in the [Profile] tab sheet. 

NOTE
When one of the pre-defined profiles is selected, the name cannot be changed.
2-34



P
rin

tin
g

2

● Page Setup Tab

Specifies the page settings including the paper size, scaling, number of copies, orientation, and 
number of pages per sheet (see p. 2-36).

● Finishing Tab 

Specifies the finishing settings for the printed pages including the collating and binding (see p. 2-43).

● Quality Tab

Specifies the print quality including resolution, brightness and contrast (see p. 2-45).

Printing Preferences
The [Canon MF5700 Series Printing Preferences] dialog box contains three tab sheets that enable you 
to specify the default print settings for every print job.

NOTE
• If you access the equivalent dialog box from an application's [Print] dialog box, your selected printing options apply 

only to the current print job.
• For more information about the following features, see the Online Help (see p. 1-2).
• The screen shots shown are from Windows XP.

[Icon]
Selects an icon to represent the new profile, or allows you to change the icon of 
the profile selected in the [Profile] tab sheet.

NOTE
When one of the pre-defined profiles is selected, the icon cannot be changed.

[Comment]
Adds comments on the new profile, or allows you to change the comments on 
the profile selected in the [Profile] tab sheet.

NOTE
When one of the pre-defined profiles is selected, the comment cannot be changed.

[Restore Defaults] Resets all the current settings to their default values. 
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■ Page Setup Tab

Specifies the page settings including the paper size, scaling, number of copies, orientation, number of 
pages per sheet, etc.

For information on [Profile], refer to “Profiles,” on p. 2-50.

Default settings depend on the country/region of purchase.

Preview image
Displays the image with the currently selected settings reflected. For details on 
preview image, see page 2-50.

[Page Size]

Selects the original page size to work with in an application. Available options 
are; [Letter], [11 x17], [Legal], [Executive], [A5], [B5], [A4], [B4], [A3], [Envelope 
Monarch], [Envelope COM10], [Envelope DL], [Envelope C5], and [Custom 
[Name fixed]]. However, when [11x17], [B4] or [A3] is selected in the [Page 
Size], the original page size is automatically reduced to fit [A4] size.

[Output Size]
Selects the output paper size to print on. When this option is set to anything 
other than [Match Paper Size], the original page size is automatically reduced or 
enlarged to fit the selected output paper size when printed.

[Copies] Specifies the number of copies to be printed (1 to 99).

[Orientation] Selects the direction of printing relative to the paper ([Portrait] or [Landscape]).
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[Page Layout]

Selects the number (1, 2, 4, 6, 8, 9 or 16) of original pages per sheet or [Poster] 
(2 x 2, 3 x 3 or 4 x 4 pages to comprise one sheet). When this option is set to 
anything other than [1 Page per Sheet] and [Poster], the original page size is 
reduced to fit the selected page layout when printed.

NOTE
• When [Poster] is selected, [Manual Scaling], [Watermark] and [Layout Options...] 

are disabled.
• When [1 Page per Sheet] is selected, [Manual Scaling] appears. When this option 

is set to anything other than [1 Page per Sheet] and [Poster], [Manual Scaling] 
disappears and [Page Order] appears in its place.

[Manual Scaling]
Reduces or enlarges the original page size. Selecting this check box enables 
the edit box on the right side to specify the magnification factor (25 to 200%).

NOTE
If you select enlarge/reduce ratio on the [Print] screen of an application software, 
select 100% on printer setup.

[Page Order]
Selects the order in which original pages are placed on each sheet of the output 
paper when more than one page is printed per sheet.

[Watermark]

Inserts the selected watermark to be printed on each page. Eight types of 
watermark are available as default:
- CONFIDENTIAL
- COPY
- DRAFT
- FILE COPY
- FINAL
- PRELIMINARY
- PROOF
- TOP SECRET
Selecting this check box enables [Edit Watermark...] to add a watermark. 

NOTE
This option is disabled when [Page Layout] is set to [Poster]. 
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[Paper Type]

Selects the paper type to print. Available paper type are as follows:
- Plain paper (64 to 90 g/m2)
- Plain Paper L
- Heavy Paper
- Heavy Paper H
- Transparencies

NOTE
If you select [Envelope Monarch], [Envelope COM10], [Envelope DL], or 
[Envelope C5] as [Output Size], [Paper Type] is automatically set to [Envelope].
For details, see “Loading an Envelope in the Multi-Purpose Feeder” on p. 2-7 in the 
User's Guide.

[Edit Watermark...] Click this button to specify detailed watermark settings (see p. 2-39).

[Custom Paper Size...]
Click this button to specify the dimensions for a paper size other than the 
provided standard paper sizes (see p. 2-40).

NOTE
You can specify the dimensions for a paper size only in the Printer Properties 
dialog box (Windows ➞ [start] ➞ [Printers and Faxes]). You cannot specify the 
dimensions from the Document Properties dialog box (software application).

[Layout Options...]
Click this button to select options for printing dates, user name, page numbers, 
and borders, etc. (see p. 2-42).

NOTE
This option is disabled when [Page Layout] is set to [Poster].

[Restore Defaults] Resets all the current settings to their default values.

[View Settings]
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed form (see p. 
2-54).
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■ Edit Watermark

Clicking [Edit Watermark...] in the [Page Setup] tab sheet opens the [Edit Watermark] dialog box. This 
dialog box enables you to insert a text string as a watermark onto pages. This option is enabled only 
when the [Watermark] check box is selected in the [Page Setup] tab sheet (see p. 2-36).

[Watermark List]
Displays the names of registered watermarks. The preview image in the upper 
left part of the dialog box displays the selected watermark with the specified 
settings reflected.

[Add]
Registers a new watermark. Clicking this button adds a blank name field in 
[Watermark List] in which you enter the name of watermark to be registered. Up 
to 50 watermarks can be registered.

[Delete] Removes the selected watermark from [Watermark List].

NOTE
You cannot delete a pre-defined watermark.

[Position]
Specifies the position where the watermark is printed on each page. You can 
enter the values in the [X] and [Y] edit boxes (in a range between –50 and +50), 
or use the X and Y slide bars to move the position. 

[Move to Center] Relocates the watermark to the center of the page. 

[Angle]

Sets the angle of watermark. ([Upward Left to Right], [Downward Left to Right], 
or [Set Angle]). You can select the corresponding radio button, or use the slide 
bar to move the angle, or enter a desired value in the [Set Angle] edit box (in a 
range between -180 and 180). 
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■ Custom Paper Size Settings

Clicking [Custom Paper Size...] in the [Page Setup] tab sheet opens the [Custom Paper Size Settings] 
dialog box. This dialog box enables you to define custom paper sizes for quick selection and register 
new custom paper sizes to the [Paper List] box. You can specify the name, width, and height of each 
size.

NOTE
• This setting is available only when you open the [Canon MF5700 Series Printing Preferences] dialog box from the 

[Printers and Faxes] (Windows 98/Me/2000: [Printers]) folder.
• Use the multi-purpose feeder when printing on custom-sized paper.

[Name] Displays the name of the currently selected watermark.

[Text] Displays the text string of the currently selected watermark.

[Font] Selects the font type of the watermark. 

[Style]
Selects the font style of the watermark. Available styles are [Regular], [Italic], 
[Bold] and [Bold Italic].

[Size] Specifies the font size of the watermark (1 to 500).

[Color] Selects the font color of the watermark. 

[Border]
Adds the frame to the watermark. You can select the frame type ([Circle], 
[Square], or [None]).

[Print Style] Selects the type of watermark ([Transparent] or [Overlap]).

[Print on First Page Only] Prints the selected watermark only on the first page of the document.

[Paper List]
Displays the paper sizes actually available. Selects a paper size from which you 
can create a custom paper size.

NOTE
You can share the custom paper sizes with all printers connected to your 
computer. Up to 50 sizes can be defined for [Custom Paper Size].
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[Name of Custom Paper Size]

Specifies the name of custom paper.

[Unit] Selects the unit of measurement of paper size ([Millimeter] or [Inch]).

[Paper Size] Specifies the width and height of the custom paper.

NOTE
Be sure that [Width] does not exceed [Height] when specifying the values.

[Register] Registers the custom paper and adds its name to [Paper List].

NOTE
To register a new custom paper size, be sure to log on as a member of 
Administrators (Windows 2000/XP/Server 2003) or Power User (Windows 2000 
only). To change the paper size for the existing custom paper size, be sure to log 
on as a member of Administrators.

[Delete] Removes the selected custom paper from [Paper List].

NOTE
• You cannot delete a pre-defined paper size.
• To delete a registered custom paper size, you be sure to log on as a member of 

Administrators.
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■ Layout Options

Clicking [Layout Options...] in the [Page Setup] tab sheet opens the [Layout Options] dialog box. This 
dialog box enables you to print pages with a page frame, header, and footer. This option is disabled 
when [Page Layout] in the [Page Setup] tab sheet is set to [Poster] (see p. 2-36).

[Edging]
Adds a page frame to be printed on each page. 11 options are available. Edging 
is not available to use with [Print Grayscale Sample] in the [Quality] tab sheet 
(see p. 2-45).

[Print Date]
Selects if the date is printed on each page or not. Six positions to print the date 
are available. 

[Print User Name]
Selects if the user name is printed on each page or not. Six positions to print the 
user name are available. 

[Print Page Number]
Selects if the page number is printed on each page or not. Six positions to print 
the page number are available. 

[Restore Defaults] Resets all the current settings to their default values.
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■ Finishing Tab

Specifies the finishing settings for the printed pages including the collating and binding.

For information on [Profile] and [Output Method], refer to “Profiles,” on p. 2-50.

Preview image
Displays the image with the currently selected settings reflected. For details on 
preview image, see page 2-50.

[Binding Location] Selects a binding location for the printed pages.

[Gutter...]
Click this button to set the gutter width for binding a printed document (see p. 
2-44).

[Finishing...]
Select the Collate option to print a document in correct binding order. For 
example, when printing multiple copies of a 3-page document, the print order is 
1, 2, 3, 1, 2, 3, and so on. ([Off] or [Collate]).

NOTE
If you select [Collate] in [Finishing], the image on the left bottom of the preview 
image will change.

[Advanced Settings...]
Click this button to display [Advanced Settings] dialog box for specifying the 
finishing details (see p. 2-44).

[Restore Defaults] Resets all the current settings to their default values.

[View Settings]
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed form (see p. 
2-54).
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■ Gutter Settings

Clicking [Gutter...] in the [Finishing] tab sheets opens the [Gutter Settings] dialog box. 

■ Advanced Settings

Clicking [Advanced Settings...] in the [Finishing] tab sheet opens the [Advanced Settings] dialog box.

[Gutter] Specifies the gutter width in a range between 0 and 30 mm.

[Image Refinement] Sets the Super Smoothing function of the printer.

[Restore Defaults] Resets all the current settings to their default values.
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■ Quality Tab

Specifies the settings for print quality including the resolution and contrast. 

For information on [Profile] and [Output Method], refer to “Profiles,” on p. 2-50.

[Objective] Selects the best setting for the print job according to document content.

[Details...] 
Click this button to open the Detailed Settings for Object and make print quality 
settings (see p. 2-46).

[Manual Grayscale Settings]

Enables the manual grayscale. Selecting this check box enables [Grayscale 
Settings...] to access the dialog box which allows you to set the grayscale for 
images (see p. 2-47).

[Print Grayscale Sample]
Prints nine thumbnails per sheet to provide the print samples with the current 
grayscale settings when printing the document. 

NOTE
This option is enabled only when [Manual Grayscale Settings] is selected.

[Grayscale Settings...]
Click this button after selecting the [Manual Grayscale Settings] check box to 
manually adjust the grayscale settings. The [Grayscale Settings] dialog box 
allows you to specify Brightness, Contrast, and Matching (see p. 2-47). 

NOTE
This option is enabled only when [Manual Grayscale Settings] is selected.

[View Settings]
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed form (see p. 
2-54).

[About] Displays the version information on the driver. 

[Restore Defaults] Resets all the current settings to their default values.
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■ Detailed Settings

Clicking [Details...] in the [Quality] tab sheet opens the [Detailed Settings] dialog box. This dialog box 
enables you to specify detailed settings for print quality.

[Resolution] Selects the printer's resolution in dot per inch (600 dpi or 300 dpi).

[B & W Halftones]

Specifies the use of dithering for printing halftone data.

Pattern 1:
Applies the same dither pattern to text data, graphics data, and image data.

Pattern 2:
Applies dither pattern of clear-cut to text data, of high-quality gradation to 
graphics data, and of high-quality nature image to image data.

Pattern 3:
Applies dither pattern of clear-cut to text and graphics data, and of high-quality 
nature image to image data.

None (Solid):
Prints all colors in black except for white.

[Enable Image Correction]

Select Enable Image Correction to smooth out the streaking and coarse 
features that tend to occur when printing enlarged image files and photographs 
using a software application.

[Toner Save]

Modifies print data to print lighter and conserve toner.

Printer Default:
Prints using the settings in the operation panel of the printer.

Off:
Prints using normal density.

On:
Prints text lighter in printouts for proofreading and checking.
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■ Grayscale Settings 

Clicking [Grayscale Settings...] in the [Quality] tab sheet opens the [Grayscale Settings] dialog box. 
This dialog box enables you to control the brightness and contrast of images. This function is enabled 
only when [Manual Grayscale Settings] is selected in the [Quality] tab sheet (see p. 2-45). Two tab 
sheets are provided in this dialog box. 

● Grayscale Adjustment Tab

[Preview] Displays the image with the currently selected brightness and contrast reflected.

[Original] Displays the original image.

[Brightness] Adjusts the brightness of the preview image in the range between –5 and 5.

[Contrast] Adjusts the contrast of the preview image in the range between –5 and 5.

[Restore Defaults] Resets all the current settings to their default values.
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● Matching Tab 

[Matching Mode]

Specifies the procedure for color correction.

Driver Matching Mode:
Processes color in the printer driver. The settings specified in Matching Method 
and Monitor Profile will be enabled.

Gamma Adjustment:
Performs gamma adjustment with the gamma correction value specified in the 
Gamma box.

[Matching Method]

Specifies the matching method by assigning highest priority when the Driver 
Matching Mode is selected in the Matching Mode box.

Perceptual [Monitor Color Matched]:
Gives priority to matching the hue of the color on the monitor with the color of 
the printed output.

Colorimetric:
Gives priority to reducing the color difference between the original document on 
the screen (a logo, for example) and the printed output.

Saturation:
Gives priority to vividness in matching.

NOTE
This option can be selected only when Driver Matching Mode or ICM Mode is 
selected for Matching Mode.
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[Monitor Profile]
Specifies the setting suitable for your monitor when the Driver Matching Mode is 
selected in the Matching Mode box.

NOTE
In the case where several gamma values are provided for one option, to obtain 
better results select the higher gamma value if the printed image is lighter than that 
of the monitor.
If the monitor is set to a custom setting, it is difficult to produce printed output 
similar to the color of the monitor when performing matching.

[Gamma]

Specifies the gamma correction value when the Gamma Adjustment is selected 
in the Matching Mode box.

The brightness of the document printout can be adjusted without losing the 
brightest and darkest portion of the document.

This option is useful when the printout result is brighter than the original image 
(for example, a photograph before scanning or graphics displayed on the 
monitor), or when you want to intentionally change the brightness of the output.

Four gamma correction values are provided. The larger the value, the darker the 
printout is.

1.0
1.4 Default value
1.8
2.2

[Restore Defaults] Resets all the current settings to their default values.
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■ Profiles

A registered combination of settings for the [Page Setup], [Finishing], and [Quality] tab sheets is 
referred to as a profile. The profile function commonly provided in each of these tab sheets enables you 
to add, edit, and select a profile, which facilitates your print jobs.

.

[Profile]

Stores various printer driver settings, each suitable for certain print jobs, as 
pre-defined Profiles. Selecting Profiles from the drop-down list enables the 
printer to perform a variety of print jobs. A frequently performed print job can 
also be saved as a Profile.

Preview image

Displays the image with the currently selected settings reflected. 
Changes the setting for [Page Layout] every time you click anywhere inside the 
image of the page (see p. 2-36). The setting changes in the following order; [1 
Page per Sheet] ➞ [2 Pages per Sheet] ➞ [4 Pages per Sheet] ➞ [1 Page per 
Sheet]….
Right-clicking the mouse button on the preview image displays the pop-up 
menu, from which you can also change the setting for [Page Layout]. 
Clicking the edges of the preview image of the page changes the binding 
location.
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[Output Method] Switches the job mode between [Print] and [Edit and Preview].

[Print] Executes a normal print job. 

[Edit and Preview]

Saves the data in the [Canon PageComposer] dialog box. If you open [Canon 

MF5700 Series Properties] from the [Printers and Faxes] (Windows 2000: 

[Printers]) folder and select the [Edit and Preview] mode,  (Lock) button 

appears on the right side. When you click this button, the [Edit and Preview] 

mode is locked.

 (Add Profile)
Click this button to display the[ Add Profile] dialog box to add a new Profile to the 
list (see p. 2-52).

 (Edit Profile)
Click this button to display the [Edit Profile] dialog box to edit the name, icon, or 
comment of a stored Profile (see p. 2-53).

[View Settings]
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed form (see p. 
2-54).
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■ Add Profile

Clicking  (Add Profile) opens the [Add Profile] dialog box. This dialog box enables you to register a 
new profile with the current settings. You can add up to 50 new profiles.

[Name] Specifies the name of the profile to be registered.

[Icon] Selects an icon to represent the profile to be registered.

[Comment] Adds comments on the profile to be registered.

[View Settings] 
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed form (see p. 
2-54).
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■ Edit Profile

Clicking  (Edit Profile) opens the [Edit Profile] dialog box. This dialog box enables you to edit the 
profile selected in [Profile List].

[Profile List] Displays the list of registered profiles.

[View Settings]
Click this button to display the [View Settings] dialog box. This dialog box allows 
you to view and confirm all of the current page settings in a listed form (see p. 
2-54).

(Move Up) Moves the profile selected in the [Profile List] one position up.

(Move Down) Moves the profile selected in the [Profile List] one position down.

[Delete] Removes the selected profile from [Profile List].

NOTE
When one of the pre-defined profiles or the profiles you defined in the [Profile] tab 
of the printer properties dialog box is selected, you cannot delete it.

[Name] Displays and allows you to change the name of the currently selected profile. 

NOTE
When one of the pre-defined profiles or the profiles you defined in the [Profile] tab 
of the printer properties dialog box is selected, the name cannot be changed.

[Icon]
Displays and allows you to change the icon representing the currently selected 
profile.

NOTE
When one of the pre-defined profiles or the profiles you defined in the [Profile] tab 
of the printer properties dialog box is selected, the icon cannot be changed.
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■ View Settings

Clicking [View Settings] opens the [View Settings] dialog box. This dialog box displays the current 
settings in the [Page Setup], [Finishing], and [Quality] tab sheets. 

[Comment]
Displays and allows you to change the comment on the currently selected 
profile. 

NOTE
When one of the pre-defined profiles or the profiles you defined in the [Profile] tab 
of the printer properties dialog box is selected, the comment cannot be changed.

[Import...] Enables you to import profile information from a file.

[Export...] Enables you to export the selected profile information to a file.

NOTE
When one of the pre-defined profiles is selected, this button is disabled.

[Apply Settings from Application]

 
Applies the selected profile only to the settings other than [Page Size], 
[Orientation] and [Copies].

[Copy] Copies the contents of the current settings to the clipboard.
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Using the Machine on Your Network
This section provides instructions for using the Canon imageCLASS MF5700 Series machine on your 
network as a shared printer. 

By setting your machine as a shared printer on your network, the network users can share the machine 
for printing. The print server and clients do not need to use the same operating system, and it is 
possible to print from a Windows 98/Me client to a Windows 2000/XP/Server 2003 print server, or vice 
versa. 

You can start printing simply by starting the server, even if the server was not running when the client 
was started. 

If the server is running on Windows 2000/XP/Server 2003, you can print even if no one is logged into 
the server.

Setting the Machine as a Shared Printer
If you plan to share your Canon imageCLASS MF5700 Series machine on a network, install the print 
server locally, then make the following settings. For more information, see your print server system 
documentation.

■ Windows 2000/XP/Server 2003 Server Settings

The following is the procedure to make your machine available to your network users, under Windows 
2000/XP/Server 2003. 

■ Adding Server Service (Windows XP/Server 2003)

1 Click [start] on the Windows task bar ➞ select [Control Panel]. 

The [Control Panel] folder appears.

2 Double-click [Network Connections]. 

The [Network Connections] folder appears.

3 Right-click the [Local Area Connection] icon ➞ select [Properties] from the pop-up menu. 

The [Local Area Connection Properties] dialog box appears.
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4 Select [File and Printer Sharing for Microsoft Networks] ➞ click [OK].

The server service is added.
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■ Adding Server Service (Windows 2000)

1 Click [Start] on the Windows task bar ➞ select [Settings] ➞ [Network and Dial-up Connections]. 

The [Network and Dial-up Connections] folder appears.

2 Right-click the [Local Area Connection] icon ➞ select [Properties] from the pop-up menu. 

The [Local Area Connection Properties] dialog box appears.

3 Select [File and Printer Sharing for Microsoft Networks] ➞ click [OK].

The server service is added.
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■ Setting Printer Sharing

1 Open the printer properties dialog box ➞ select [Share this printer] (Windows 2000: [Shared as]) in the 
[Sharing] tab sheet.

NOTE
On how to open the printer properties dialog box, see “Changing Print Settings,” on p. 2-2.

2 Enter a share name in the edit box as needed.

NOTE
Do not enter a space or special character in the [Share name] edit box.

3 Click [OK]. 

The printer driver icon changes to indicate sharing.
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■ Windows 98/Me Server Settings

The following is the procedure to make your machine available to your network users, under Windows 
98/Me. 
The screen shots shown are from Windows 98. 

■ Adding Server Service

1 Click [Start] on the Windows task bar ➞ select [Settings] ➞ [Control Panel].

The [Control Panel] folder appears.

2 Double-click the [Network] icon.

The [Network] dialog box appears.

3 Click [Add...] in the [Configuration] tab sheet.

The [Select Network Component Type] dialog box appears.

4 Select [Service] ➞ click [Add...].

The [Select Network Service] dialog box appears.
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5 Select [File and printer sharing for Microsoft Networks] ➞ click [OK].

6 Click [File and Print Sharing...].

The [File and Print Sharing] dialog box appears.

7 Select [I want to be able to allow others to print to my printer(s).] ➞ click [OK].
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8 Select the [Access Control] tab ➞ [Share-level access control] or [User-level access control].

9 Click [OK].

The server service is added. 

If the confirmation message dialog box appears, click [Yes] to restart your computer.

Using the Shared Printer on Your Network
When the imageCLASS MF5700 Series machine is already on your network and set as a shared 
printer, you can use it via network. The easiest way to make the machine available for your computer is 
using network download. If your operating system is Windows 2000/XP/Server 2003, you cannot 
download the driver from Windows 98/Me servers. In that case, use [Add Printer Wizard].

■ Network Download

The following is the procedure to connect to the shared printer on your network using network 
download.

NOTE
Windows 2000/XP/Server 2003 clients cannot download the driver from Windows 98/Me servers.

1 Open Explorer ➞ browse the network until you can see the icon of the shared printer.

2 Double-click the machine icon, or drag the machine icon to your [Printers and Faxes] (Windows 98/Me/
2000: [Printers]) folder.

The [Add Printer Wizard] dialog box appears.

3 Follow the instructions on the screen to complete the installation.
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■ Add Printer Wizard (Windows 2000/XP/Server 2003)

The following is the procedure to connect to the shared printer on your network using Windows 2000/
XP/Server 2003. 

IMPORTANT
Installation in Windows 2000/XP/Server 2003 needs to be done by a user with administrator privileges.

1 Open the [Printers and Faxes] (Windows 2000: [Printers]) folder.

Click [start] on the Windows task bar ➞ select [Printers and Faxes] (Windows 2000: [Start] ➞ [Settings] ➞ 
[Printers]).

2 Open the [Add Printer Wizard] dialog box.

Click [Add a printer] in [Printer Tasks] (Windows 2000: double-click the [Add Printer] icon).

3 Click [Next >].

4 Select [A network printer, or a printer attached to another computer] (Windows 2000: [Network printer]) ➞ 

click [Next >]. 

The [Specify a Printer] (Windows 2000: [Connect to Printer]) dialog box appears.

5 Select [Connect to this printer (or to browse for a printer, select this option and click Next)] (Windows 
2000: [Type the printer name, or click Next to browse for a printer]) ➞ enter the name of the printer you 
want to connect to ➞ click [Next >].

If you do not know the name of the printer, click [Next >] without entering the name to proceed to the [Browse for 
Printer] dialog box. In this dialog box, select the printer ➞ click [OK]. 

NOTE
• If the printer name is invalid, it means the client cannot to connect the shared printer. 
• If a suitable driver is not found, it probably means the server is a Windows 98/Me computer. 

6 Follow the instructions on the screen to complete the installation.

■ Add Printer Wizard (Windows 98/Me)

The following is the procedure to connect to the shared printer on your network using Windows 98/Me 
[Add Printer Wizard]. 
The screen shots shown are from Windows 98.

1 Click [Start] on the Windows task bar ➞ select [Settings] ➞ [Printers].

The [Printers] folder appears.

2 Double-click the [Add Printer] icon.

The [Add Printer Wizard] dialog box appears.

3 Click [Next >].

4 Select [Network printer] ➞ click [Next >].
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5 Enter the network path or print queue that you want to connect to, or select the location of the shared 
printer.

● To enter the location directly:

❑ Enter the path name or print queue in the edit box.

● To select the location:

❑ Click [Browse...].

❑ Select the location of the printer ➞ click [OK].

NOTE
Depending on your network environment, the installation of the driver may be carried out automatically. In this 
case you need not perform steps 7 through 10 below.

6 Click [Next >].

7 Click [Have Disk...].

The [Install From Disk] dialog box appears.
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8 Select the location containing the printer driver.

● To specify in the default location:

❑ Go to step 9.

● To change the location:

❑ Click [Browse...].

❑ Select the location containing the printer driver ➞ click [OK].

You can also enter the path name directly in the edit box.

9 Click [OK].

10 Enter the name of the printer you want to use ➞ click [Next >].

If you accept the default name, leave the edit box as it is ➞ click [Next >].

NOTE
If the connection fails, you will be able to install the printer but you will not be able to use the printer until it comes 
back online.

11 Follow the instructions on the screen to complete the installation.
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Scanning
This chapter explains the procedure to scan documents to your computer.

IMPORTANT
• For better scanning quality, we recommend that you place documents on the platen glass. If you use the ADF, the 

scanned image might not be clear.
• Your machine must be connected via USB and the USB printer driver loaded to scan. This machine does not 

support network scanning. 

Scanning with [Start] on the Machine
By pressing [SCAN] ➞ [Start] on the operation panel of the machine, you can scan documents to your 
computer.

Pressing [SCAN] ➞ [Start] has the same effect as clicking [Save] in the MF Toolbox.

You can change the settings for [Save], or set up a button other than [Save] to perform the same 
operation. (See "Setting the Scanning Function for [Start]," on p. 3-1.)

NOTE
You can use the machine for only a local scanner (connected directly to your computer).

1 Place the document face-down on the platen glass or load it face-up in the ADF.

2 Press [SCAN] ➞ [Start] on the machine.

If you are asked to select a program to launch, select “MF Toolbox Ver4.7.”

Scanning starts.

The MF Toolbox and the [Save] dialog box will open, but the document will be scanned without pressing [Start] in 
the [Save] dialog box.

The scanned document will be processed according to your settings.

When you use [Start] for the first time, a folder with the scanning date will be created in the [My Pictures] folder in the 
[My Documents] folder, and your document will be saved in this folder. If there is no [My Pictures] folder, the folder 
with the scanning date will be created in the [My Documents] folder and your document will be saved in this folder.

Setting the Scanning Function for [Start]
When you scan for the first time using [Start] on the machine, scanning will occur in the same way as 
when you click [Save] in the MF Toolbox. 

Setting Up [Start] to Operate in a Different Way from [Save]

1 On the Windows desktop, double-click [Canon MF Toolbox 4.7].

Alternatively, on the Windows desktop, click [start] ➞ [(All) Programs] ➞ [Canon] ➞ [MF Toolbox 4.7] ➞ [Toolbox 
4.7]. The MF Toolbox will open.
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2 Drag the  mark over the button you want to select.

The  mark will be displayed above the button you select.

Setting Up [Start] in the [Settings] Dialog Box
In the MF Toolbox, click [Settings]. In the [Settings] dialog box, from the pull-down list for [Start], select 
the button you want to link [Start] to, then click [OK].

You can also set up [Start] in the [Scanners and Cameras] folder (see p. 3-3).
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Setting Up [Start] in the [Scanners and Cameras] Folder (Windows 
98/2000: the [Scanners and Cameras Properties] Dialog Box)

1 Open the [Scanners and Cameras] folder (Windows 98/2000: the [Scanners and Cameras Properties] 
dialog box).

Click [start] on the Windows task bar, select [Control Panel] ➞ [Scanners and Cameras] (Windows 98/Me/2000: 
[Settings] ➞ [Control Panel] ➞ double-click the [Scanners and Cameras] icon).

2 Click the corresponding scanner driver name or icon.

3 From the [File] menu, click [Properties]. (Windows 98/2000: Click [Properties].)
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4 Specify an action for [Start].

● On Windows XP:

❑ Select the [Events] tab ➞ select [Canon MF5730 Scan Button], [Canon MF5750 Scan Button] or [Canon 
MF5770 Scan Button] in the [Select an event] pull-down list ➞ select the operation for [Start] in [Actions] ➞ 
click [OK].

● On Windows 98/2000/Me:

❑ Select the [Events] tab ➞ select [Canon MF5730 Scan Button], [Canon MF5750 Scan Button] or [Canon 
MF5770 Scan Button] in the [Scanner events] pull-down list ➞ select the operation for [Start] in [Send to this 
application] ➞ click [OK].

NOTE
If the settings you specified in the scanner property dialog box do not work immediately, disconnect and reconnect 
the USB cable, or restart your computer.
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Scanning with the MF Toolbox
You can scan a document using the buttons on the MF Toolbox.

1 Place the document face-down on the platen glass or load it face-up in the ADF. 

2 On the Windows desktop, double-click [Canon MF Toolbox 4.7].

Alternatively, on the Windows desktop, click [start] ➞ [(All) Programs] ➞ [Canon] ➞ [MF Toolbox 4.7] ➞ [Toolbox 
4.7]. The MF Toolbox will open.

3 Click one of the scanning buttons below.

[Mail]
The document will be scanned and attached to an e-mail message in your e-mail 
application.

[OCR] The text will be scanned and read by the OCR software.

[Save] The document will be scanned and saved.

[PDF] The text will be scanned and saved as a PDF file.

[Scan-1], [Scan-2]
The text will be scanned and appear in the registered application. You can change 
the button name by directly entering a new name over the button name. The name 
can be up to 8 characters long.

[MF Toolbox] buttons
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A dialog box will appear for each of the buttons.

4 Adjust the settings.

For details, see “MF Toolbox Settings,” on p. 3-8.

If you clicked a button other than [Mail], [Save] or [PDF] and no application appears in [Link Scanned Images to], 
select an application.

If you want to keep the same settings for future scans, click [Apply] before clicking [Start].

Example: [Mail] dialog box
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5 Click [Start].

If you checked the [Use the Scanner Driver to Make Advanced Settings] checkbox in step 4, the [ScanGear MF] 
dialog box will appear. 

Adjust the settings, then click [Scan].

For details, see “Setting Preferences and Scanning with ScanGear MF,” on p. 3-14.

Scanning starts.

If you clicked [Mail], [Save] or [PDF] in step 3, a folder with the scanning date will be created in the [My Pictures] 
folder in the [My Documents] folder, and your document will be saved in this folder. If there is no [My Pictures] 
folder, the folder with the scanning date will be created in the [My Documents] folder and your document saved in 
this folder.

If you clicked [Mail], [OCR], [PDF], [Scan-1], or [Scan-2] in step 3, the scanned image will be displayed in the 
application after scanning. Send the e-mail message or perform OCR conversion. (The scanned image will not be 
displayed if you have not installed the applications on the MF5700 Series Setup CD-ROM or if you have not set 
the [Link Scanned Images to] setting.)

When the applications in the MF5700 Series Setup CD-ROM are installed, they will be registered in the MF 
Toolbox buttons.

[OCR] ScanSoft OmniPage

[PDF] Presto! PageManager

NOTE
If white lines appear on one edge of the scanned image, check that the document is correctly placed on the platen 
glass. A document should be placed approximately 3 mm from the front edge (i.e., the edge closest to the 
operation panel) of the platen glass.

[ScanGear MF] dialog box
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MF Toolbox Settings

Scanner Settings
You can specify the scanning mode, scanning resolution, document size, and file size of the scanned 
image. You can also select to make advanced settings using the ScanGear MF.

■ [Select Source]
Selects where the document is placed ([Platen Glass], [Document Feeder], or [Auto mode]).

NOTE
When [Auto mode] is selected, the document in the ADF is automatically scanned. If there is no document in the 
ADF, the document on the platen glass will be scanned.

Example: [Mail] dialog box
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■ [Scan Mode]
Selects the scan mode. The scan modes you can select differ depending on the MF Toolbox button you press.

■ [Paper Size]
Selects the size of the document you will scan.

If you wish to specify the width and height with a value, select [Custom] to display the [Paper Size Settings] dialog 
box. Select the [Unit], enter the [Width] and [Height] ➞ click [OK].

■ [Upper Limit of Attached File]
Selects an approximate upper size limit (after compression) for the image you will send. (Depending on the image, 
some file sizes after compression may be larger than the value set.) 

For an ordinary mail message, a file size of [150 KB] is recommended. 

You cannot select set this item when [PDF] is selected in [Save as Type].

■ [Image Quality]
Selects the scan quality (resolution). 

When scanning using the [Mail] button, the resolution you can select will depend on your setting in [Upper Limit of 
Attached File].

■ [Use the Scanner Driver to Make Advanced Settings]
If you check this checkbox and click [Start], the [ScanGear MF] dialog box will appear and you can make advanced 
settings for scanning.

If you do not check this checkbox, scanning will begin immediately with the settings displayed.

This option is not available when scanning using the [OCR] button.

Save Scanned Image to
You can specify the file name, file format, and location to save the scanned image. When you select 
[PDF] as file format, you can also perform detailed settings for the PDF file.

■ [File Name]
Enter a file name for the scanned image. 

If you try to save another file with the same name, four digits starting from 0001 will be attached after the file name.

[Black and White] Scans document as a black and white image.

[Black and White] (OCR)] Scans document as a black and white image for OCR software.

[Grayscale] Scans document as a grayscale image (similar to a monochrome picture).

[Color] Scans document as a color image.

[Color (Magazine)]

Scans document as a color image with the [Descreen] function set to [On]. The 
[Descreen] function is designed to reduce as much as possible the distorted pattern 
(moire) which occasionally occurs when scanning printed materials. The scanning of a 
document will take longer if you use this function. 
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■ [Save as Type]

The type of file which can be saved with each button is shown below. 

If you select [PDF] in [Save as Type], depending on the output settings in the Advanced Mode, an error message 
may appear indicating that the image size is too large. In such cases, reduce the [Output Size] and/or [Output 
Resolution] under [Output Settings] to reduce the [Data Size] of the scanned file.

If you select [JPEG] in [Save as Type] and then select [Newspaper (B&W)] in ScanGear MF Simple Mode or [Black 
and White] in ScanGear MF Advanced Mode, the document will still be saved in grayscale.

To change the location to save the scanned images, click [Browse...] ➞ select a folder ➞ click [OK].

When you scan for the first time, a folder with the scanning date will be created in the [My Pictures] folder in the [My 
Documents] folder, and your document will be saved in this folder. If there is no [My Pictures] folder, a folder with the 
scanning date will be created in the [My Documents] folder and your document saved in this folder.

■ [Save Pictures to a Subfolder with Current Date]
Check this checkbox to create a folder with current date (e.g. 2004-12-31) in the specified location and save the 
scanned images in this folder.

Link Scanned Images to
You can specify an application to be used to display the scanned image. If no name is displayed or you 
wish to change the application, click [Set...] ➞ select the application you wish to use ➞ click [OK].

If the name of the application you wish to use does not appear for the [Mail] button, select [None 
(Attach Manually)]. In this case, you must open the image file in the application and attach the file 
manually.

The software is compatible with the e-mail software such as Outlook Express, Microsoft Outlook, 
EUDORA and Netscape Messenger.

If you do not want to select an application, click [Link Deletion] (available only with [OCR], [PDF], and 
[Scan-1], and [Scan-2] buttons). When asked to confirm, click [Yes].

[BMP] Bitmap format.

[JPEG] JPEG format. Select for grayscale or color images only.

[TIFF] TIFF format.

[PDF]
PDF format. You can make advanced settings with the [PDF Settings]. For details on 
[PDF Settings] dialog box, see “Creating One PDF File from Two or more Pages,” on 
p. 3-12.

BMP JPEG TIFF PDF

[Mail] – –

[OCR] – –

[Save]

[PDF] – – –

[Scan-1], [Scan-2] –
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Confirmation of the Scanned Image and Exif Settings (Confirm 
Scanned Image)
You can preview the scanned images as thumbnail images, and specify the file type and location to 
save them. You cannot use this function when scanning with the [OCR] button, and for the [PDF] 
button, only the confirmation of the scanned image and specifying the location to save are available.

Check the [Confirmation of the Scanned Image and Exif Settings] checkbox (for the [PDF] button, 
[Confirm the Scanned Image] checkbox) ➞ click [Start]. When the scanning is complete, the thumbnail 
of the scanned image will be displayed. Confirm the thumbnail image ➞ specify the file type and 
location ➞ press [Save] or [Forward].

■ Exif Settings
You can attach extra information in the EXIF format, such as the description of the image, the date the image was 
scanned, etc., to the JPEG files. Select a scanned image from the pull-down list to view and add information for the 
image.

[Save Scanned Image to] Specifies the location to save the scanned image. 

[Save as Type]

Specifies the file type to save the scanned image. You can select from [JPEG/EXIF], 
[BMP], [TIFF], or [PDF]. The available file types are the same as those listed in [Save 
as Type] of the [Save Scanned Image to]. If you select [JPEG/EXIF], you can set the 
Exif information using [Exif Settings] dialog box (see “Exif Settings” below. If you select 
[PDF], you can make advanced settings with the [PDF Settings] (see “Creating One 
PDF File from Two or more Pages,” on p. 3-12).

[Save Pictures to a Subfolder with Current Date]

Check this checkbox to create a folder with current date inside the specified location 
and save the scanned images in this folder.

[Add]
Press to scan other images to preview as thumbnails and save or forward all the 
scanned images at once.

[Forward]

Press to forward the scanned images to the application you specified in the [Link 
Scanned Images to] settings. When scanning with the [Mail] button and [None (Attach 
Manually)] is selected for [Link Scanned Images to], pressing [Forward] opens the 
folder where the scanned image is saved.

[Save]
Press to save the scanned images in the specified location. This button appears 
instead of the [Forward] button when scanning with the [Save] button.

[Basic information] Displays the information automatically acquired by scanning.

[Advanced information]
Displays the extra information you enter. Check the checkbox of the item you want to 
enter ➞ specify a value ➞ click [Apply].

[Apply the Same Setting of Input Items Automatically]

Check this checkbox to use the same values you have specified in the previous 
scanning operation.

[Apply] Press to apply the currently selected settings.

[OK] Press to exit the Exif Settings.
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Scanning an Image from an Application
You can scan an image from a TWAIN- or WIA- (Windows XP only) compliant application and use the 
image in that application.
This procedure varies depending on the application. The following is only one example. For the correct 
procedure, refer to the documentation of the application you are using.

1 Place the document face-down on the platen glass or load it face-up in the ADF.

2 Open the application from which you will scan the document.

3 Select the command to scan.

In most cases, select [Import] or [Acquire image] etc. from the [File] menu.

4 Select the scanner driver to be used.

With Windows XP, you can use the ScanGear MF or the WIA driver as the scanner driver.

To use ScanGear MF, select [Canon MF5730], [Canon MF5750] or [Canon MF5770].

To use the WIA driver, select [WIA-Canon MF5730], [WIA-Canon MF5750] or [WIA Canon MF5770].

5 Specify the scanner settings ➞ click [Scan].

For details, see “Setting Preferences and Scanning with ScanGear MF,” on p. 3-14, or "Scanning with the WIA 
Driver (Windows XP Only)," on p. 3-38.

When scanning is completed, the scanned image will appear in the application's display area.

NOTE
If white lines appear on one edge of the scanned image, check that the document is correctly placed on the platen 
glass. A document should be placed approximately 3 mm from the front edge (i.e., the edge closest to the 
operation panel) of the platen glass.

Creating One PDF File from Two or more Pages
You can scan two or more pages and make them into one PDF file.

1 Place the document face-down on the platen glass or load it face-up in the ADF.

2 On the Windows desktop, double-click [Canon MF Toolbox 4.7].

Alternatively, on the Windows desktop, click [start] ➞ [(All) Programs] ➞ [Canon] ➞ [MF Toolbox 4.7] ➞ [Toolbox 
4.7]. The MF Toolbox will open.

3 Click [PDF].

If necessary, adjust any settings.
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4 Click [PDF Settings...].

5 Check the [Create Multiple PDF] checkbox to create one PDF file by scanning two or more pages.

6 Adjust the following settings if necessary ➞ click [OK].

7 Click [Start].

The [ScanGear MF] dialog box will open if you selected [Use the Scanner Driver to Make Advanced Settings] in 
step 3.

Adjust your settings, then click [Scan].

For settings, see “Setting Preferences and Scanning with ScanGear MF,” on p. 3-14.

Scanning starts.

[Create Searchable PDF]

Click to convert the characters in the document to text data and make the document 
searchable with simple keywords. However, all the characters in the document may 
not be accurately recognized. In [Text Language], select [English]. In [Scanner 
Settings], in [Image Quality], select [300 dpi] or more.

[PDF Compression]
Select [High] for images such as photos or illustrations to be further compressed, 
reducing the file size.

[ScanGear MF] dialog box
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NOTE
If white lines appear on one edge of the scanned image, check that the document is correctly placed on the platen 
glass. A document should be placed approximately 3 mm from the front edge (i.e., the edge closest to the 
operation panel) of the platen glass.

If you are scanning using the platen glass, the following dialog box appears as each page is scanned.

To continue to scan, place the next page and click [Next]. When scanning is completed, click [Finish].

The above dialog box is not displayed if you scanned your document using the ADF.

A folder with the scanning date will be created in the [My Pictures] folder in the [My Documents] folder, and your 
document will be saved in this folder. If there is no [My Pictures] folder, the folder with the scanning date will be 
created in the [My Documents] folder and your document saved in this folder.

For text documents or black-and-white documents, it is recommended you select either [Black and White] or 
[Grayscale] in [Scan Mode].

If making a Multiple PDF with color documents ([Image Quality] set to [300 dpi]), it is recommended that the PDF 
have fewer than 20 pages.

Setting Preferences and Scanning with ScanGear MF
With ScanGear MF, you can review with the preview image (provisional scan) how the final image will 
be scanned and make detailed adjustments for the size and color of the image. If the preview image is 
satisfactory, you can then scan the document properly.

If you wish to make settings with ScanGear MF when scanning a document, you can either check the 
[Use the Scanner Driver to Make Advanced Settings] checkbox in the MF Toolbox before scanning, or 
scan from an application.

NOTE
If you are scanning from an application in Windows XP, select ScanGear MF in the application before scanning. 
For details, see “Scanning an Image from an Application,” on p. 3-12.
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Switching between Simple Mode and Advanced Mode
ScanGear MF has two modes: [Simple Mode] and [Advanced Mode]. With [Advanced Mode] you can 
perform detailed settings such as resolution and contrast.

To switch between two modes, click the corresponding tab.

Using Simple Mode

1 Place the document face-down on the platen glass or load it face-up in the ADF.

[Simple Mode] dialog box [Advanced Mode] dialog box
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2 In [Select Document Type], select the document type.

NOTE
If you select a document type other than [Newspaper (B & W)], there will be automatic color correction. To turn off 
automatic color correction, in Advanced Mode, click [Preferences...] ➞ [Color Settings] tab ➞ clear [Always 
Execute the Auto Tone].

3 To see a preview image (provisional scan), click [Preview].

A preview of the document will be scanned and appear in the preview window.

4 Select the destination of the scanned image.

You can select from [Print (300 dpi)], [Image Display (150 dpi)], or [OCR (300 dpi)], depending on the document 
type you select in step 2.

For details on this setting, see “Determining Resolution,” on p. 3-37.

5 Select the output size of the scanned image depending on the destination you selected in step 4.

If you select [Add/Delete...], you can add or delete the custom output size. For details on setting, see “Add/Delete 
the Output Size,” on p. 3-17.

Click  to switch the orientation of the output size (landscape or portrait).

6 Click [Scan].

Scanning starts.

NOTE
If white lines appear on one edge of the scanned image, check that the document is correctly placed on the platen 
glass. A document should be placed approximately 3 mm from the front edge (i.e., the edge closest to the 
operation panel) of the platen glass.

[Photo (Color)] To scan color photos (300dpi)

[Magazine (Color)] To scan color magazines (150dpi, with the Descreen function)

[Newspaper (B & W)] To scan text and line drawings (black and white, 300dpi)

[Document (Grayscale)]
To scan color image or text in monochrome. Especially appropriate, for scanning 
high-resolution monochrome image (300dpi)

[Document (Color) ADF] To scan color document (300 dpi) on the ADF

[Document (Grayscale) ADF]

To scan grayscale document (300 dpi) on the ADF
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■ Add/Delete the Output Size

Selecting [Add/Delete...] for the [Output Size] in the [Simple Mode] tab sheet opens the [Add/Delete the 
Output Size] dialog box. In this dialog box, you can add or delete the custom output size.

■ Simple Mode Toolbar

With the Simple Mode Toolbar, you can make adjustments to the preview image and also select a part 
of the image displayed.

[Output Size Name] Specifies the output size name you want to register.

[Width] Specifies the width of the output size.

[Height] Specifies the height of the output size.

[Unit] Selects the unit of measurement for the output size.

[Add] Adds the output size to the [Output Size List].

[Delete] Deletes the selected output size from the [Output Size List].

This button is disabled for this model.

 (Auto Crop)
Crops the image border automatically. For details, see “Advanced Mode - Specifying 
the Parameters of a Scan,” on p. 3-20.

 (Flip) Flips the scanned image horizontally.

 (Left Rotate) Rotates the scanned image 90 degrees left.

 (Right Rotate) Rotates the scanned image 90 degrees right.

 (Information) Lists the scanning information.
3-17



S
ca

nn
in

g

3

■ To Detach and Move the Toolbar

To detach the toolbar from the [ScanGear MF] dialog box, click and hold on the edge of the toolbar, 
then drag the Toolbar. It will return to its original position if you double-click on the title of the toolbar.

The toolbar will adhere to a position if you drag it to the left or right of the preview area or the bottom 
frame.

Using Advanced Mode
In Advanced Mode, you can adjust settings such as brightness and contrast to the preview.

1 Place the document face-up in the ADF or face-down on the platen glass.

2 Select settings for [Input Settings], [Output Settings] and [Image Settings], and adjust the color settings.

For details on the settings, see “Advanced Mode Settings,” on p. 3-21.

3 Click [Preview].

NOTE
• Selecting the range in the preview window and clicking [Zoom] reloads the selected image to enlarge it.

When enlarged image is displayed, the [Zoom] button changes to the [Undo] button. Clicking [Undo] displays the 
image in normal size.

• To delete the displayed preview image, click ➞ when asked to confirm, click [OK].

4 If you want to scan only part of the document, specify the parameters.

For details, see “Advanced Mode - Specifying the Parameters of a Scan,” on p. 3-20.

5 Click [Scan].

Scanning starts.
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■ Advanced Mode Toolbar

With the Advanced Mode Toolbar, you can make adjustments to the preview image and also select a 
part of the image displayed.

■ To Detach and Move the Toolbar

To detach the Toolbar from the [ScanGear MF] dialog box, click and hold on the edge of the Toolbar, 
then drag the Toolbar. It will return to its original position if you double-click on the title of the Toolbar.

The Toolbar will adhere to a position if you drag it to the left or right of the preview area or the bottom 
frame.

This button is disabled for this model.

 (Crop)
Specifies the parameter of a scan. For details, see “Advanced Mode - Specifying the 
Parameters of a Scan,” on p. 3-20.

 (Move)

Moves the image. If the enlarged image is too large to fit on the screen, on the 

Toolbar, click . Then drag the image across the screen until the part you want to 

see is displayed. You can move the image in the same way with the scroll bars.

 (Zoom)
Enlarges or reduces the preview image. Click this button on the toolbar ➞ click on 
the image to enlarge, or right-click on the image to reduce.

 (Auto Crop)
Crops the image border automatically. For details, see “Advanced Mode - Specifying 
the Parameters of a Scan,” on p. 3-20.

 (Invert) Inverts the color in the image.

 (Flip) Flips the scanned image horizontally.

 (Left Rotate) Rotates the scanned image 90 degrees left.

 (Right Rotate) Rotates the scanned image 90 degrees right.

 (Rulers)
Shows the ruler at the upper and left edges of the preview to make accurate 
measurements.

 (Information) Lists the scanning information.
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Advanced Mode - Specifying the Parameters of a Scan
You can specify the parameters of a scan by selecting a part of the image. When you scan again, only 
the part of the image you have specified is scanned.

You can specify the parameters of a scan with one of the following methods.

■ To Select the Parameters of a Scan Automatically

After previewing, on the Toolbar, click . Clicking this button allows you to gradually crop off the 
image outside the borders detected in the preview image.

■ To Specify the Parameters of a Scan

1 To maintain the current width and height proportions set for the image even after selecting the 
parameters of the scan, click  in the [Input Settings].

2 Do one of the following.

● Specify by dragging

❑ Click . Then click and drag from the upper left corner of the parameter you wish to specify to the lower 
right of the parameter. To adjust even further, drag the corner or border of the selected parameters.

● Specify size

❑ In  (Width) and  (Height), enter the parameters you want.

NOTE
If you clicked  in step 1, entering either  (Width) or  (Height) automatically decides the other 
parameter.

3 To move the crop border you have selected, place the mouse pointer inside the crop border, then drag.

4 To preview the image, click [Preview].

To delete the settings, click on an area outside of the crop border.
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Advanced Mode Settings

■ Input Settings

■ [Select Image Source]

Selects where the document is placed ([Platen Glass] or [Document Feeder]).

■ [Paper Size]

Selects the size of the document to be scanned. The preview area size (height-to-width ratio) will 
change to the paper size you selected.

Change this setting to set up the machine not to scan beyond the parameters of the scan when 
previewing or if you are scanning without specifying the parameters of the scan. If you do not know the 
size of the document, select [Full Platen] or a large size. You can specify the parameters after 
previewing. If you change [Paper Size] setting after previewing, the preview image will be deleted.

NOTE
If you selected [Document Feeder] in [Selected Image Source], select the paper size of [A5 Portrait], [A5 
Landscape], [A4], [Letter] and [Legal].
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■ Input Size

You can specify the width and height of the parameters of the scan by entering a value. After entering 
the value, press the Enter key, and the size of the cropping frame will change. Click  to change the 
icon to  and maintain the width and height proportions of the image.

IMPORTANT
• Some applications have a limit to the amount of image data they can receive. If the parameters of a scan contain 

more than 21,000 x 30,000 pixels, the image will not be received.
• The values you can enter will be within the parameters of the document size you have selected.

• Minimum parameters of an image with [Output Resolution] is set to [600] dpi are 96 x 96 pixels.

■ Output Settings

■ [Color Mode]

Selects the type of document and the way in which it will be scanned.

■ [Output Resolution]

Selects the resolution for the scan. If you have selected [Color] for [Color Mode], either click or type a 
resolution between 25-2400 dpi (in 1 dpi increments), or enter one of the values 4800, 7200 or 9600 
dpi. If you have selected [Black and White], [Grayscale], or [Text Enhanced], either click or type a 
resolution between 25-600 dpi (in 1 dpi increments). For details, see “Determining Resolution,” on 
p. 3-37.

[Black and White]

Select this mode when outputting photos and other documents to monochrome 
printer. The image is displayed in black and white. The contrast in the image is 
divided at certain levels (threshold values) into black and white and is displayed in 
two colors. Threshold can be set on the [Halftone] button.

[Grayscale]
Select this mode to scan black and white photos or monochrome images. The image 
is expressed in a 0-255 scale of black and white.

[Color]
Select this mode to scan color documents. The image is expressed in 256 levels (8 
bit) of R(ed), G(reen) and B(lue).

[Text Enhanced]

Select this mode to scan texts crisply, particularly to process it with OCR software. 
The image is displayed in black and white. The document is scanned in grayscale 
and then converted to black and white, therefore takes longer than the [Black and 
White] setting.
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■ [Output Size]

For setting the print size (output size) of the scanning parameters you have specified.

Specify by entering a value in either  (Width),  (Height) or [%] (Scale), or click a [%] (Scale) 
value. After adjusting the settings, either click on another area or press the Enter key, and the other 
values linked to the input values will change. Even if you change these settings, the size of the cropping 
frame and the setting for [Output Resolution] will not change. The resolution when you actually scan 
will change in accordance with the value entered in [%] (Scale).

The ratio of  (Width) and  (Height) is linked to  (Width) and  (Height) in Input Size. You 
can make settings for [%] (Scale) between 25 and 3200 in increments of 1%. [%] (Scale) is fixed to 
100% if 4800, 7200 or 9600 dpi is entered in [Output Resolution].

Click  to switch the orientation of the output size (landscape or portrait). This button is disabled 
when you select [Flexible] for [Output Size].

■ [Data Size]

Shows the data size of the scanned image according to your settings.

■ Image Settings

■ [Auto Tone]

Set to [ON] to automatically adjust the tone of the image. The results of tone adjustment are reflected 
in the whole image and when the image is actually scanned. You cannot apply this setting if the 
preview image is not displayed. The default setting applies auto tone adjustment to the cropped image 
when previewing the image.

To view the preview image without auto tone adjustment, select [OFF].

NOTE
This setting is not available when [Fading Correction] is turned on.

IMPORTANT
You cannot set [Auto Tone] to [ON] if [Black and White] or [Text Enhanced] is selected in [Color Mode].

■ [Unsharp Mask]

Set to [ON] to emphasize and make sharper the outline of an image. This setting is selected by default. 
It is effective for scanning photos etc., which have a soft focus.

IMPORTANT
You cannot set [Unsharp Mask] to [ON] if [Black and White] or [Text Enhanced] is selected in [Color Mode].

■ [Descreen]

Set to [ON] when scanning printed photographs and pictures. The default setting is [OFF].

IMPORTANT
• You cannot set [Descreen] to [ON] if [Black and White] or [Text Enhanced] is selected in [Color Mode].
• Even if [Descreen] is set to [ON], some moire effect may remain if [Unsharp Mask] is also set to [ON]. In this case, 

disable [Unsharp Mask].

• [Descreen] cannot be set to [ON] when scanning from an application which will not display the [ScanGear MF] 

dialog box. If you are scanning from the MF Toolbox without using ScanGear MF, select [Color (Magazine)] in 

[Scan Mode] to activate [Descreen].
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NOTE
• Printed photographs and pictures are displayed as a collection of fine dots. If you scan without descreen, the dots 

may interfere with each other and cause an unevenness of gradation and a striped pattern in the image. 
[Descreen] is the function for reducing this moire effect.

• Selecting [Magazine (Color)] in [Select Document Type] in Simple Mode has the same effect as selecting 
[Descreen] in Advanced Mode.

■ [Reduce Dust and Scratches]

Scanned photos may contain white dots caused by dust and scratches. This setting reduces the dust 
and scratches on photos. The default setting is [OFF].

IMPORTANT
• You cannot set [Descreen] to [ON] if [Black and White] or [Text Enhanced] is selected in [Color Mode].
• For scanning printed materials, the [OFF] setting is recommended.

• If [Descreen] is set to [ON], you cannot set [Reduce Dust and Scratches] to [ON]. 

• This setting may not be effective for some types of photos.

■ [Fading Correction]

The fading correction feature rebuilds the color quality that has faded over time. It also increases 
saturation of dull-colored originals to reproduce a vivid image. The default setting is [OFF].

NOTE
• This setting is not available when [Canon ColorGear] is selected in the [Color Settings] tab in the [Preferences] 

dialog box.
• This setting is reflected also in the preview image.
• This setting is available when [Color] is selected in [Color Mode]. 
• You cannot apply this setting when the preview image is not displayed.
• If you set [Fading Correction] to [Low], [Medium], or [High], scanning may take more time.
• The fading correction may not work when the scanning area is too small.

[OFF] No reduction of dust and scratches will be made.

[Low]
Reduces small dust and scratch marks. With this setting, large dust or scratch marks 
may remain.

[Medium] Normally this setting is recommended.

[High]
Reduces large dust and scratch marks but evidence of the reduction process may 
remain and may also remove delicate parts of the image.

[OFF] No fading correction will be made.

[Low] Corrects slightly faded images.

[Medium] Normally this setting is recommended.

[High] Corrects highly faded images, but it may change the tone of the image.
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■ [Grain Correction]

The grain correction feature smoothes out the film grain of the image recorded on fast film. The result is 
smoother tones and higher overall quality. The default setting is [OFF].

NOTE
• This setting is not reflected in the preview image.
• This setting is available when [Color] or [Grayscale] is selected in [Color Mode]. 
• If you set [Grain Correction] to [Low], [Medium], or [High], scanning may take more time.
• The grain correction may not work when the scanning area is too small.

■ [Calibration Settings]

Calibrate the scanner if the colors in the preview image vary from those in the original document. To 
access this setting, press . Clicking [Execute] starts the calibration process, which adjusts the 
scanned image to the proper coloration. Set [Execute at Every Scan] to [ON] if you want to calibrate the 
scanner every time you scan.

IMPORTANT
Do not open the document cover while the scanner is calibrating.

■ Color Settings

Using Color Settings buttons, you can adjust the brightness and contrast of the whole image, perform 
gamma correction, specify highlights and shadows, and adjust the contrast and balance in an image 
(with the histogram and tone curve).

The Color Settings buttons will be displayed when [Color] or [Grayscale] is selected in [Color Mode].

In [Black and White] mode, the Color Settings buttons changes to the [Threshold] button, and no Color 
Settings buttons will be displayed when [Text Enhanced] mode or [Canon ColorGear] is selected.

[OFF] No grain correction will be made.

[Low] Select this setting when the grain in the picture is not so notable.

[Medium] Normally this setting is recommended.

[High]
Smoothes out the grain in the picture even when the grain is very notable but it may 
lower the image sharpness and tonal quality.
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When you use the Color Settings buttons, the changes you make will be immediately reflected in the 
preview image or in the scan.

Color Settings buttons when [Color] or [Grayscale] is selected in [Color Mode]

Color Settings buttons when [Black and White] is selected in [Color Mode]

 (Save)
Saves settings to a color adjustment file.
You can save the color settings for use in future scans. The file extension will be 
(.adc) for color and (.adg) for grayscale.

 (Load)
Loads the settings in the saved color adjustment file to scan an image with the saved 
settings.

[Reset]

Revises all color adjustment settings to default settings. [Master], [Red], [Green], 
[Blue] and all settings for contrast/brightness, gamma, histogram and tone curve will 
be suspended and will return to default settings. Images which have undergone 
automatic color correction will also return to their defaults.
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■ [Brightness/Contrast]

By clicking , you can access the [Brightness/Contrast] dialog box. 

If the original image is too dark or too bright, or if the image quality is flat due to lack of contrast, adjust 
the levels of brightness and contrast.

The brightness and contrast are active if [Color] or [Grayscale] is selected in [Color Mode]. 

To adjust the brightness and contrast diagrammatically, press .

■ [Gamma]

By clicking , you can access the [Gamma] dialog box. 

The gamma allows you to adjust the brightness of the image viewed on the computer monitor to the 
brightness of the original document. The default is 2.2. You will have to change this value if you are 
using a monitor with a different gamma value. When you set the monitor’s gamma value, the scanner’s 
gamma value will automatically be displayed in the formula (reciprocal equation of the monitor gamma 
value) below.

1/ monitor gamma value = scanner gamma value

The gamma is active if [Color] or [Grayscale] is selected in [Color Mode].

To adjust the gamma diagrammatically, press .

[Channel]
Adjust the elements of grayscale when [Color Mode] is set to [Grayscale]. Selects a 
color to adjust either [Red], [Green], or [Blue], or select [Master] to adjust three 
colors together when [Color Mode] is set to [Color].

[Brightness]
Move the slider to the left to increase the darkness of the image, and to the right to 
increase the brightness of the image. You can also enter values (–127 to 127).

[Contrast]
Move the slider to the left to decrease the contrast of the image, and to the right to 
increase the contrast of the image. You can also enter values (–127 to 127).

[Reset] Resets all the current settings to their default values.
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NOTE
• The monitor has characteristics (gamma values) for reproducing colors. The gamma value of an average monitor 

is between 1.4 and 2.2, and reproduces colors in a somewhat darker way than the original document.
Consequently, to correct the difference between the color in the original image and the reproduction of the color by 
the monitor, you may need to correct the gamma value.

• For the monitor’s gamma value, refer to the documentation of your monitor, or contact the manufacturer of your 
monitor.

[Channel]
Adjust the elements of grayscale when [Color Mode] is set to [Grayscale]. Selects a 
color to adjust either [Red], [Green], or [Blue], or select [Master] to adjust the three 
colors together when [Color Mode] is set to [Color].

[Gamma]
Move the slider to the left to decrease or the right to increase the contrast displayed 
in the middle of the tonal range (midtones) of the image. You can also enter values 
(0.10 to 10.00).

[Reset] Resets all the current settings to their default values.
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■ [Histogram]

By clicking , you can access the [Histogram] dialog box.

A histogram allows you to see the data concentration at each brightness level in an image. You can 
specify the darkest and brightest levels within an image, cut the levels and expand the middle of the 
tonal range of the image.

The histogram is active if [Color] or [Grayscale] is selected in [Color Mode].

1 To change the black-point (shadow-level), mid-point (midtone-level), or white-point (highlight-level), do 
one of the following.

❑ Click  (Black-point eyedropper tool) then click a point in the preview image to specify the darkest point.

You can also enter a value (0 to 245).

❑ Click  (Mid-point eyedropper tool) then click a point in the preview image to specify the midtone point.

You can also enter a value (5 to 250).

❑ Click  (White-point eyedropper tool) then click a point in the preview image to specify the highlighted point.

You can also enter a value (10 to 255).

❑ Drag the triangles at the bottom of the histogram to an appropriate level.

Areas on the left of  (parts darker than the value specified in [Black-point]) will turn black.

The area at  (parts specified in [Mid-point]) will turn to a color exactly between black-point and 
white-point.

Areas on the right of  (parts lighter than the value specified in [White-point]) will turn white.

2 When adjusting a color image, click  (Gray Balance eyedropper tool) ➞ click a point in the preview 
image to specify the point to execute gray balance adjustment.

The gray balance adjustment ensures that gray elements within a scanned image appear as a neutral gray, and 
consequently, other elements within the image will also have true color reproduction.

[Channel]
Adjust the elements of grayscale when [Color Mode] is set to [Grayscale]. Selects a 
color to adjust either [Red], [Green], or [Blue], or select [Master] to adjust the three 
colors at once when [Color Mode] is set to [Color].

[Reset] Resets all the current settings to their default values.
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■ [Tone Curve Settings]

By clicking , you can access the [Tone Curve] dialog box.

You can make subtle adjustments to the brightness of a specific area of an image by selecting the type 
of the tone curve. The tone curve is a graph showing the balance of tone input and output.

The tone curve is active if [Color] or [Grayscale] is selected in [Color Mode].

[Channel]
Adjust the elements of grayscale when [Color Mode] is set to [Grayscale]. Selects a 
color to adjust either [Red], [Green], or [Blue], or select [Master] to adjust three 
colors together when [Color Mode] is set to [Color].

[Select Tone Curve]
Selects the tone curve. ([No correction], [Overexposure], [Underexposure], or [High 
contrast])

[Reset] Resets all the current settings to their default values.
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■ [Final Review]

By clicking , you can access the [Final Review] dialog box.

In this dialog box, you can confirm the color settings you have made.

■ [Threshold]

By clicking , you can access the [Threshold] dialog box.

If [Black and White] is selected in [Color Mode], the Color Settings buttons will become the [Threshold] 
button.

NOTE
• The brightness of color and grayscale images are expressed as a value between 0 and 255 but brightness of black 

and white images is expressed in terms of either black or white including the parts of an image which are a color 
between the two. The boundary at which black and white is divided is called Threshold.

• By adjusting the threshold, you can sharpen characters in a text document and reduce back-printing such as in 
newspapers.
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■ [Preferences] Dialog Box

Clicking [Preferences...] on [Advanced Mode] tab opens the [Preferences] dialog box. In this dialog 
box, you can adjust settings for scanning and previewing.

[Threshold Level]

Move the [Threshold] slider to the right to increase the threshold value and thus 
reduce the white areas (black areas will increase). Move the slider to the left to 
decrease the threshold value and thus increase the white areas (black areas will 
reduce). You can also enter a value (0 to 255).

[Reset] Resets all the current settings to their default values.
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■ [Preview] Tab

[Preview at the Start of ScanGear MF]

Selects the preview operation when you open ScanGear MF. [Display Saved Preview 
Image] is selected by default.

[Automatically Execute Preview]

The preview scan will start automatically when you open ScanGear MF.

[Display Saved Preview Image]

Displays the image last previewed. Color Settings and the Flip, Left and Right 
Rotate, Reverse Color and Ruler buttons in the Toolbar will be reproduced.

[None] Nothing is displayed when ScanGear MF is opened.

[Cropping Frame on Previewed Images]

Sets how the frame is displayed when you preview images. [Execute Auto Cropping 
on Previewed Images] is selected by default.

[Execute Auto Cropping on Previewed Images]

The document will automatically be cropped to match the document size. 

[Display the Last Frame on Previewed Images]

Displays the last frame when you preview images.

[None] No frame will be displayed when you preview images.

[Cropping Size for Thumbnail View]

This setting is not available for this model.
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■ [Scan] Tab

[Scan without using ScanGear’s Window]

Color mode cannot be changed in applications such as OCR software which will not 
display the [ScanGear MF] dialog box (UI off mode), and consequently the 
document will be scanned with the settings in the application. To override the 
application settings and scan in a specific color mode, configure the settings here. 
Neither of these settings is selected by default.

[Color (Documents)]

This setting is not available for this model.

[Text Enhanced]

The document is scanned in [Text Enhanced] mode when the [Black and White] 
setting is configured in the application.

IMPORTANT
These settings will be invalid in UI mode (the mode in which the ScanGear MF dialog 
box is displayed).

[Enable 48/16 bit Output] This setting is not available for this model.

[Automatically Quit ScanGear MF after Scanning]

If selected, the [ScanGear MF] dialog box quits automatically after the image is 
scanned. This setting is not selected by default. Some applications will automatically 
quit ScanGear MF after scanning irrespective of this setting.
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■ [Color Settings] Tab

Click one of the following. The default setting is [Recommended].

[Recommended]
Vividly reproduces the tone of a document on the screen. Normally this settings is 
recommended.

[Canon ColorGear]

Select to automatically match the scanner, monitor and color printer colors, thus 
reducing time and trouble to manually match the monitor and printer colors. This 
setting is available when [Color] is selected in [Color Mode]. If [Canon ColorGear] is 
selected, the Color Settings buttons are disabled on the Advanced Mode tab.

[None]
No color matching is made. If you select either [Black and White] or [Text Enhanced] 
in [Color Mode], this setting is not available.

[Always Execute the Auto Tone]

This setting is only available when you select either [Color] or [Grayscale] in [Color 
Mode]. If selected, the image color will always be automatically corrected. If you 
select either [Canon ColorGear] or [None], this setting is not available. This setting is 
selected by default.
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■ [Scanner] Tab

[Energy Saving Mode] You cannot set the Energy Saving Mode from your computer.

[Quiet Mode] This setting is not available for this model.

[Select Folder Where Temporary Files are Saved]

Click [Browse...] and specify the folder to which the file will be saved.

[Sound Settings]
Sets the scanner to play music during scanning or play a sound when scanning is 
completed.

[Play Music During Scanning]

If selected, the scanner plays music during scanning. Click [Browse...], then specify 
a sound file.

[Play Sound When Scanning is Completed]

If selected, the scanner plays sound when scanning is completed. Click [Browse...], 
then specify a sound file.

You can specify the files below.
• MIDI files (*.mid, *.rmi, *.midi)
• Audio files (*.wav, *.aiff)
• MP3 file (*.mp3)

[Test Scanner...]
Checks the power cord plugged in, or the USB cable is connected between the 
machine and your computer.
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Determining Resolution
You can specify a resolution in [Image Quality] in the MF Toolbox settings dialog box, or in

[Output Resolution] in ScanGear MF.

NOTE
• The data in the image you have scanned is a collection of dots carrying information about brightness and color. 

The density of these dots is called "resolution," and "dpi" (dots per inch) refers to the number of dots in one inch. 
Resolution will determine the amount of detail your image contains. The higher the resolution (number), the more 
detail in your image; the lower the resolution (number), the less detail.

• As a general rule, you should select a scanning resolution that corresponds to your final output device such as a 
monitor or printer.

■ Images for Display on a Monitor

Images for display on a monitor should in general be scanned at a resolution of 75 dpi.

■ Images for Printing

Images to be printed should be scanned at a resolution which corresponds to the resolution of the 
printer. For example, if you are using a 600 dpi black and white printer, you should scan your document 
at [600 dpi].

NOTE
With a color printer, the colors are expressed as a certain percentage of ink pigment so scanning your document 
at half the resolution of the printer should be fine. For example, if you are using a 600 dpi color printer, you should 
scan your document at [300 dpi].

■ Printing to Scale

For example, if you want to print a document which is twice the size both vertically and horizontally, the 
resolution of your document will be reduced by half. If the resolution of the original document is 300 dpi, 
the resolution of the enlarged document will be 150 dpi. If you print the document with a 600 dpi color 
printer, the lack of detail in the image may be obvious. In such a case, if you scan at a resolution of 600 
dpi, resolution will be 300 dpi even if you double the size of the document and you can print the 
document with sufficient quality. Conversely, if you want to print a document at a reduced size, it should 
be sufficient to scan at half the resolution.

■ Resolution and Data Size

If you double the resolution, the image data will be four times greater. If the data is too large, 
processing speed will slow down significantly, and you may experience malfunctions such as lack of 
memory. Make sure the resolution corresponds to the purpose of use of the image and set at the 
lowest level possible.
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Scanning with the WIA Driver (Windows XP Only)

Scanning from the [Scanner and Camera Wizard] Dialog Box

NOTE
If white lines appear on one edge of the scanned image, check that the document is correctly placed on the platen 
glass. A document should be placed approximately 3 mm from the front edge (i.e., the edge closest to the 
operation panel) of the platen glass.

1 Open the [Scanners and Cameras] folder.

For details on how to open the [Scanners and Cameras] folder, see “Setting Up [Start] in the [Scanners and 
Cameras] Folder (Windows 98/2000: the [Scanners and Cameras Properties] Dialog Box),” on p. 3-3.

2 Double-click the scanner icon ([WIA Canon MF5730], [WIA Canon MF5750] or [WIA Canon MF5770]).

3 Click [Next >].

4 Select a picture type.

You can select from the following:

- [Color picture]
- [Grayscale picture]
- [Black and white picture or text]
- [Custom]
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NOTE
• When selecting [Custom], click [Custom settings] to make detailed settings in the [Properties] dialog box.

5 Select the paper source ([Flatbed] or [Document Feeder]). 

NOTE
If you selected [Document Feeder], select paper size from [Page size] and proceed to step 7.

6 Specify the scanned area. 

Click [Preview] ➞ drag  to specify the scanned area.

7 Click [Next >].

8 Specify a name, a file format, and the location for saving the group of pictures.
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❑ Type a name for the group of pictures.

When you save more than one picture in the same location, sequential numbers are automatically added at 
the ends of file names (e.g. numbers 001, 002, ... are added from the second picture on.)

❑ Select a file format for the pictures.

You can select from the following:
- [BMP (Bitmap Image)]
- [JPG (JPEG Image)]
- [TIF (TIF Image)]
- [PNG (PNG Image)]

❑ Select the location where you want to save the pictures.

To change the location, click [Browse...] ➞ select the new location ➞ click [OK].

9 Click [Next >].

Scanning starts.

NOTE
To cancel scanning, click [Cancel].
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10 Click [Next >]. 

If you want to publish these pictures to a Web site or order printouts online, select the corresponding option. For 
more information, see the Windows operating system documentation.

11 Click [Finish]. 

The location selected in step 8 will appear.
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■ Advanced Properties

The following screen shows the Advanced Properties tab in Windows XP. To display the Advanced 
Properties screen, see “Scanning from an Application,” on p. 3-43.

NOTE
The setting items and default values in the [Advanced Properties] tab vary depending on the type of picture you 
have selected.

Appearance Shows the preview of sample image.

[Brightness] Specifies the brightness (–127 to 127).

NOTE
You can also adjust the brightness in PageManager or OmniPage if it is not 
specified sufficiently in this tab.

[Contrast] Specifies the contrast (–127 to 127). (Only for color or grayscale scanning.)

NOTE
You can also adjust the contrast in PageManager or OmniPage if it is not 
specified sufficiently in this tab.

[Resolution (DPI)] Selects the scanning resolution in dot per inch (50 to 300).

NOTE
You can enter the values of resolution listed above in the edit box directly. If 
you enter an invalid value, the error message will appear and the resolution 
will be corrected to the closest one.

[Picture type]
Selects the scanning color type ([Color picture], [Grayscale picture], or 
[Black and white picture or text]).

[Reset] Resets all the current settings to their default values.
3-42



S
ca

nn
in

g

3

Scanning from an Application
With the WIA driver dialog box open, follow the procedure below.
To display the WIA driver, see “Scanning an Image from an Application,” on p. 3-12.

NOTE
If white lines appear on one edge of the scanned image, check that the document is correctly placed on the platen 
glass. A document should be placed approximately 3 mm from the front edge (i. e., the edge closest to the 
operation panel) of the platen glass.

1 Select the paper source ([Flatbed] or [Document Feeder]).

NOTE
If you selected [Document Feeder], select paper size from [Page size] and proceed to step 4.

2 Select the type of picture you want to scan.

You can select from the following:

- [Color picture]
- [Grayscale picture]
- [Black and white picture or text]
- [Custom Settings]

3 If you want to adjust the quality of the scanned image, click [Adjust the quality of the scanned picture].

The [Advanced Properties] dialog box appears.

4 Adjust the quality of the image ➞ click [OK].

For details on how to adjust the quality of the image, see “Advanced Properties,” on p. 3-42.

5 Specify the scanned area.

If you have selected [Flatbed] as the paper source, click [Preview] ➞ drag  to specify the scanned area.

If you have selected [Document Feeder] as the paper source, select the page size from the pull down menu.

6 Click [Scan].

Scanning starts. When the scanning is completed, the scanned image will appear in the display area of the 
application.
3-43



CHAPTER

4
ing the fax driver 
PC Faxing (MF5750/MF5770 Models 
Only)
This chapter explains the procedure to fax documents from your computer. You can send faxes us
from applications that support document printing.

Sending a Fax
You can send a fax to multiple recipients in one operation. 

NOTE
• You cannot send a fax when an error occurs in the machine.
• A very large document may not be sent.
• You can send up to 256 pages per fax (Based on ITU-T No.1 Chart, Standard Mode.). A document of 257 pages or 

more needs to be sent in separate faxes.
• Your machine must be connected via USB and the USB printer driver loaded to fax from your computer. This 

machine does not support network faxing.

1 Open the document you want to fax in an application ➞ select the command to print.

In most cases, click [Print] from the [File] menu.

The [Print] dialog box appears.

2 From the [Select Printer] list box or the [Name] pull-down list in the [Print] dialog box, select [Canon 
MF5700 Series (FAX)].

3 Click [Print] or [OK].

The [Fax Sending Settings] dialog box appears.

4 In the [Fax Sending Settings] dialog box, enter the [Recipient Name] and [Fax Number], or select them 
from the Address Book ➞ click [Add to Recipient List].

For details on how to use the [Fax Sending Settings] dialog box, see "Fax Sending Settings," on p. 4-2.

For details on the characters and symbols you can use for fax numbers, see "Characters and Symbols for Fax 
Numbers," on p. 4-2.

For details on how to select a recipient from the Address Book, see "Select Recipient from Address Book," on 
p. 4-4.
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NOTE
• You cannot send a fax without entering the [Recipient Name].
• Up to 38 characters (excluding "-") can be entered in the [Fax Number] edit box.
• Up to 85 characters can be entered in the [Recipient Name] edit box.
• To select the [Recipient Name] and [Fax Number] from the Address Book, you must register them in the Address 

Book first. For details, see p. 4-28.
• You can register the recipient and his/her fax number in the Address Book so that you can use it in the future. Click 

[Add to Address Book] after entering the recipient name and fax number in the [Fax Sending Settings] dialog box. 
You can enter additional information, such as the company name and department, etc., in the [Edit Address Book] 
tab (see "Edit Address Book Tab," on p. 4-28).

5 Click [OK].

Characters and Symbols for Fax Numbers
You can use the following characters and symbols in the fax numbers you send from your computer or 
for a recipient you register in the Address Book.

Fax Sending Settings
If you select the command to print from an application, the [Fax Sending Settings] dialog box appears. 
The [Fax Sending Settings] dialog box has three tab sheets.

NOTE
• For more information about the following features, see the Online Help (see p. 1-2).
• The screen shots shown are from Windows XP.

Character/symbol Explanation

0-9 * # For use in telephone and fax numbers.

p To place a pause between numbers.

P To place a pause at the end of an array of numbers.

T Numbers after the T will be sent as a tone signal.

R PSTN/PBX switchover function.

+ - (), To make the number easier to read.
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■ Sending Settings Tab

Specifies the recipient name and fax number of the destination to which you send a fax. You can 
specify multiple destinations in one operation.

[Recipient Name] Specifies the recipient’s name.

[Fax Number]
Specifies the fax/telephone number of the recipient.
For details on the characters and symbols you can use for fax numbers, see 
"Characters and Symbols for Fax Numbers," on p. 4-2.

[Add to Address Book]
Adds the recipient name and fax numbers you entered in [Recipient Name] and 
[Fax Number] to the Address Book.

[Add to Recipient List]
Adds the recipient name and fax numbers you entered in [Recipient Name] and 
[Fax Number] to the [Recipient List].

[Select from Address Book...]

Opens the [Select Recipient from Address Book] dialog box. (See p. 4-4.)

[Recipient List]
Shows the list of the recipient names and fax numbers of the destinations you 
are going to send a fax.

[Remove from Recipient List]

Deletes destination(s) from the [Recipient List]. Select the destination(s) you 
want to delete from the list and click [Remove from Recipient List].
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■ Select Recipient from Address Book

■ Edit Address Book Tab

Allows you to edit the Address Book. For details, see "Edit Address Book Tab," on p. 4-28.

[Address Books] Shows the available address books.

NOTE
• Address books might not be shown in the cases below.

- There are no address book files.
- The address book file is a read-only file.
- The user is not authorized to write in the address book.

[Search by Recipient] Searches the destination by the recipient name.

[Add to Recipient List] Adds the recipient names and fax numbers you entered in [Recipient List].

[Recipient List]
Shows the list of the recipient names and fax numbers of the destinations you 
are going to send a fax.

[Remove from Recipient List]

Deletes destination(s) from the [Recipient List]. Select the destination(s) you 
want to delete from the list and click [Remove from Recipient List].
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■ Cover Sheet Tab

Specifies the cover sheet to be attached to the document you fax.

NOTE
You can create your original cover sheets using the Canon Cover Sheet Editor. For details, see "Canon Cover 
Sheet Editor," on p. 4-36.

[Cover Sheet Attachment]
Specifies if the cover sheet is attached or not. ([None], [Different Sheet to Each 
Recipient] or [Same Sheet to All Recipients])

[Style]

Selects the style of the cover sheet from the list of the cover sheet templates 
supplied with the fax driver, or the cover sheets you registered in the [Register 
Cover Sheet] dialog box (for Windows 98/Me, see p. 4-20, for Windows 2000/
XP/Server 2003, see p. 4-33).

[Items to Include] Displays the items to be included in the cover sheet.

[Settings...] Opens the [Item Settings] dialog box. (See p. 4-6.)

[Remark]
Prints the attention label to the cover sheet. ([Urgent], [Very Urgent], [FYI], or 
[Confidential])

[Comment to Include] Allows you to enter the comment to be included in the cover sheet.

[Preview] Displays the preview image of the cover sheet.
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■ Item Settings

The [Item Settings] dialog box allows you to set the details of the items to be included in the cover 
sheets. The [Item Settings] dialog box has the following five tab sheets.

● Sender Tab

The [Sender] tab sheet enables you to edit the sender information to be included in the cover sheets.

[Sender Name]
Enables you to enter the sender name in [Sender Name] text box up to 85 
characters.

[Company]
Enables you to enter the company name in the [Company] text box up to 40 
characters.

[Dept./Div.]
Enables you to enter the department or division name of the sender in the 
[Dept./Div.] text box up to 40 characters.

[Fax Number]
Enables you to enter the fax number in the [Fax Number] text box up to 45 
characters (up to 38 characters excluding hyphens “-”).

[Import Sender...] Imports sender information from a CSV file.

[Save Sender...] Saves sender information in a CSV file.
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● Recipient Tab

Specifies to include the display of Recipient information specified in the Address Book on the cover 
sheet.

[Recipient Name] Enters the recipient name.

[Company] Enters the recipient’s company name.

[Dept./Div.] Enters the recipient’s department or division name.

[Fax Number]
Enters the recipient’s fax number. For details on the characters and symbols you 
can use for fax numbers, see "Characters and Symbols for Fax Numbers," on 
p. 4-2.
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● Logo Tab

The [Logo] tab sheet enables you to select whether the logo is attached to the cover sheet, and sets 
how the logo is attached.

[Print with Logo] Attaches the logo to the cover sheet.

[File Name]
Selects the data file of the logo to be attached to the cover sheet. You can select 
a bitmap data only.

[Browse...] Allows you to search for the logo file in your computer.

[Manual Scaling] Enables you to specify the size of the logo in [Scaling] from 50% to 200%.

[Position]
Specifies the vertical and horizontal position where the logo is printed. You can 
enter the values in the [X] and [Y] edit boxes (in a range between -50 and +50), 
or use the X and Y slide bars to move the position.

[Move to Center] Relocates the logo to the center of the page.
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● Signature Tab

The [Signature] tab sheet enables you to select whether the signature is attached to the cover sheet, 
and sets how the signature is attached.

[Print with Signature] Attaches the signature to the cover sheet.

[File Name]
Selects the data file of the signature to be attached to the cover sheet. You can 
select a bitmap data only.

[Browse...] Allows you to search for the signature file in your computer.

[Manual Scaling] Enables you to specify the size of the logo in [Scaling] from 50% to 200%.

[Position]
Specifies the vertical and horizontal position where the signature is printed. You 
can enter the values in the [X] and [Y] edit boxes (in a range between -50 and 
+50), or use the X and Y slide bars to move the position.

[Move to Center] Relocates the signature to the center of the page.
4-9



P
C

 F
ax

in
g 

(M
F

57
50

/M
F

57
70

 M
od

el
s 

O
nl

y)

4

● Sheets to Send Tab

The [Sheets to Send] tab sheet enables you to select whether the number of sheets to send is included 
in the cover sheet, and edit the number of sheets to be included in the cover sheet.

Changing Fax Settings
If you want to view or change the fax options, access the fax properties or fax printing preferences 
dialog box of the fax driver. 
You can access the fax properties dialog box either from the application's [Print] dialog box and the 
[Printers and Faxes] (Windows 98/Me/2000: [Printers]) folder, or the fax printing preferences dialog box 
from the [Printers and Faxes] (Windows 2000: [Printers]) folder.

[Include Number of Sheets to Send]

Enables you to specify the number in the [Number of Sheets to Send] text box 
up to maximum of 4 numeric characters.

NOTE
Number of sheet to send is not counted automatically. The number you entered will 
be printed on the cover page.
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To access the dialog box, follow this procedure below.

NOTE
• If you open the fax properties dialog box from the [Printers and Faxes] (Windows 98/Me/2000: [Printers]) folder, 

you can set up the fax configuration and configure the fax settings for all Windows applications. The fax printing 
preferences dialog box enables you to specify the default settings for the faxing options available when you fax 
with the Canon imageCLASS MF5700 Series. (Only for Windows 2000/XP/Server 2003.)

• The number of tabs displayed in the properties dialog box will vary, depending on the type of operating system you 
are using and the method you use to access the dialog box.

• The method you use to access the dialog boxes determines how long the faxing options remain in effect:
- If you access the dialog box from an application's [Print] dialog box, your selected faxing options apply only to 

the current fax job. They will not be stored when you close the application.
- If you access the dialog box from the [Printers and Faxes] (Windows 98/Me/2000: [Printers]) folder, selected 

faxing options apply to all Windows applications and remain in effect until you change those settings.

From a Windows Application

■ Opening the MF5700 Series (FAX) Printing Preferences or MF5700 Series (FAX) 
Properties Dialog Box

1 Open the application from which you will fax the document.

2 Select the command to print.

In most cases, click [Print] from the [File] menu.

The [Print] dialog box appears.

3 From the [Select Printer] list box or the [Name] pull-down list in the [Print] dialog box, select the fax to be 
used.

4 Click [Preferences] or [Properties].

The [Canon MF5700 Series (FAX) Printing Preferences] or [Canon MF5700 Series (FAX) Properties] dialog box 
appears.

From the [Printers and Faxes] (Windows 98/Me/2000: [Printers]) 
Folder

■ Opening the MF5700 Series (FAX) Properties Dialog Box

1 Open the [Printers and Faxes] (Windows 98/Me/2000: [Printers]) folder.

Click [start] on the Windows task bar ➞ select [Printers and Faxes] (Windows 98/Me/2000: [Start] ➞ [Settings] ➞ 
[Printers]).

2 Click the corresponding printer driver icon.

3 From the [File] menu, click [Properties].

You can also open the [Canon MF5700 Series (FAX) Properties] dialog box by right-clicking the corresponding 
printer driver icon and selecting [Properties] from the pop-up menu. 

The [Canon MF5700 Series (FAX) Properties] dialog box appears. 
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■ Opening the MF5700 Series (FAX) Printing Preferences Dialog Box (Windows 
2000/XP/Server 2003 Only)

1 Open the [Printers and Faxes] (Windows 2000: [Printers]) folder.

Click [start] on the Windows task bar ➞ select [Printers and Faxes] (Windows 2000: [Start] ➞ [Settings] ➞ 
[Printers]).

2 Click the corresponding printer driver icon.

3 From the [File] menu, click [Printing Preferences].

You can also open the [Canon MF5700 Series (FAX) Printing Preferences] dialog box by right-clicking the 
corresponding printer driver icon and selecting [Printing Preferences] from the pop-up menu.

The [Canon MF5700 Series (FAX) Printing Preferences] dialog box appears.

Windows 98/Me Fax Properties

■ General Tab

Lets you print a test page or define separator pages. Refer to your Windows operating system 
documentation for more information.
4-12



P
C

 F
ax

in
g 

(M
F

57
50

/M
F

57
70

 M
od

el
s 

O
nl

y)

4

■ Details Tab

Specifies the printer port and time-out settings. Refer to your Windows operating system 
documentation for more information.

■ Spool Settings

The installer sets the following defaults.
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■ Sharing Tab

Specifies the printer sharing settings. This tab sheet is available only when the printer sharing is 
enabled (see "Setting Printer Sharing," on p. 2-58.) Refer to your Windows operating system 
documentation for more information.
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■ Edit Address Book Tab

Lets you edit the address book.

[Address Book]
Displays the list of the destinations registered in the Address Book. The entries 
can be sorted by their information ([Recipient Name], [Company], [Dept./Div.], 
[Fax Number], and [Description]).

[Show]
Selects the category of the list displayed in [Address Book]. ([Person] or 
[Group])

[Add Person...] Opens the [Add Person] dialog box. (See p. 4-16.)

[Add Group...] Opens the [Add Group] dialog box. (See p. 4-17.)

[Edit...]
Edits the selected entry in the Address Book list. If you select a person, the [Edit 
Person] dialog box appears. If you select a group, the [Edit Group] dialog box 
appears.

[Delete] Deletes the selected entry from the Address Book.

[Specify a Folder...]
Opens the [Browse For Folder] dialog box. Enables you to make changes to the 
Address book folder.

[Import...]
Enables you to import address book data from files. Importable file types are: 
some CSV files (with file extension “*.csv”) and some Canon Data Files (with file 
extension “*.abk”).

[Export...] Exports the address book data to an outside file.
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■ Add Person

The [Add Person] dialog box enables you to register a person and his/her information in the Address 
Book.

You can register the following information:

[Prefix]
Enters the prefix to the recipient’s name, or selects the prefix from the pull-down 
list. ([Dr.], [Mr.], [Mrs.], or [Ms.])

[First] Enters the recipient’s first name.

[Last] Enters the recipient’s last name.

[Suffix]
Enters the suffix to the recipient’s name, or selects the suffix from the pull-down 
list. ([Jr.], [MD], or [Sr.])

[Recipient Name] Enters the recipient name.

[Company] Enters the recipient’s company name.

[Dept./Div.] Enters the recipient’s department or division name.

[Fax Number] Enters the recipient’s fax number. You can enter two numbers and description.

[Notes] Enters the additional information about the recipient.
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■ Add Group

The [Add Group] dialog box enables you to register a group and its information in the Address Book.

You can register the following information:

[Group Name] Enters the group name.

[Show]
Selects the category of the list displayed in [Available Recipients]. ([Person] or 
[Group])

[Available Recipients] Displays the list of recipients already registered in the Address Books.

[Add to Group] Adds a person/group to the group.

[Remove from Group] Deletes a person/group from the group.

[Current Group Members]

Displays the members currently registered in the group.

[Notes] Enters the additional information about the group.
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■ Edit Person

The [Edit Person] dialog box enables you to edit a person and his/her information in the Address Book.

You can edit the following information:

[Prefix]
Enters the prefix to the recipient’s name, or selects the prefix from the pull-down 
list. ([Dr.], [Mr.], [Mrs.], or [Ms.])

[First] Enters the recipient’s first name.

[Last] Enters the recipient’s last name.

[Suffix]
Enters the suffix to the recipient’s name, or selects the suffix from the pull-down 
list. ([Jr.], [MD], or [Sr.])

[Recipient Name] Enters the recipient name.

[Company] Enters the recipient’s company name.

[Dept./Div.] Enters the recipient’s department or division name.

[Fax Number] Enters the recipient’s fax number. You can enter two numbers and description.

[Notes] Enters the additional information about the recipient.
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■ Edit Group

The [Edit Group] dialog box enables you to edit a group and its information in the Address Book.

You can edit the following information:

[Group Name] Enters the group name.

[Show]
Selects the category of the list displayed in [Available Recipients]. ([Person] or 
[Group])

[Available Recipients] Displays the list of recipients already registered in the Address Books.

[Add to Group] Adds a person/group to the group.

[Remove from Group] Deletes a person/group from the group.

[Current Group Members]

Displays the members currently registered in the group.

[Notes] Enters the additional information about the group.
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■ Register Cover Sheet Tab

Registers/deletes the cover sheets to be attached to the document you fax.

NOTE
You can create your original cover sheets using the Canon Cover Sheet Editor. For details, see "Canon Cover 
Sheet Editor," on p. 4-36.

Preview image Displays the image with the currently selected settings reflected.

[Style] Displays the list of the registered cover sheets.

NOTE
The number of sheets you are going to send as a fax is not displayed on the cover 
sheet when you select Template 1, 2 or 3 for Style.

[Preview] Displays the preview image of the selected cover sheet.

[Register...] Registers the cover sheet template.

[Delete]
Deletes the registered cover sheet template. Select a cover sheet template from 
[Style], then press [Delete].
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■ Special Tab

Specifies the page settings including the paper size, orientation, and resolution.

You can also specify the outside dialing prefix if you dial through a switchboard.

[Address Book List] Displays the list of the registered Address Books.

Preview image Displays the image with the currently selected settings reflected.

[Page Size]
Selects the original page size to work with in an application. ([Letter], [11x17], 
[Legal], [A4], [A3], [A5], [B4], or [B5])

[Orientation] Selects the direction of printing relative to the paper. ([Portrait] or [Landscape])

[Resolution] Specifies the resolution of the fax. ([Ultra Fine] or [Fine])

[Outside Dialing Prefix]
Enables you to enter the prefix number in [Outside Dialing Prefix] up to 5 
numbers.

[Address Books...] Opens the [Address Books] dialog box (see p. 4-22).

[Restore Defaults] Resets all the current settings to their default values.
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■ Address Books

Clicking [Address Books] in the [Special] tab sheet opens the [Address Books] dialog box. This dialog 
box enables you to specify an Address Book to be referred to when sending a fax.

● Register Address Book

This dialog box enables you to register the Address Books to be used when you send a fax.

[Address Book List] Displays the list of the registered Address Books.

[Register] Opens the [Register Address Book] dialog box. (See p. 4-22.)

[Edit]
Opens the [Add/Edit Canon Fax Driver Address Book] dialog box. 
(See p. 4-23.)

[Delete] Deletes the selected Address Book from the [Address Book List].

[Available Address Books]

Displays the list of the available Address Books.
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● Add/Edit Canon Fax Driver Address Book

This dialog box enables you to edit the properties of the Address Books to be used when you send a 
fax.

■ Configuration Tab

[Name] Changes the name of the Address Book. You can enter up to 64 characters.

[About] Displays the version information on the driver. 
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Windows 2000/XP/Server 2003 FAX Properties and FAX 
Printing Preferences

The FAX driver for Windows 2000/XP/Server 2003 has the following two main dialog boxes:

■ The FAX Properties Dialog Box
This dialog box enables you to set up the fax configuration and configure the fax settings for all 
Windows applications.

■ The FAX Printing Preferences Dialog Box
This dialog box enables you to edit the address book, register the cover sheets, and set up the page 
settings.

FAX Properties
The [Canon MF5700 Series (FAX) Properties] dialog box contains several tab sheets that enable you 
to set up the fax configuration and configure the fax settings.

NOTE
• The number of tabs displayed in the properties dialog box depends on how you have your system set up. 
• For more information about the following features, see the Online Help (see p. 1-2).
• The screen shots shown are from Windows XP. 

■ General Tab

Lets you print a test page and define faxing preferences. Refer to your Windows operating system 
documentation for more information.
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■ Sharing Tab

Specifies the printer sharing settings. This tab sheet is available only when the printer sharing is 
enabled (see p. 2-58). Refer to your Windows operating system documentation for more information.

■ Ports Tab

Specifies the port to which the printer is attached. Refer to your Windows operating system 
documentation for more information.

■ Advanced Tab

Specifies the settings for print spooling. Refer to your Windows operating system documentation for 
more information.
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NOTE
[Spool print documents so program finishes printing faster] and [Start printing immediately] are set automatically 
when you install the printer driver.

■ Color Management Tab

Associates color profiles with your color printer. Refer to your Windows operating system 
documentation for more information.

■ Security Tab

Specifies security settings. Refer to your operating system documentation for more information.
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■ Configuration Tab

FAX Printing Preferences
The [Canon MF5700 Series (FAX) Printing Preferences] dialog box contains three tab sheets that 
enable you to edit the address book, register the cover sheets, and set up the page settings.

NOTE
• If you access the equivalent dialog box from an application's [Print] dialog box, your selected faxing options apply 

only to the current fax job.
• For more information about the following features, see the Online Help (see p. 1-2).
• The screen shots shown are from Windows XP.

[About] Displays the version information on the driver.
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■ Edit Address Book Tab

Lets you edit the address book.

[Address Book]
Displays the list of the destinations registered in the Address Book. The entries 
can be sorted by their information ([Recipient Name], [Company], [Dept./Div.], 
[Fax Number], and [Description]).

[Show]
Selects the category of the list displayed in [Address Book]. ([Person] or 
[Group])

[Add Person...] Opens the [Add Person] dialog box. (See p. 4-29.)

[Add Group...] Opens the [Add Group] dialog box. (See p. 4-30.)

[Edit...]
Edits the selected entry in the Address Book list. If you select a person, the [Edit 
Person] dialog box appears. If you select a group, the [Edit Group] dialog box 
appears.

[Delete] Deletes the selected entry from the Address Book.

[Specify a Folder...]
Opens the [Browse For Folder] dialog box. Enables you to make changes to the 
Address book folder.

[Import...]
Enables you to import address book data from files. Importable file types are: 
some CSV files (with file extension “*.csv”) and some Canon Data Files (with file 
extension “*.abk”).

[Export...] Exports the address book data to an outside file.

[About]
Opens a dialog box containing the copyright and version information about this 
fax driver software.
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■ Add Person

The [Add Person] dialog box enables you to register a person and his/her information in the Address 
Book.

You can register the following information:

[Prefix]
Enters the prefix to the recipient’s name, or selects the prefix from the pull-down 
list. ([Dr.], [Mr.], [Mrs.], or [Ms.])

[First] Enters the recipient’s first name.

[Last] Enters the recipient’s last name.

[Suffix]
Enters the suffix to the recipient’s name, or selects the suffix from the pull-down 
list. ([Jr.], [MD], or [Sr.])

[Recipient Name] Enters the recipient name.

[Company] Enters the recipient’s company name.

[Dept./Div.] Enters the recipient’s department or division name.

[Fax Number] Enters the recipient’s fax number. You can enter two numbers and description.

[Notes] Enters the additional information about the recipient.
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■ Add Group

The [Add Group] dialog box enables you to register a group and its information in the Address Book.

You can register the following information:

[Group Name] Enters the group name.

[Show]
Selects the category of the list displayed in [Available Recipients]. ([Person] or 
[Group])

[Available Recipients] Displays the list of recipients already registered in the Address Books.

[Add to Group] Adds a person/group to the group.

[Remove from Group] Deletes a person/group from the group.

[Current Group Members] Displays the members currently registered in the group.

[Notes] Enters the additional information about the group.
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■ Edit Person

The [Edit Person] dialog box enables you to edit a person and his/her information in the Address Book.

You can edit the following information:

[Prefix]
Enters the prefix to the recipient’s name, or selects the prefix from the pull-down 
list. ([Dr.], [Mr.], [Mrs.], or [Ms.])

[First] Enters the recipient’s first name.

[Last] Enters the recipient’s last name.

[Suffix]
Enters the suffix to the recipient’s name, or selects the suffix from the pull-down 
list. ([Jr.], [MD], or [Sr.])

[Recipient Name] Enters the recipient name.

[Company] Enters the recipient’s company name.

[Dept./Div.] Enters the recipient’s department or division name.

[Fax Number] Enters the recipient’s fax number. You can enter two numbers and description.

[Notes] Enters the additional information about the recipient.
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■ Edit Group

The [Edit Group] dialog box enables you to edit a group and its information in the Address Book.

You can edit the following information:

[Group Name] Enters the group name.

[Show]
Selects the category of the list displayed in [Available Recipients]. ([Person] or 
[Group])

[Available Recipients] Displays the list of recipients already registered in the Address Books.

[Add to Group] Adds a person/group to the group.

[Remove from Group] Deletes a person/group from the group.

[Current Group Members] Displays the members currently registered in the group.

[Notes] Enters the additional information about the group.
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■ Register Cover Sheet Tab

Registers/deletes the cover sheets to be attached to the document you fax.

NOTE
You can create your original cover sheets using the Canon Cover Sheet Editor. For details, see "Canon Cover 
Sheet Editor," on p. 4-36.

Preview image Displays the image with the currently selected settings reflected.

[Style]
Selects the style of the cover sheet.
A bitmap image of the selected cover sheet style is displayed in the preview area 
to the left of the options.

NOTE
The number of sheets you are going to send as a fax is not displayed on the cover 
sheet when you select Template 1, 2 or 3 for Style.

[Preview] Displays the preview image of the selected cover sheet.

[Register] Registers the cover sheet template.

[Delete]
Deletes the registered cover sheet template. Select a cover sheet template from 
[Style], then press [Delete].
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■ Special Tab

Specifies the page settings including the paper size, orientation, and resolution.

You can also specify the outside dialing prefix if you dial through a switchboard.

Default settings depend on the country/region of purchase.

Preview image Displays the image with the currently selected settings reflected.

[Page Size]
Selects the original page size to work with in an application. ([Letter], 
[11 x17], [Legal], [A4], [A3], [A5], [B4], or [B5])

[Orientation] Selects the direction of printing relative to the paper. ([Portrait] or [Landscape])

[Resolution] Specifies the resolution of the fax. ([Ultra Fine] or [Fine])

[Outside Dialing Prefix]
Enables you to enter the prefix number in [Outside Dialing Prefix] up to 5 
numbers.

[Address Books...] Opens the [Address Books] dialog box (see p. 4-35).

[Restore Defaults] Resets all the current settings to their default values.
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■ Address Books

Clicking [Address Books] in the [Special] tab sheet opens the [Address Books] dialog box. This dialog 
box enables you to specify an Address Book to be referred to when sending a fax.

● Register Address Book

This dialog box enables you to register the Address Books to be used when you send a fax.

[Address Book List] Displays the list of the registered Address Books.

[Register] Opens the [Register Address Book] dialog box.

[Edit] Opens the [Add/Edit Canon Fax Driver Address Book] dialog box.

[Delete] Deletes the selected Address Book from the [Address Book List].

[Available Address Books]

Displays the list of the available Address Books.
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● Add/Edit Canon Fax Driver Address Book

This dialog box enables you to edit the properties of the Address Books to be used when you send a 
fax.

Canon Cover Sheet Editor
This section describes instructions for installing Canon Cover Sheet Editor, launching the editor, and 
creating and registering original cover sheets.

The Canon Cover Sheet Editor is software for creating original fax cover sheet templates for use with a 
Canon fax driver.

After registering the cover sheets created with this software in your fax driver, you can use them with 
any fax. If you specify fields instead of manually entering data for sender or recipient information, the 
actual sender or recipient information that you select in the fax driver is automatically entered in the 
cover sheet when the fax is sent.

With the Canon Cover Sheet Editor, you can do the following:

• Insert text using different fonts, font styles, and font sizes into a cover sheet.
• Insert a variety of objects, such as drawings and images, into a cover sheet.
• Use the field feature for creating cover sheets for sending faxes to multiple recipients.
• Add fields for specifying remarks and comments in addition to the sender and recipient information fields.
• Easily edit the display order and position of objects, and group different objects.
• Align objects on a grid while you work with them.

[Name] Changes the name of the Address Book. You can enter up to 64 characters.
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Installing and Uninstalling Cover Sheet Editor

■ Installation

1 Insert the CD-ROM into your CD-ROM drive.

NOTE
When [MF5700 Series Setup] screen appears, click [Exit] to close the screen.

2 Click [start] on the Windows task bar ➞ [My Computer] (Windows 98/Me/2000: double-click [My 
Computer]).

3 Open the CD-ROM icon ➞ double-click the following folders: [CSE] ➞ [English].

4 Double-click the [setup (setup.exe)] icon to start the installation process.

5 Click [Next >] ➞ follow the instructions on the screen to continue the installation.

The [License Agreement] dialog box is displayed.
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6 Read CANON SOFTWARE LICENSE AGREEMENT carefully. If you agree to the terms, select [I accept the 
terms in the license agreement] ➞ click [Next >] ➞ follow the instructions on the screen to continue the 
installation.

7 In the dialog box for selecting a setup type, select [Complete] or [Custom] ➞ click [Next >].

NOTE
If you select [Custom] in the dialog box for selecting [Setup Type], you can specify the directory into which Canon 
Cover Sheet Editor is to be installed.

8 Click [Install] to start copying the files.

9 Click [Finish].
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■ Launching

To start the Cover Sheet Editor, follow the procedure below.

1 Click [start] on the Windows task bar ➞ [(All) Programs] ➞ [Canon] ➞ [CSE] ➞ [Cover Sheet Editor].

The Canon Cover Sheet Editor will open.

■ Uninstalling

If it becomes necessary to uninstall the Canon Cover Sheet Editor, follow the procedure below.

1 Click [start] on the Windows task bar ➞ [Control Panel].

2 Click [Add/Remove Programs] (Windows 98/Me/2000: double-click [Add/Remove Programs] icon) ➞ 
select [Canon Cover Sheet Editor] ➞ click [Change] or [Remove].

3 When the [InstallShield Wizard] dialog box appears, follow the instructions on the screen.

The Canon Cover Sheet Editor is uninstalled.
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Opening, Saving, and Closing a File

■ Opening a File

■ Creating a New File

To create a new cover sheet, follow the procedure below.

1 Click [ ] (New) on the toolbar.

Alternatively, select [New] from the [File] menu.

The [New] dialog box appears.

2 Select a paper size for the new cover sheet ➞ click [OK].

The New Cover Sheet screen appears.

■ Opening a Saved Cover Sheet

You can open a saved cover sheet by specifying its file name.

To open a saved cover sheet, follow the procedure below.

1 Click [ ] (Open) on the toolbar.

Alternatively, select [Open] from the [File] menu.

The [Open] dialog box appears.

2 Specify the file name of the cover sheet that you want to open.

NOTE
Clicking [Preview] displays an image of the selected cover sheet.

3 Click [Open].

The selected cover sheet appears.
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■ Saving and Closing a File

■ Saving a New File

If you save a cover sheet, you can register it later in the fax driver for use as an original cover sheet.

1 Click [ ] (Save) on the toolbar.

Alternatively, select [Save] or [Save as] from the [File] menu.

The [Save as] dialog box appears.

2 Enter a name for the file in [File name] ➞ specify the location where you want to save the file ➞ click 
[Save].

The file extension is automatically set to "cse."

■ Saving an Existing File

Follow the procedure below to save an existing cover sheet after editing it.

1 Click [ ] (Save) on the toolbar.

Alternatively, select [Save] from the [File] menu.

IMPORTANT
• To preserve the opened file as it was before editing, select [Save As] and specify a different name or location for 

saving the edited file. Selecting [Save] will overwrite the existing file.
• Selecting the [Save as] command is necessary only to specify a different file name or a different location to save 

the cover sheet.

■ Closing a File

Follow the procedure below to close a currently open cover sheet without exiting the Canon Cover 
Sheet Editor.

1 Click the lower [ ] (Close) at the top-right corner of the Canon Cover Sheet Editor main window.

Alternatively, select [Close] from the [File] menu.

NOTE
If you close a cover sheet that has not been saved after editing, a message appears asking whether you want to 
save the changes. Click [Yes] to save the changes, or [No] if you do not want to save changes. Click [Cancel] if you 
do not want to close the cover sheet.
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Creating an Original Cover Sheet
This section explains how to insert text, adjust text properties, specify fields, create objects, adjust 
objects, and specify grid options in order to create an original cover sheet.

■ Inserting Text

You can insert text and numbers into the cover page. The properties of any text or the text box itself can 
also be changed. To edit the text, change to the edit mode by clicking anywhere inside of a text box, 
and then place the cursor on the text that you want to edit.

1 Click [ ] (Text Box) on the toolbar.

Alternatively, select [Text Box] from the [Insert] menu.

2 Drag the pointer on the area of the cover sheet to insert text.

A square or rectangular text box appears.

3 Click inside the text box.

The cursor for editing text appears.

4 Enter the desired text.

■ Adjusting Text Properties

You can change text properties whenever you want. When you change text properties, all text inside 
the selected text box is affected.

Text properties for field settings inside a text box are also changed according to the text properties you 
specified. For details on field features, see "Specifying Fields," on p. 4-46.

■ Font

1 Click inside the text box.

The text box is now ready for editing.

2 Select the desired font from the Font drop-down menu on the toolbar.

■ Font Size

1 Click inside the text box.

The text box is now ready for editing.

2 Select the desired font size from the Font Size drop-down menu on the toolbar.

You can also enter the desired font size directly into Font Size.
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■ Font Color

1 Click inside the text box.

The text box is now ready for editing.

2 Select the desired font color from the Font Color drop-down menu on the toolbar.

■ Bold Formatting

1 Click inside the text box.

The text box is now ready for editing.

2 Click [ ] (Bold) on the toolbar.

To undo the bold formatting, click [ ] (Bold) again.

■ Italic Formatting

1 Click inside the text box.

The text box is now ready for editing.

2 Click [ ] (Italic) on the toolbar.

To undo the italic formatting, click [ ] (Italic) again.

■ Underlining

1 Click inside the text box.

The text box is now ready for editing.

2 Click [ ] (Underline) on the toolbar.

To undo the underlining, click [ ] (Underline) again.

■ Aligning Text

1 Click inside the text box.

The text box is now ready for editing.

2 Click [ ] (Align Left), [ ] (Align Center), or [ ] (Align Right) on the toolbar.
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■ Specifying Text Properties

You can specify all of the properties for text inside a text box simultaneously.

[Preview] inside the [Text Properties] dialog box displays a preview of how the text would appear with 
the currently selected settings. Use it as a guide if you are specifying settings.

1 Click inside the text box.

The text box is now ready for editing.

2 Click [ ] (Properties) on the toolbar.

Alternatively, select [Properties] from the [Edit] menu.

Alternatively, right-click inside the text box ➞ click [Properties].

The [Text Properties] dialog box appears.

3 Select [Font], [Font Style], and [Size] from the respective list boxes.

Alternatively, enter the desired font size directly into [Size].

4 Select [Strikethrough] or [Underline] to draw a line through or to underline text.

5 Select the desired text color from [Color].

6 Specify [Alignment] for the text.

7 Click [OK].
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■ Specifying Text Box Properties

Follow the procedure below to specify the type of border, border color, and background color of the 
selected text box.

1 Click anywhere on the border of the text box.

The border of the text box is selected.

2 Click [ ] (Properties) on the toolbar.

You can also select [Properties] from the [Edit] menu.

You can also display the [Text Box Properties] dialog box by double-clicking anywhere on the border of the text 
box.

The [Text Box Properties] dialog box opens.

3 Select the desired border type from [Line Style].

4 Specify the [Width] setting to set the thickness of the border (0.1 to 50.0).

NOTE
The [Width] setting is available only if [Line Style] is set to 'Solid'.

5 Select the desired color of the border from [Color].

6 Select the desired background color for the text box from [Fill in].

7 Click [OK].
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■ Specifying Fields

You can show sender or fax recipient information, such as the name, fax number, company name, and 
department/division name on the cover sheet using a feature called a "field."

Fields are objects in the cover sheet that you can replace with data when sending a fax. Actual sender 
and recipient information as specified in the fax driver is automatically inserted in the corresponding 
fields on the cover sheet during transmission.

Available fields:

• Sender information: Name, Fax Number, Company, Dept./Div.
• Recipient information: Name, Fax Number, Company, Dept./Div.
• Sheets to send
• Other information: Remark, Comment

A recipient information field that contains multiple values is called a "repeating field." This feature is 
convenient for using the same cover sheet to send faxes to multiple recipients.

The repeating field is used to insert data for every recipient specified in the fax driver.

In addition to the [Sender Information] and [Recipient Information] fields, you can also insert [Sheets to 
Send], [Remark], and [Comment] fields on the cover sheet. When the fax is sent, the number of sheets 
to send as a fax specified in the fax driver is inserted in the [Sheets to Send] field, information specified 
in the fax driver such as [Urgent] or [Confidential] is inserted in the [Remark] field, and comments 
specified in the fax driver are entered in the [Comment] field.

FAX

From
[Sender Name]

To
[Recipient Name]

Substituted
when the fax
is sent.

[Remark]

FAX

From
George Smith

To
Mr. David Walters

[Confidential]

FAX FAX

[Recipient Company] XXX Company

Dept. A

Dr. Curtis

Dept. B

Mr. Alter

Dept. C

Mr. Green

Dept. D

Ms. Harrison

Substituted
for each
recipient when
the fax is sent.[Begin Repeat]

[Recipient Dept./Div.]

[Recipient Name]

[End Repeat]
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■ Inserting Sender and Recipient Information Fields When Editing Text

1 Inside the text box, place the cursor to where you want to insert the field.

2 Click the [Insert] menu ➞ [Sender Information] or [Recipient Information] ➞ select the field (such as 
[Name], [Fax Number], [Company], and [Dept./Div.]) to insert.

The selected field is inserted.

NOTE
If you select [Insert All], all of the available fields for sender or recipient information are inserted simultaneously. 
The fields are inserted in this order: [Name], [Fax Number], [Company], and [Dept./Div.]. You can change the 
position of the fields as needed.

■ Inserting Sender and Recipient Information Fields When Not Editing Text

1 Click the [Insert] menu ➞ [Sender Information] or [Recipient Information] ➞ select the field (such as 
[Name], [Fax Number], [Company], and [Dept./Div.]) to insert.

2 Drag the pointer on the area of the cover sheet to where you want to insert the field.

A square or rectangular text box containing the selected field appears.

NOTE
If you select [Insert All], all of the available fields for sender or recipient information are inserted simultaneously. 
The fields are inserted in this order: [Name], [Fax Number], [Company], and [Dept./Div.]. You can change the 
position of the fields as needed.

■ Inserting Repeating Fields

Follow the procedure below to show information for multiple recipients on the cover sheet when 
sending a fax.

1 Insert the desired recipient information field, such as [Name], [Fax Number], [Company], and [Dept./Div.].

2 Inside the text box, place the cursor to the left of the field to repeat.

3 Click the [Insert] menu ➞ [Recipient Information] ➞ [Begin Repeat].

The [Begin Repeat] field is inserted.

4 Inside the text box, place the cursor to the right of the field to repeat.

5 Click the [Insert] menu ➞ [Recipient Information] ➞ [End Repeat].

The [End Repeat] field is inserted.

The field between the [Begin Repeat] and [End Repeat] fields is replaced with multiple recipients' information 
when sending a fax.

NOTE
The text box may not be able to accommodate all of the actual data for a repeating field if a large number of 
recipients are specified for sending a fax. In this case, a new page is automatically created and data that does not 
fit into the text box displays from the top of the new page.
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■ Inserting Borders Between Repeating Fields

When you specify a repeating field for recipient information, you can also select to insert borders 
between the values for easier reading.

1 Click the [Insert] menu ➞ [Recipient Information] ➞ [Borders].

The [Border Settings] dialog box opens.

2 Select [Insert a Border Between Repeats] to insert borders between multiple values in a repeating 
recipient information field.

If you do not want to insert borders between the values, deselect this check box ➞ click [OK]. 

3 Select the type of line to use as the border from [Line Style].

4 Specify the [Width] setting to set the thickness of the borders (0.1 to 10.0).

NOTE
The [Width] setting is available only if [Line Style] is set to 'Solid'.

5 Select the desired color of the borders from [Color].

6 Click [OK].

■ Inserting Sheets to Send Field When Editing Text

1 Inside the text box, place the cursor where you want to insert the field.

2 From the [Insert] menu, select [Sheets to Send].

The [Sheets to Send] field is inserted.

■ Inserting Sheets to Send Field When Not Editing Text

1 Form the [Insert] menu, select [Sheets to Send].

2 Drag the pointer on the area of the cover sheet to insert the field.

A square or rectangular text box containing the selected field appears.
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■ Inserting Remark and Comment Fields When Editing Text

1 Inside the text box, place the cursor to where you want to insert the field.

2 From the [Insert] menu, select either [Remark] or [Comment].

The [Remark] field or the [Comment] field is inserted depending on your selection.

■ Inserting Remark and Comment Fields When Not Editing Text

1 From the [Insert] menu, select either [Remark] or [Comment].

2 Drag the pointer on the area of the cover sheet to insert the field.

A square or rectangular text box containing the selected field appears.

■ Creating Objects

You can draw lines, rectangles, rounded rectangles, or ovals on the cover sheet. You can also change 
their properties once they are drawn.

■ Lines

1 Click [ ] (Line) on the toolbar.

You can also select [Line] from the [Drawing] menu.

2 Drag the pointer on the area of the cover sheet to draw the line.

■ Rectangles

1 Click [ ] (Rectangle) on the toolbar.

You can also select [Rectangle] from the [Drawing] menu.

2 Drag the pointer on the area of the cover sheet to draw the rectangle.

To draw a square, hold down [SHIFT] on the keyboard while dragging.

■ Rounded Rectangles

1 Click [ ] (Rounded Rectangle) on the toolbar.

You can also select [Rounded Rectangle] from the [Drawing] menu.

2 Drag the pointer on the area of the cover sheet to draw the rounded rectangle.

To draw a rounded square, hold down [SHIFT] on the keyboard while dragging.

You can adjust the degree of the curve or the roundness of the corners of the rounded rectangle. To do so, click 
anywhere outside the newly created rounded rectangle ➞ click the rounded rectangle again ➞ click and drag the 
inner handle in its upper right corner to change the degree of the curve.
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■ Ovals

1 Click [ ] (Oval) on the toolbar.

You can also select [Oval] from the [Drawing] menu.

2 Drag the pointer on the area of the cover sheet to draw the oval.

To draw a circle, hold down [SHIFT] on the keyboard while dragging.

■ Inserting Images

1 Click [ ] (Image) on the toolbar.

You can also select [Image] from the [Insert] menu.

The [Open] dialog box appears.

2 Specify the file name of the bitmap file that you want to insert.

NOTE
Clicking [Preview] opens the [Preview] dialog box, where an image of the highlighted bitmap file is displayed.

3 Click [Open].

■ Editing Objects

You can copy, move, and delete objects such as lines, rectangles, rounded rectangles, ovals, images, 
and text boxes on the cover sheet.

■ Selecting an Object

1 Click the object to select.

You can also drag the pointer completely over the object.

The object is selected.

NOTE
You can also select multiple objects by holding down [SHIFT] on the keyboard and clicking each object that you 
want to select, or by dragging the pointer completely over the objects. If you want to deselect any of the objects 
you selected, hold down [SHIFT] on the keyboard ➞ click the objects that you want to deselect.

■ Moving an Object within the Same Cover Sheet

Select the object to move.

1 You can select multiple objects and move them at the same time.

2 Drag the selected object to the desired location.

Alternatively, use any of the four arrow keys [ ], [ ], [ ], or [ ] to move the object in the desired 
direction in 0.1 mm increments.

NOTE
• Hold down [SHIFT] on the keyboard while dragging to move the object horizontally or vertically only.
• Hold down [CTRL] on the keyboard while dragging to copy the selected object and drag the copy to the desired 

location.
• If [Snap to Grid] is specified, holding down [SHIFT] on the keyboard while pressing an arrow key moves the object 

in the direction of the arrow in half-grid space increments. If [Snap to Grid] is not specified, holding down [SHIFT] 
on the keyboard while pressing an arrow key moves the object in the direction of the arrow in 2.0 mm increments.
4-50



P
C

 F
ax

in
g 

(M
F

57
50

/M
F

57
70

 M
od

el
s 

O
nl

y)

4

■ Moving an Object to a Different Cover Sheet

1 Select the object to move.

NOTE
You can select multiple objects and move them at the same time.

2 Click [ ] (Cut) on the toolbar.

Alternatively, select [Cut] from the [Edit] menu.

3 Display the second cover sheet.

 

NOTE
If the second cover sheet is open, you can select it from the [Window] menu.

4 Click [ ] (Paste) on the toolbar.

Alternatively, select [Paste] from the [Edit] menu.

The selected object is moved to the active cover sheet.

■ Resizing an Object

1 Select the object whose size you want to change.

NOTE
You can select multiple objects and change all of their sizes at the same time.

2 Drag any handle on the selected object to change its size.

NOTE
The shape of the pointer changes depending on which handle you place it over.
- Dragging the handles on the top and bottom sides of the object changes its height.
- Dragging the handles on the left and right sides of the object changes its width.
- Dragging the handles on the corners of the object changes both its height and width.

■ Copying an Object by Dragging

1 Select the object to copy.

NOTE
You can select multiple objects and copy them at the same time.

2 Hold down [CTRL] on the keyboard ➞ drag the selected (copied) object to the desired location.

NOTE
Dragging the selected object without holding down [CTRL] on the keyboard moves the object to the new location 
instead of copying it.
4-51



P
C

 F
ax

in
g 

(M
F

57
50

/M
F

57
70

 M
od

el
s 

O
nl

y)

4

■ Copying an Object by Using Button or Menu Commands

You can use button and menu commands to copy an object such as a line, rectangle, rounded 
rectangle, oval, image, or text box on the same cover sheet or to another cover sheet.

Follow the procedure below.

1 Select the object to copy.

NOTE
You can select multiple objects and copy them at the same time.

2 Click [ ] (Copy) on the toolbar.

You can also select [Copy] from the [Edit] menu.

3 If you want to copy the object to a different cover sheet, display the second cover sheet.

NOTE
If the second cover sheet is open, you can select it from the [Window] menu.

4 Click [ ] (Paste) on the toolbar.

Alternatively, select [Paste] from the [Edit] menu.

The selected object is copied.

NOTE
• You cannot copy an object to a different cover sheet by dragging.
• To copy text, drag the pointer over the text to select it ➞ click [ ] (Copy) or select the [Copy] command to copy it 

➞ click [ ] (Paste) or select the [Paste] command. If you want to copy text within the same text box, hold down 
[CTRL] on the keyboard while dragging the selected text.

■ Duplicating an Object

Duplicating enables you to copy and paste an object in one operation.

1 Select the object to duplicate.

NOTE
You can select multiple objects and duplicate them at the same time.

2 Click [ ] (Duplicate) on the toolbar.

Alternatively, select [Duplicate] from the [Edit] menu.

The selected object is duplicated.

■ Deleting an Object

1 Select the object to delete.

NOTE
You can select multiple objects and delete them at the same time.

2 Click [ ] (Delete) on the toolbar.

Alternatively, select [Delete] from the [Edit] menu, or press [DELETE] on the keyboard.

The selected object is deleted.
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■ Grouping Objects

You can edit or handle multiple objects that are grouped together as a single object. You can move, 
copy, or change the size of grouped objects in a single operation. You can also simultaneously modify 
the properties of all objects in the group.

1 While holding down [SHIFT] on the keyboard, you can individually select multiple objects by left clicking 
on them with the mouse, or you can select all of the objects by running the mouse over them.

2 Click [ ] (Group) on the toolbar.

Alternatively, select [Group] from the [Layout] menu.

You can ungroup objects by selecting the group of objects that you want to ungroup and clicking [ ] (Ungroup) 
on the toolbar or selecting [Ungroup] from the [Layout] menu.

■ Specifying Object Properties

Follow the procedure below to change the line style, line color, and background color of objects such as 
lines, rectangles, rounded rectangles, ovals, and images.

1 Select the object whose properties you want to change.

NOTE
You can select multiple objects and change their properties at the same time.

2 Click [ ] (Properties) on the toolbar.

Alternatively, select [Properties] from the [Edit] menu, or display the [Object Properties] dialog box by 
double-clicking the selected object.

The [Object Properties] dialog box opens.

3 Select the desired line type for the object from [Line Style].

4 Specify the [Width] setting to set the thickness of the line.

NOTE
The [Width] setting is available only if [Line Style] is set to 'Solid'.

5 Select the desired line color for the object from [Color].

6 Select the desired background color for the object from [Fill in].

NOTE
[Fill in] cannot be specified if the selected object is either a line or an image.

7 Click [OK].

■ Arranging Objects

You can rearrange the order and appearance of objects such as lines, rectangles, rounded rectangles, 
ovals, images, and text boxes on the cover sheet.
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■ Changing the Order of Display

If multiple objects overlap, you can specify the order in which they overlap. Use the following four 
commands to change the order of display of overlapping objects.

• [Bring to Front]: Moves the selected object to the front.
• [Send to Back]: Moves the selected object to the back.
• [Bring Forward]: Moves the selected object one level higher.
• [Send Backward]: Moves the selected object one level lower.

1 Select the object whose display order you want to change.

NOTE
• You can select multiple objects and change the order of display for all of them at the same time.
• If the object you want to select lies behind other objects and thus is hidden from view, press [TAB] on the keyboard 

repeatedly until the object you want is selected. You can also select in reverse order by holding down [SHIFT] on 
the keyboard while pressing [TAB] on the keyboard.

2 Click [ ] (Bring to Front), [ ] (Send to Back), [ ] (Bring Forward), or [ ] (Send Backward) on 
the toolbar.

NOTE
Alternatively, select [Bring to Front], [Send to Back], [Bring Forward], or [Send Backward] from the [Layout] menu.

■ Aligning Multiple Objects

You can align multiple selected objects according to their left edge, right edge, top edge, bottom edge, 
or center in one operation. The position of the last selected object becomes the point of reference of 
alignment.

Use the following commands to change the alignment of the selected objects.

• [Align Left]: Aligns the left edge of all objects along the left edge of the last selected object.
• [Align Center]: Aligns the left-right center axis of all objects along the left-right center axis of the last selected 

object.
• [Align Right]: Aligns the right edge of all objects along the right edge of the last selected object.
• [Align Top]: Aligns the top edge of all objects along the top edge of the last selected object.
• [Align Middle]: Aligns the top-bottom center axis of all objects along the top-bottom center axis of the last selected 

object.
• [Align Bottom]: Aligns the bottom edge of all objects along the bottom edge of the last selected object.

1 While holding down [SHIFT] on the keyboard, you can individually select multiple objects by left clicking 
on them with the mouse, or you can select all of the objects by running the mouse over them.

Select the object to be used as the point of reference last.

 

NOTE
If you drag the pointer to select multiple objects, the object positioned in the front is used as the point of reference.

2 Click [ ] (Align Left), [ ] (Align Center), [ ] (Align Right), [ ] (Align Top), [ ] (Align Middle), or 
[ ] (Align Bottom) on the toolbar.

Alternatively, click the [Layout] menu ➞ point to [Distribute Horizontally] or [Distribute Vertically] ➞ select the type 
of alignment you want.
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■ Specifying Grid Options

The grid function is useful for arranging created objects.

■ Showing Grids

You can display the grid on the cover sheet to help you create and arrange objects.

1 On the toolbar, click [ ] (Show Grids) to activate the grid.

Alternatively, activate the command by clicking [Show Grids] from the [View] menu.

Hide the grid by clicking the activated [ ] (Show Grids) to deactivate it or by clicking [Show Grids] from the 
[View] menu.

■ Snapping Objects to Grid

If you activate the [Snap to Grid] setting for the cover sheet, objects are aligned along the grid when 
they are moved or resized on the cover sheet.

1 On the toolbar, click [ ] (Snap to Grid) to activate the grid.

Alternatively, activate the command by clicking [Snap to Grid] from the [View] menu.

Deactivate the [Snap to Grid] setting by clicking the activated [ ] (Snap to Grid) or by clicking [Snap to Grid] 
from the [View] menu.

NOTE
[Snap to Grid] is available only after this setting is specified. It does not affect objects that are modified before this 
setting is specified.

■ Specifying Grid Properties

Follow the procedure below to specify the properties for the grid on the cover sheet, such as type, 
color, and spacing. You can also specify whether to display the grid and whether to snap objects to the 
grid.

1 Select [Grid Properties] from the [View] menu.

The [Grid Properties] dialog box appears.

2 Select [Show Grids].

Deselect the check box if you do not want to display the grid.

NOTE
Deselecting this check box disables the [Type] and [Color] settings.
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3 Select [Dotted] or [Dashed].

4 Click the button to the right of [Color].

The [Color Setting] dialog box appears.

5 Select a color to use as the grid's basic color in the [Color Setting] dialog box.

● To select basic color:

❑ Select the color you want from [Basic colors].

● To create your own color:

❑ Click on a color that is the closest to the color you want.

❑ Click [Define Custom Colors >>].

The color matrix appears on the right of the [Color Settings] dialog box.

❑ Adjust the luminosity of the color ➞ click [Add to Custom Colors].

6 Click [OK] in the [Color Setting] dialog box.

7 Specify the [Horizontal] and [Vertical] spacing for the grid.

NOTE
You can change the unit of measure for the spacing in the [Unit Setting] dialog box displayed by selecting [Unit] 
from the [View] menu.

8 To align objects along the grid, select [Snap to Grid].

To deactivate [Snap to Grid], deselect the check box.

9 Click [OK].

NOTE
Clicking [Restore Defaults] in the [Grid Properties] dialog box restores all [Grid Properties] settings for the cover 
sheet to their default values.
4-56



P
C

 F
ax

in
g 

(M
F

57
50

/M
F

57
70

 M
od

el
s 

O
nl

y)

4

Printing a Cover Sheet
Follow the procedure below to print the cover sheet.

1 Click [ ] (Print) on the toolbar.

Alternatively, select [Print] from the [File] menu.

The [Print] dialog box appears.

2 Select the printer ➞ click [OK].

If necessary, click [Properties] to specify detailed print settings.

3 Specify the number of copies to print.

NOTE
[All] is the only active selection for the [Print range] setting because the cover sheet consists of only one page.

4 Click [OK].

Registering an Original Cover Sheet as a Template
You can register the cover sheet created with the Canon Cover Sheet Editor with the fax driver for use 
as a template.

1 Click [start] on the Windows task bar ➞ [Settings] ➞ [Printers].

NOTE
If you are using Windows XP Professional, on the [start] menu, click [Printers and Faxes]. If you are using 
Windows XP Home Edition, on the [start] menu, click [Control Panel] ➞ [Printers and Other Hardware] ➞ [Printers 
and Faxes].

2 In the [Printers] folder, right-click the printer icon for your fax ➞ click [Properties] (Windows 98/Me), or 
[Printing Preferences] (Windows 2000/XP/Server 2003).

3 Click the [Register Cover Sheet] tab.
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4 Click [Register...].

The [Register Cover Sheet] dialog box appears.

5 Select the cover sheet template file ➞ click [Open].

The selected template is added to [Style] in the [Register Cover Sheet] sheet.

NOTE
In addition to the default templates, you can add up to 30 templates to the fax driver.
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CHAPTER

5
dies. It also 
Troubleshooting
This chapter describes the problems you might encounter when using the machine and their reme
explains what to do if you cannot solve the problem by yourself.
•"Printer Problems," on p. 5-1.
•"Driver Problems," on p. 5-3.
•"Scanning Problems," on p. 5-5.
•"Installing and Uninstalling Problems," on p. 5-9.
If you cannot solve the problem by referring to the information in this chapter, see also Chapter 9, "Troubleshooting," in 
the User’s Guide. 

Printer Problems

Printer does not print.

Q Is there some paper in the machine?

A Make sure paper is loaded.

Q Does the copy job stop due to out of paper?

A Load paper. The print job will start automatically when the copy job is completed.

Q Is the cartridge installed correctly?

A Make sure the cartridge is installed correctly. (See "Install cartridge," in the Set-Up Sheet.)

Q Does your BIOS port setting need to be modified?

A See your computer's documentation concerning available ports.

Q Is your computer working properly?

A Make sure your computer is turned on. If so, see your computer’s documentation for troubleshooting.
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No power is supplied.

Q Is the power cord plugged in?

A Make sure the power cord is securely plugged into both the machine and the AC outlet.

Q Is the AC outlet supplying power?

A Make sure the AC outlet is supplying power; try another outlet if necessary.

Q Does the AC voltage match the printer?

A Make sure the voltage of the AC outlet matches the ratings on the machine.

Printer stops printing.

Q Is the interface cable loose?

A Check your computer and cable.

Q Are you working on an application in the foreground?

A Printer performance improves if you give priority to your print job.

Printout is wrong.

Q Is there a communication problem between the printer and your computer?

A Make sure your cable connections are secure.

A Make sure your USB cable is less than 3 m long.

A Make sure you are not using a switch box.

A Make sure you have selected the correct printer driver in Windows.

Q Is a wrong printer driver selected in the [Printers and Faxes] (Windows 98/Me/2000: [Printers]) 
folder?

A Make sure the corresponding printer driver is selected in the [Printers and Faxes] (Windows 98/Me/
2000: [Printers]) folder.
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Printer locks up system.

Q Does your system setup have a problem?

A Make sure that you have a high-quality shielded interface cable.

A The problem might be in your BIOS. Verify that your BIOS setup is correct. (See your computer's 
documentation for details.)

A Verify that your physical memory is working correctly.

A If you have a Toshiba laptop, change the following line in your CONFIG.SYS file:
c:\winutils\mxtime.exe
to:
REM c:\winutils\mxtime.exe

Computer indicates a device time-out.

Q Is the machine off, offline, or not connected to the computer?

A Make sure the machine is not paused.

A Make sure the machine's interface cable is securely connected to both the machine and the 
computer.

A Make sure paper is properly loaded from the cassette or multi-purpose feeder.

A Reset the machine and the computer.

A Try the print operation again.

A Try a different cable.

Driver Problems

Driver is not working properly.

Q Is the printer driver selected as the default printer driver?

A Specify the corresponding printer driver as the default printer driver for the imageCLASS MF5700 
Series.
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Cannot print some fonts in a document correctly.

Q Does the document contain Adobe Type Manager (ATM) fonts?

A Adobe Type Manager (ATM) is not supported. Replace Adobe Type Manager (ATM) fonts to other 
appropriate fonts.

Cannot print with a printer driver other than the imageCLASS MF5700 Series printer.

Q Is the printer driver connected to the same port as the imageCLASS MF5700 Series printer driver?

A Connect the printer driver to a port different from the imageCLASS MF5700 Series printer driver.

Cannot install the imageCLASS MF5700 Series printer driver using the USB port. 

Q Is the USB driver installed properly?

A Perform the following steps.

1. Make sure the machine is connected to your computer using a USB cable and the machine is 
turned on.

2. For Windows XP, click [Performance and Maintenance] in the [Control Panel] folder ➞ [See basic 
information about your computer] in the [Performance and Maintenance] folder. For Windows 98/
Me/2000/Server 2003, double-click [System] in the [Control Panel] folder. The [System 
Properties] dialog box appears.

3. For Windows 2000/XP/Server 2003, select the [Hardware] tab ➞ click [Device Manager] ➞ 
double-click [Universal Serial Bus controllers]. For Windows 98/Me, select the [Device Manager] 
tab ➞ double-click [Universal Serial Bus controllers].

4. Locate the USB class driver under [Universal Serial Bus controllers]. Delete ONLY the USB 
class driver specified for your operating system. (If the USB class driver is displayed under 
[Other device], delete ONLY one of the following, depending on your operating system: [USB 
Printing Support], [Canon MF5700 Series], or [Unknown].)
For Windows 2000/XP/Server 2003, select [USB Printing Support] or [Canon CARPS USB 
Printer] ➞ select [Uninstall] from the [Action] menu. For Windows 98/Me, select [Canon MF5700 
Series] ➞ click [Remove].

5. Close the [Control Panel] folder ➞ unplug the USB cable.
6. Restart your computer.
7. For instructions on installing the printer driver, see "Installing Software on Your Computer," on 

p. 1-2.

IMPORTANT
Never delete other devices or device drivers. Windows may not operate properly.

NOTE
The procedure for Windows XP/Server 2003 is given for the Category View mode.
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Strings of garbled characters are printed.

Q Is the driver installed properly?

A Check if the corresponding printer driver icon is displayed in the [Printers and Faxes] (Windows 98/
Me/2000: [Printers]) folder. If not, install the driver. If the corresponding printer driver icon is 
displayed, right-click the corresponding printer driver icon ➞ check if [Set as Default printer] 
(Windows 98/Me: [Set as Default]) is selected in the pop-up menu. For more information, see 
"Checking Installation," on p. 1-13.

Scanning Problems

Cannot scan a document.

Q Is there anything displayed in the LCD?

A If nothing is displayed in the LCD, see Chapter 9, "Troubleshooting," in the User’s Guide.

Q Is the Alarm indicator blinking?

A If the Alarm indicator is blinking, see Chapter 9, "Troubleshooting," in the User’s Guide.

Q Is the document loaded correctly?

A Remove the document and load it in the platen glass or ADF correctly. (See Chapter 3, "Document 
Handling," in the User’s Guide.)

Q Is your computer working properly?

A Restart your computer.

Q Is a USB hub or repeater working properly?

A When using a USB hub or repeater, try connecting a USB cable directly to the computer to check if it 
works properly. If you can scan the document successfully after connecting a USB cable directly to 
the computer, check your USB hub or repeater if it is working properly.
5-5



Tr
ou

bl
es

ho
ot

in
g

5

Q Are you using a USB 2.0-compatible USB hub?

A If you connect the machine to a USB 2.0-equipped computer using a USB 2.0-compatible USB hub, 
you may not be able to scan. In this case, connect a USB cable directly to the computer.
If you want to connect the printer and computer via a USB 2.0-compatible hub, follow the procedure 
below to modify the INI file. It is recommended to make a backup copy of the file before making any 
changes to it.

1. Open the following file in Notepad or another text editor application.
Windows 98/Me:

windows\system\CNCMFP12.ini
Windows 2000:

winnt\system32\CNCMFP12.ini
Windows XP/Server 2003:

windows\system32\CNCMFP12.ini
2. Below the last line, add the following two lines, then save the file. Take care not to modify any 

other parts.
[Scan]

ReadSize=16

A If you connect the machine to a USB 2.0-equipped computer, you may not be able to scan. If your 
PC is equipped with two or more USB ports, try connecting the machine to another USB ports. If the 
problem persists, follow the procedure below to modify the INI file. It is recommended to make a 
backup copy of the file before making any changes to it.

1. Open the following file in Notepad or another text editor application.
Windows 98/Me:

windows\system\CNCMFP12.ini
Windows 2000:

winnt\system32\CNCMFP12.ini
Windows XP/Server 2003:

windows\system32\CNCMFP12.ini
2. In the [ScanSize] section, change "Read512Bytes=0" to "Read512Bytes=1," then save the file. 

Take care not to modify any other parts.

Q Is the [Select Source] setting in the MF Toolbox, ScanGear MF, or WIA driver set correctly?

A Choose between loading the document on the platen glass or ADF.

Q After installing the software, did you install a TWAIN-compatible application?

A The TWAIN system file is replaced with something inappropriate and you will be unable to scan 
images. If this happens, remove the software (see "Uninstalling and Reinstalling the Software," on p. 
1-14), then reinstall it (see "Installing Software on Your Computer," on p. 1-2.)
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Q Is the machine recognized in [Scanners and Cameras] of the [Control Panel] folder?

A Follow this procedure below to check if the corresponding scanner driver name or icon is present in 
[Scanners and Cameras] of the [Control Panel] folder:

1. Click [start] on the Windows task bar ➞ [Control Panel]. (Windows 98/Me/2000: Click [Start] on 
the Windows task bar ➞ select [Settings] ➞ [Control Panel].)

2. Click [Printers and Other Hardware] in the [Control Panel] folder ➞ [Scanners and Cameras]. 
(Windows 98/Me/2000: Double-click [Scanners and Cameras].)

3. If [WIA Canon MF5730], [WIA Canon MF5750] or [WIA Canon MF5770] (Windows 98/Me/2000: 
[Canon MF5730], [Canon MF5750] or [Canon MF5770]) is present in the [Scanners and 
Cameras] folder or dialog box, the machine is recognized. If not, remove the software (see 
"Uninstalling and Reinstalling the Software," on p. 1-14), then reinstall it (see "Installing Software 
on Your Computer," on p. 1-2.)

You tried to create a multipage PDF, but were not able to scan several documents.

Q Is the [Automatically Quit ScanGear MF after Scanning] checkbox in [Preferences] checked?

A Click a button on the MF Toolbox and in the settings dialog box, select [Use the scanner driver to 
make advanced settings]. When ScanGear MF opens, if you scan with the [Automatically Quit 
ScanGear MF after Scanning] setting selected in [Preferences] of Advanced Mode, only the 
documents placed at one time on the platen glass will be scanned. If you want to scan additional 
documents, clear the [Automatically Quit ScanGear MF after Scanning] checkbox before scanning.

Computer has hung up or frozen.

Q Is enough memory loaded in your computer?

A Quit other opened applications and try again.

Q Is enough space available in the hard disk?

A Check that hard disk has enough available space, in particular when scanning large documents at a 
high resolution. For example, an A4-size document scanned at 600 dpi, full color requires a minimum 
of 300 MB of disk space.
* If you do not have enough available space, scan the document at a lower resolution.

Q Does an error occur when scanning an image in Photoshop?

A Change the allocated memory. On the [Edit] menu, select [References] ➞ click [Memory & Image 
Cache]. Change the [Physical Memory Usage] in a range of approximately 10% to 20%.

Q Is the driver installed properly?

A Remove the software (see "Uninstalling and Reinstalling the Software," on p. 1-14), then reinstall it. 
(See "Installing Software on Your Computer," on p. 1-2.)
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You installed the applications on the MF5700 Series Setup CD-ROM but they were not registered in the MF Toolbox.

Q Have you installed the applications with the MF Toolbox open?

A If you install the applications with the MF Toolbox open, the applications will not be registered in the 
MF Toolbox. Click [Defaults] to register them. (See "Scanning with the MF Toolbox," on p. 3-5.)

When you click a button on the MF Toolbox, another application opens.

Q Is the application selected correctly for that button?

A Click a button on the MF Toolbox and select the application you want to open for that button. Repeat 
for the other buttons. (See "MF Toolbox Settings," on p. 3-8.)

Changed settings in a dialog box are not activated (Windows Me/2000).

Q Did you restart your computer after changing the settings?

A In Windows Me/2000, if you open [Scanners and Cameras] in the [Control Panel] folder and change 
the settings in the [Events] tab, the settings will not be activated unless you restart your computer. 
Once you have changed your settings, restart your computer.

Scanned images look dirty.

Q Is the platen glass or the platen glass cover clean?

A Clean the platen glass or the platen glass cover.

Q Is the image size too small?

A Some applications do not display an image properly at small sizes. Try displaying the image at 100% 
magnification.

Q Does the monitor display color set at below 16 bits?

A In [Display Properties], set the display colors to 16-bit color, 24-bit color or higher.

White lines appear on one edge of the image you scan.

Q Is the document placed on the platen glass correctly?

A Place the document approximately 3 mm from the front edge (i. e., the edge closest to the operation 
panel) of the platen glass.
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Scanned image is displayed at a larger (smaller) size on the computer screen.

Q Is the resolution setting correct?

A Do one of the following:

1. Enlarge or reduce the image display in the application.
However, if you open the image in [Paint] or [Imaging], it may display at a large size and you will 
not be able to reduce it.

2. Change the resolution and scan again.
The image will be large if resolution is high. It will be small if resolution is low.
(See "Determining Resolution," on p. 3-37.)

Installing and Uninstalling Problems

Cannot install the software.

Q Have you followed the instructions to install the software?

A Try reinstalling the software. If an error occurred and installation was not complete, restart your 
computer and try reinstalling the software.

Q Are any other applications open?

A Quit all of these and try reinstalling the software.

Removal of the drivers takes too long (Windows XP/Server 2003).

Q Is any application such as an anti-virus open when removing the software?

A Quit any applications (including anti-virus) before removing the software.

Removal of the software was completed, but [Canon] remains.

Q Did you remove the MF drivers before removing the MF Toolbox?

A In Windows XP/Server 2003, right-click the [start] menu to open the Windows Explorer ➞ select 
[Start Menu] in [Administrator] ➞ [Programs] ➞ delete the [Canon] folder. 
In Windows 2000, open [Settings] from the [Start] menu ➞ click [Taskbar & Start Menu] ➞ 
[Advanced] ➞ [Advanced...] ➞ select [Start Menu] in [All Users] ➞ [Programs] ➞ delete the [Canon] 
folder.
In Windows 98/Me, open [Settings] from the [Start] menu ➞ click [Taskbar & Start Menu] ➞ [Start 
Menu Programs] ➞ [Remove] ➞ select the [Canon] folder ➞ click [Remove].
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The message <Version conflict> appears on your computer (Windows 98).

Q Is Photoshop installed on your computer?

A If the message <Version conflict> or <Windows 98 file language or ...> appears during installation, 
click [Yes] or [No]. Whichever you click, installation thereafter will continue trouble-free.

Cannot use the software after upgrading to Windows XP/Server 2003.

Q Have you upgraded Windows 98/Me/2000 to Windows XP/Server 2003 without removing the 
software?

A Remove the software (see "Uninstalling and Reinstalling the Software," on p. 1-14), then reinstall it. 
(See "Installing Software on Your Computer," on p. 1-2.)

In [Device Manager], green mark “?” is displayed (Windows Me).

Q Is green mark "?" displayed on [USB Composite Device] in [USB (Universal Serial Bus) Controller] in 
[Device Manager] in Windows Me?

A As this is not a problem, you can continue to use it as is.
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CHAPTER

6
Appendix
Printer Specifications

Hardware

Software

Glossary

A
AC

Alternating Current. The type of electrical current typically available from household wall outlets.

Application
Abbreviation of the phrase "application software." Software designed for a specific purpose such as word 
processing software, spreadsheet software, database software, or a combination of these.

Printing Speed 21 pages per minute (A4-size paper)

Resolution Approx. 600 dpi × 600 dpi

Paper Sizes

Cassette LTR, Executive, A4, B5, A5
Plain paper, transparencies and heavy paper (up to 128 g/m2)
Maximum capacity: 250 sheets of 64 g/m2 paper

Multi-purpose 
Feeder

216 mm × 356 mm [max.] to 76 mm × 127 mm [min.]
Plain paper, transparencies, envelopes, and heavy paper (up to 128 g/m2)
Maximum capacity: 1 sheet

Paper Delivery 
(Face Down 
Output Way)

60 sheets (64 to 75 g/m2)

Host Interface USB interface
Network interface card (only for the MF5770 model)

Printing Software Canon Printer Driver for MF5700 Series

Valid Printing Area Max. 5 mm blank margins at each edge
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B
Bold

A characteristic of a printed character with wider, and darker representation. Also referred to as emphasized 
or double-strike printing.

Brightness
The relative proportion of light and dark areas. Decreasing brightness darkens the overall image; increasing 
brightness lightens it.

C
Canon ColorGear Color Matching

Color management system for high-speed, high-precision color processing using Canon’s own color 
management technology. Canon ColorGear is compatible with the industry-standard format "ICC Profiles" 
and enables high-precision color management using the properties of color devices specified in color profiles. 
The system is used in many Canon products.

Client
A computer that is connected to the printer over a network. A client does not control the printer directly. It 
interacts with the printer through a server. See also Server.

Collate
To print multiple copies of a multi-page document in sequential page order.

Command
An instruction that tells the machine to perform a certain function. Commands are sent from the computer to 
the machine via the interface cable when the machine is ready.

Contrast
The degree of difference between the lightest and darkest areas of an image. Decreasing contrast lightens 
the dark areas and darkens the light areas; increasing it darkens the dark areas and lightens the light areas.

Control Panel
The set of Windows programs you can use to change system, hardware, software, and Windows settings.
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D
Default setting

A setting that is automatically used if no other setting is specified.

Desktop
The entire Windows screen that represents your work area in Windows. Icons, windows, and the taskbar are 
displayed on the Windows desktop. 

dpi
Dots per inch. A unit of measurement for indicating a printer's resolution. The Canon imageCLASS MF5700 
Series prints at a resolution of 600 dpi.

Driver
A program that controls how the computer and an external device interact. For example, the printer driver 
supplies Windows with information such as descriptions of the fonts and features of the installed printer.

E
Exif

The Exif (Exchangeable Image File) format is a JEIDA (Japan Electronic Industry Development Association) 
standard used by most digital cameras to store images. The Exif compressed files use the baseline JPEG 
format, so they can be read by any application supporting "JPEG." EXIF supports the storage of extra 
information, such as the date & time the image was taken, exposure information, etc., within the header of 
each JPEG file.

F
Fixing assembly

The device used during the print process to fix the toner onto the paper (or other media) through applying 
heat and pressure. The assembly, located inside the printer, gets extremely hot (190°C) during operation.

Folder
A container in which documents, program files, and other folders are stored on your disks. Formerly referred 
to as a directory.

Font
A complete set of characters of the same size and style. For example, 12-point Courier bold.

Form
A custom paper size, with width and height defined by the user. 

G
Gamma Correction

Method for changing the brightness of an image. With gamma correction, the brightness of parts of an image 
in the middle of the tonal range is changed without changing the lightest or darkest areas of the image, which 
means you can change the brightness of an image while maintaining contrast.

Grayscale image
A bitmap image that stores data for each dot as a shade of gray, rather than as black or white.
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H
Halftones

The process of converting a grayscale image to black dots and white (unprinted) dots that simulate the gray 
shades in the original image.

I
Import

To bring in information created in another application.

Install
To copy software to a designated location on a computer’s hard disk so that it can be used at any time.

Interface
The connection between two devices through which they communicate with each other. The Canon 
imageCLASS MF5700 Series feature USB interface, which makes it compatible with IBM and similar 
personal computers.

Interface port
The port through which the machine communicates with the computer. The Canon imageCLASS MF5700 
Series have a USB port, located on the back of the machine. See also USB interface.

Italic
A font style distinguished by slanted characters (the upright strokes of the characters are at an angle to the 
vertical axis).

J
Jam

A situation created when paper becomes caught along the paper path. You must remove jammed paper 
before you can continue printing.

K
Kilobyte (KB)

A unit of measurement, representing the binary number 1024, used to describe machine or computer 
memory size in thousand-byte units.

L
Landscape

A horizontal print orientation. Text and graphics are printed across the longer axis of the page.

Local printer
A printer that is directly connected to your computer, using a USB cable.
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M
Megabyte (MB)

A unit of measurement, representing one million bytes, used to describe machine or computer memory size. 

Multi-page PDF
Several scanned documents saved as one PDF. Each document will become one page of the PDF.

My Computer
The Windows program that you can use to browse through your computer's filing system, and to open drives, 
folders, and files. You can also use [My Computer] to manage your files and your filing system, by moving, 
copying, renaming, and deleting items.

N
Network

A group of computers connected by cables or other means and using software that enables them to share 
equipment (such as printers) and exchange information.

O
OCR (Optical Character Reader)

Device for reading characters optically. System for extracting information in a text format from information in 
the form of a graphic such as hand-written or printed characters which have been scanned with a scanner. 
You cannot edit text scanned with a scanner because it is in a graphic format, but with OCR software you can 
convert to a text file and then edit the text with word-processing software.

Orientation
The printing of text either along the width (portrait) or length (landscape) of the page.

P
Paper feed

The act of guiding a sheet of paper into the machine's paper path.

Paper jam
A situation created when paper becomes caught along the paper path. You must remove jammed paper 
before you can continue printing.

Paper path
The route that paper travels through the machine.

Paper source
Source of paper feed. The machine has a cassette and a multi-purpose feeder.

Paper type
All kinds of paper (plain paper, heavy paper, transparencies, and envelopes) are grouped under several 
paper types. 
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PDF
Stands for Portable Document Format. A widely used format for transmitting and viewing documents on 
computers. PDF documents can be read or printed out with Adobe's Acrobat Reader program.

Physical RAM
Random Access Memory (RAM) that is physically present in the computer in the form of memory chips, as 
opposed to virtual memory. See also Virtual Memory.

Platen
The document scanning unit.

Point size
Character height is defined in points: one point is 1/72 of an inch.

Portrait
A vertical print orientation. Text and graphics are printed across the shorter axis of the page.

Preview
Provisional scanning and display of the document you are about to scan before you actually scan it. If the 
preview scan looks different from what you want, you can change the settings, display the preview again and 
confirm before scanning.

Print job
A document that a Windows application has processed and sent to the Spooler to be added to the print 
queue or directly to the machine.

Print queue
A list of files that are either waiting to be printed or are currently printing. Once a file has been printed, it is 
removed from the print queue.

Printer driver
A program that controls how the computer and printer interact. The printer driver supplies Windows with 
information such as descriptions of fonts and features of the installed printer.

Printers and Faxes folder (Printers folder)
The container in which your printer and fax information is stored.

Properties dialog box
The dialog box that contains information about a particular device, such as a printer.

Proportional spacing
The spacing of characters according to the width of each character. This variable spacing between each 
character closes up awkward space and makes text easier to read.

Q
Queue

A list of files that are either waiting to be printed or are currently printing. Once a file has been printed, it is 
removed from the print queue.
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R
Random Access Memory (RAM)

The working memory of the computer in which programs and data are temporarily stored while you use them. 
Resetting or shutting off the computer clears all information from RAM. Printing very complicated documents 
might require closing other running programs or adding more RAM to the computer. See also Physical RAM, 
Virtual memory.

Reinstall
To remove installed software and install again.

Resolution
The density of dots for any given output device, expressed in terms of dots per inch (dpi). Low resolution 
causes font characters and graphics to have a jagged appearance, but prints faster than higher resolutions. 
Higher resolution provides smoother curves and angles as well as a better match to traditional typeface 
designs, but prints more slowly. This machine can produce output with 600 dpi resolution. Resolution values 
are represented by horizontal data and vertical data, for example, 600 × 600 dpi.

S
Scalable fonts

Scalable fonts allow characters to be printed in various sizes and rotation angles. This is different from bitmap 
fonts, which are printed in fixed sizes and angles.

Scaling
Enlarging or reducing the printed image.

Scanner driver
A program that controls how the computer and scanner interact. The scanner driver is provided with two 
drivers: The TWAIN and the WIA driver (for use with Windows XP).

Separator page
Optional pages printed at the beginning of each document to help separate one print job from another.

Server
A network computer that is directly attached to the printer. The server controls the printer and handles print 
jobs sent from the clients. See also Client.

Shielded
A type of cable that contains a metallic sheath over the conductor material to protect the data passing 
through the cable from electromagnetic interference. You need to use a double-shielded interface cable with 
this machine.

Spooling
A process by which an application sends a document to the spooler, rather than directly to the printer, thus 
freeing the computer and application for other tasks. Spooled documents are printed in the order they are 
received.
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T
Title bar

The horizontal bar that contains the title of a window or dialog box. On many windows, the title bar contains 
the [Control] menu box and Maximize and Minimize buttons.

Toner
A black, resin-coated powder contained in the cartridge. The machine applies the toner to the surface of the 
photosensitive drum inside the machine via an electrophotographic mechanism.

Toner saver
Because the black areas of print data are thinned, toner consumption is reduced.

Transfer roller
Presses the paper against the drum, to aid the transfer of toner to the paper.

TrueType fonts
Scalable fonts used for both screen display and printing. TrueType fonts can be sized to any height, and print 
exactly as they appear on the screen, but with higher resolution. 

TWAIN (Technology Without Any Interested Name)
Industry-standard protocol for transferring information from devices such as scanners and digital cameras to 
a computer.

Industry-standard protocol for an application programming interface (API) for input devices such as scanners. 
If both the device and the application comply with the standard, they will be compatible regardless of 
differences in manufacturer or model.

For example, with TWAIN-compatible image-processing software, you can start the scanner’s TWAIN driver 
from the software’s menu, scan the document and return the scanned image to its original image-processing 
software.

U
Uninstall

To remove software installed on a computer and return the computer to its condition before the software was 
installed.

Universal Serial Bus (USB) interface
These are new serial interface standards. This bus automatically recognizes connections (Plug and Play) to 
allow plugging and unplugging connectors with the power still turned on to the PC or peripheral equipment.

V
Virtual Memory

Space on the hard disk that Windows uses for temporary data storage as if it were actually random access 
memory (RAM). Windows does this by means of a swap file. This provides Windows with more usable 
memory, but reduces speed of access to it when the swap file must be used. See also Physical RAM.
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W
Weight

Refers to the thickness of a font: light, medium, or bold. Also refers to the thickness of paper.

WIA (Windows Image Acquisition)
Standard for downloading images from scanners or digital cameras. The machine includes a 
TWAIN-compliant driver and a WIA-compliant driver. The WIA driver can only be used with Windows XP. With 
either driver, you can scan documents with the machine in applications which support the TWAIN interface 
(Photoshop etc.).

Windows Explorer
The Windows program you can use to browse through, open, and manage the disk drives, folders, and files 
on your computer in a network system. You can also use Windows Explorer to view and open shared folders 
on other computers on the network. You can use Windows Explorer to manage your files by moving, copying, 
renaming, and deleting files.

WYSIWYG
Pronounced wizzy-wig, an acronym for "what you see is what you get." For example, when you format a 
paragraph, the line breaks that appear on the printout are exactly the same as they are on the screen.
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Index
A
Accompanying Applications

installing, 1-7

Add Group dialog box, 4-17, 4-30

Add Person dialog box, 4-16, 4-29

Add profiles, 2-52

Add/Delete the Output Size dialog box, 3-17

Add/Edit Canon Fax Driver Address Book, 4-23

Add/Edit profile, 2-34

Address Book, 4-15, 4-28

Address Books, 4-22, 4-35

Address Books dialog box, 4-22

Advanced Mode

settings, 3-21
switching, 3-15
toolbar, 3-19
using, 3-18

Advanced Properties dialog box, 3-42

Advanced Settings

Windows 2000/XP/Server 2003, 2-44
Windows 98/Me, 2-15

Advanced tab, Windows 2000/XP/Server 2003, 2-30, 4-25

Alarm indicator, 5-5

Application, 3-12, 6-1

Attribution tab, Windows 2000/XP/Server 2003, 2-34

Auto Tone, 3-23

B
Brightness, 6-2

Brightness/Contrast, 3-27

C
Calibration, 3-25

Cannot install, 5-9

Canon ColorGear, 3-35

Cassette, 6-1

Client, 6-2

Collate, 6-2

Color, 2-31, 4-26

Color Management tab, Windows 2000/XP/Server 2003, 2-31, 
4-26

Color Settings, 3-25

Color Settings tab, 3-35

Composite device, 5-10

Configuration tab

Windows 2000/XP/Server 2003, 4-27
Windows 98/Me, 4-23

Contrast, 6-2

Control Panel, 6-2

Cover Sheet, 4-20, 4-33

Cover Sheet Editor, 4-36

installing/uninstalling, 4-37

Cover Sheet tab, 4-5

Custom Paper Size Settings, 2-11

D
Default setting, 6-3

Descreen, 3-23

Detailed Settings

Windows 2000/XP/Server 2003, 2-46
Windows 98/Me, 2-17

Details tab, Windows 98/Me, 2-5, 4-13

Dialog boxes

Windows 2000/XP/Server 2003 printer properties, 
2-26, 4-24

Windows 98/Me printer properties, 2-4, 4-12

dpi, 6-3

Driver

installing, 1-2
problems, 5-3
uninstall, 1-14

E
Edit Address Book tab, 4-4, 4-15, 4-28

Edit Group dialog box, 4-19, 4-32

Edit Person dialog box, 4-18, 4-31

Edit Profiles

Windows 2000/XP/Server 2003, 2-53
Windows 98/Me, 2-24

Edit Watermark

Windows 2000/XP/Server 2003, 2-39
Windows 98/Me, 2-10

F
Fading Correction, 3-24

Fax

sending, 4-1
settings, 4-10

Fax Phone Number Entry, 4-1

Fax printing preferences

Windows 2000/XP/Server 2003, 4-27

Fax properties

Windows 2000/XP/Server 2003, 4-24
Windows 98/Me, 4-12

Fax Sending Settings, 4-2

Fax Setting

changing, 4-10

Fields, 4-46

Final Review, 3-31

Finishing tab

Windows 2000/XP/Server 2003, 2-35, 2-43
Windows 98/Me, 2-14

Fixing assembly, 6-3

Font, 6-3

Form, 6-3
6-10
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G
Gamma, 3-27

General tab

Windows 2000/XP/Server 2003, 2-27, 4-24
Windows 98/Me, 2-4, 4-12

Grain Correction, 3-25

Grayscale Adjustment tab

Windows 2000/XP/Server 2003, 2-47
Windows 98/Me, 2-18

Grayscale image, 6-3

Grayscale Settings

Windows 2000/XP/Server 2003, 2-47
Windows 98/Me, 2-18

Gutter Settings

Windows 2000/XP/Server 2003, 2-44
Windows 98/Me, 2-15

H
Halftones, 6-4

Hard disk, 5-7

Histogram, 3-29

I
Image Settings, 3-23

Import, 6-4

Input Settings, 3-21

Installation, 1-1

Accompanying Applications, 1-7
checking, 1-13
MF drivers, 1-3
MF Toolbox, 1-4
problem, 5-9

Interface, 6-4

Interface port, 6-4

Item Settings dialog box, 4-6

L
Landscape, 6-4

Layout Options

Windows 2000/XP/Server 2003, 2-42
Windows 98/Me, 2-13

Local printer, 1-2

Logo tab, 4-8

M
Matching tab

Windows 2000/XP/Server 2003, 2-48
Windows 98/Me, 2-19

Megabyte, 6-5

MF drivers

installing, 1-3, 1-10
uninstalling, 1-14

MF Toolbox

installing, 1-4
Save Scanned Image to, 3-9

scanner settings, 3-8
setting, 3-8
uninstalling, 1-14
using, 3-5

[MF5700 Series Setup] screen, 1-3

Multiple PDF, 3-12

Multi-purpose feeder, 6-1

N
Network

setting shared printer, 2-55
using shared printer, 2-61
Windows 2000/XP/Server 2003 server settings, 2-55
Windows 98/Me server settings, 2-59

O
Orientation, 6-5

Output Settings, 3-22

P
Page Setup tab

Windows 2000/XP/Server 2003, 2-35, 2-36
Windows 98/Me, 2-7

Paper

delivery, 6-1
feed, 6-5
size, 6-1
type, 6-5
weight, 6-1, 6-9

paper size

custom, 2-11

Parameters of a scan

specifying, 3-20

PDF, 6-6

PDF Setting dialog box, 3-13

Plain paper, 6-1

Portrait, 6-6

Ports tab, Windows 2000/XP/Server 2003, 2-29, 4-25

Power

not supplied, 5-2

Preferences dialog box, 3-32

Presto! PageManager, 3-7

Preview, 6-6

Preview tab, 3-33

Print

queue, 6-6
settings, 2-2
6-11
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Printer

does not print, 5-1
driver, 5-4, 6-6
locks up, 5-3
opening printing preferences, 2-3, 4-12
opening properties, 2-2
problems, 5-1
sharing settings, 2-58
specifications, 6-1
stops printing, 5-2

Printer properties

Windows 2000/XP/Server 2003 dialog boxes, 2-26
Windows 98/Me dialog boxes, 2-4

Printing, 2-1

speed, 6-1

Problems

driver, 5-3
installing, 5-9
printer, 5-1
removing (uninstalling), 5-9
scanning, 5-5
uninstalling, 5-9

Profile tab, Windows 2000/XP/Server 2003, 2-33

Profiles

Windows 2000/XP/Server 2003, 2-50
Windows 98/Me, 2-21

Q
Quality tab

Windows 2000/XP/Server 2003, 2-35, 2-45
Windows 98/Me, 2-16

Queue, 6-6

R
Random Access Memory, 6-7

Recipient tab, 4-7

Reduce Dust and Scratches, 3-24

Register Address Book, 4-22, 4-35

Register Cover Sheet tab, 4-20, 4-33

Resolution, 2-17, 2-46, 4-21, 4-34, 6-1, 6-7

determining, 3-37
DPI, 3-42
output, 3-22

S
Scaling, 6-7

Scan tab, 3-34

ScanGear MF

Advanced Mode, 3-18
dialog box, 3-7, 3-13
setting, 3-14
Simple Mode, 3-15

Scanner and Camera Wizard, 3-38

Scanner driver, 6-7

Scanner tab, 3-36

Scanners and Cameras, 3-3

Scanning, 3-1

from an application, 3-12, 3-43
problems, 5-5
setting, 3-3
using MF Toolbox, 3-5
with [Start] on the machine, 3-1

ScanSoft OmniPage, 3-7

Security tab

Windows 2000/XP/Server 2003, 2-32, 4-26

Select Recipient from Address Book dialog box, 4-4

Sender tab, 4-6

Sending fax, 4-1

Sending Settings tab, 4-3

Server, 6-7

settings Windows 2000/XP/Server 2003, 2-55
settings Windows 98/Me, 2-59

Shared printer, 2-55

Add Printer Wizard (Windows 2000/XP/Server 2003), 
2-62

Add Printer Wizard (Windows 98/Me), 2-62
network download, 2-61

Sharing tab

Windows 2000/XP/Server 2003, 2-28, 4-25
Windows 98/Me, 2-6

Sheets to Send tab, 4-10

Shielded, 6-7

Signature tab, 4-9

Simple Mode

switching, 3-15
toolbar, 3-17
using, 3-15

Software

checking installation, 1-13
installing, 1-2
problems during installation, 5-9
problems during removal, 5-9
uninstalling/reinstalling, 1-14

Special tab, 4-21, 4-34

Specifications

printer, 6-1

Spool Settings, 2-5, 4-13

Spooling, 6-7

System requirements, 1-1

T
Threshold, 3-31

Tone Curve, 3-30

Toner, 6-8

saver, 6-8

Transfer roller, 6-8

Troubleshooting, 5-1

driver problems, 5-3
installing and uninstalling problems, 5-9
printer problems, 5-1
scanning problems, 5-5
6-12
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U
Uninstall, 6-8

drivers, 1-14

Unsharp Mask, 3-23

USB 2.0, 1-1, 5-6

USB cable

connecting, 1-7

USB interface, 6-8

V
Version conflict, 5-10

View Settings

Windows 2000/XP/Server 2003, 2-54
Windows 98/Me, 2-25

W
White lines, 5-8

WIA driver, 3-38

Windows 2000/XP/Server 2003

Advanced tab, 2-30, 4-25
Attribution tab, 2-34
Color management tab, 2-31, 4-26
Finishing tab, 2-35
General tab, 2-27, 4-24
Grayscale Adjustment tab, 2-47
Matching tab, 2-48
Page Setup tab, 2-36
Ports tab, 2-29, 4-25
Profile tab, 2-33
Quality tab, 2-45
Sharing tab, 2-28, 4-25

Windows 98/Me

Details tab, 2-5, 4-13
Finishing tab, 2-14
General tab, 2-4, 4-12
Grayscale Adjustment tab, 2-18
Matching tab, 2-19
Page Setup tab, 2-7
Printer Properties, 2-4, 4-12
Quality tab, 2-16
Sharing tab, 2-6

WYSIWYG, 6-9
6-13
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